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626881/files. There are links there that you can click to submit errata and to 
provide other kinds of feedback.
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We Want to Hear from You
We welcome your feedback about this book. Please share your comments and ideas 
through the following short survey:

http://microsoft.com/learning/booksurvey.

Your participation helps Microsoft Press create books that better meet your needs and your 
standards. 

Note
We hope that you will give us detailed feedback in our survey. If you have questions 
about our publishing program, upcoming titles, or Microsoft Press in general, we 
encourage you to interact with us using Twitter at http://twitter.com/MicrosoftPress. 
For support issues, use only the email address shown previously.
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Conventions and Features Used in This Book
This book uses special text and design conventions to help you find the information you 
need more easily.

Text Conventions
Convention Meaning

Abbreviated com-
mands for navigat-
ing the ribbon 

For your convenience, this book uses abbreviated commands. For 
example, “Click Home, Insert, Insert Cells” means that you should 
click the Home tab on the ribbon, then click the Insert button, and 
finally click the Insert Cells command.

Boldface type Boldface indicates text that you type.
Initial Capital 
Letters

The first letters of the names of tabs, dialog boxes, dialog box ele-
ments, and commands are capitalized. Example: the Save As dialog 
box. 

Italicized type Italicized type indicates new terms. 
Plus sign (+) in text Keyboard shortcuts are indicated by a plus sign (+) separating key 

names. For example, Ctrl+Alt+Delete means that you press the Ctrl, 
Alt, and Delete keys at the same time.

Design Conventions

INSIDE OUT  �This Statement Illustrates an Example of an “Inside Out” 
Heading

These are the book’s signature tips. In these tips, you get the straight scoop on what’s 
going on with the software—inside information about why a feature works the way it 
does. You’ll also find handy workarounds to deal with software problems. 

Sidebar
Sidebars provide helpful hints, timesaving tricks, or alternative procedures related to 
the task being discussed. 
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TROUBLESHOOTING
This statement illustrates an example of a “Troubleshooting” problem 
statement.

Look for these sidebars to find solutions to common problems you might encounter. 
Troubleshooting sidebars appear next to related information in the chapters. You can 
also use “Index to Troubleshooting Topics” at the back of the book to look up problems 
by topic. 

Cross-references point you to locations in the book that offer additional information about 
the topic being discussed.

CAUTION!
Cautions identify potential problems that you should look out for when you’re com-
pleting a task or that you must address before you can complete a task.

Note
Notes offer additional information related to the task being discussed.

When an example has a related file that is included on the companion Web site, this icon 
appears in the margin. You can use these files to follow along with the book’s examples. 
The companion Web site is located at http://go.microsoft.com/fwlink/?Linkid=198961.
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CHAPTER 9

Worksheet Formatting Techniques

W hen creating a worksheet in Microsoft Excel 2010, you probably don’t ask your-
self the question, why use formats? But we’ll answer it anyway. Compare Fig-
ure 9-1 to Figure 9-2, and we need say no more. Although the data is the same 

in both worksheets, the worksheet in Figure 9-2 takes advantage of the formatting features 
available in Excel 2010, and as you can see, it’s much easier to read and interpret. In this 
chapter, you’ll learn how to apply basic formatting to help turn your data into information. 
We also discuss advanced formatting features such as themes, cell styles, and conditional 
formatting.

Figure 9-1  All entries in this worksheet are displayed in their default formats.
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Figure 9-2  The formatted worksheet is easier to read.

Formatting Fundamentals
Worksheet editing involves creating and modifying the content, layout, and organization 
of data, while worksheet formatting deals with the appearance and readability of that data. 
With formatting, you can take mind-numbing detail and turn it into information by high-
lighting the important stuff, adding visual cues and clues, and enhancing overall readability 
and organization. Be careful, though—over formatting can be as distracting as none at all. 
Usually, the goal of a good worksheet is to call attention to the right information, not to 
showcase Excel’s formatting features (or your mastery of them).

Formatting in Excel is easy: Select the cell or range, and use the appropriate buttons and 
commands on the ribbon to apply formatting. Many of the most often used formatting 
features appear on the Home tab on the ribbon for quick access, as shown in Figure 9-3. In 
fact, formatting commands dominate the Home tab; all seven of its ribbon groups include 
formatting commands (even the Editing group). Figure 9-3 also shows the Format Cells dia-
log box, which you can access by clicking the dialog box launcher in the Font, Alignment, 
or Number group on the Home tab on the ribbon. (The dialog box launcher is the small 
arrow icon to the right of the title in many ribbon groups.)

Note
To quickly access the Format Cells dialog box, press Ctrl+1.
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Figure 9-3  The Home tab on the ribbon and the Format Cells dialog box are your formatting 
toolboxes.

Here are some fundamental rules of formatting in Excel:

●● A formatted cell remains formatted until you remove the format or apply a new 
format.

●● When you overwrite or edit a cell entry, you need not reformat the cell.

●● When you copy or cut a cell, the formats applied to that cell travel with it.

Note
Build and edit the worksheet first; apply formatting later. Sometimes, the least efficient 
step you can take is to apply your formatting too soon. Applying, removing, and then 
reapplying formatting is at least three times the work. Trust us, you’ll do some refor-
matting no matter what, so give yourself the freedom to rearrange until the layout 
becomes clear for your purposes.
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Formatting Tables

The concept of “tables” in Excel took on fresh meaning with the 2007 release, and it con-
tinues in the 2010 release. Tables are special objects in Excel that include many features 
beyond formatting, but you can use the Format As Table button on the Home tab to apply 
specific font, border, and fill attributes to all the elements of a table at once. The Format 
As Table gallery, shown in Figure 9-4, applies predefined combinations of these formatting 
criteria.

Note
When you use Format As Table, you apply more than just formatting—you are actu-
ally transforming a region of your worksheet into a kind of self-contained entity that 
not only adds filters to all column headings but also has special properties that offer 
extreme editing while preserving the integrity and format of the table structure. Chap-
ter 22, “Managing Information in Tables,” covers tables in more detail. You’ll want to 
check out that chapter.

Figure 9-4  The Format As Table gallery offers a selection of predefined formats you can apply 
with one click.
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You can apply the Format As Table command to any region of cells (that is, a contiguous 
block of cells on a worksheet). You select a cell anywhere within the region, click Format As 
Table, and then select one of the sample table formats from the gallery. When you do, Excel 
displays the Format As Table dialog box, which lets you adjust the selection, as shown in 
Figure 9-5.

Figure 9-5  The Format As Table dialog box appears after you select a format in the Format As 
Table gallery.

If your table includes headers (as most do), select the My Table Has Headers check box in 
the Format As Table dialog box. Excel then selects the entire table automatically and applies 
the selected table format to it.

Here are a few tips to keep in mind when using Format As Table:

●● If you don’t like the way something looks, click the Undo button on the Quick Access 
Toolbar (or press Ctrl+Z).

●● The boundaries of a table are defined by blank rows and columns or the edges of the 
worksheet. Try adding blank columns or rows around your table to effectively fence 
off areas you don’t want Format As Table to touch.

●● Select more than one cell before issuing the command, and Format As Table affects 
only the selected cells.

Undo
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Although Format As Table does a pretty good job with simple tables, you usually need to 
make a few adjustments afterward. For example, starting with the raw data shown in Figure 
9-1, we applied the Table Style Light 4 format. Figure 9-6 shows the result.

Figure 9-6  In seconds, you can transform a raw worksheet into something more presentable.

As you can see in Figure 9-6, the title and subtitle in cells A1 and A2 were not part of the 
table, and therefore were not formatted, so we applied additional formatting manually to 
arrive at the result shown in Figure 9-2. In addition, we applied number formatting to the 
cells containing data. Nonetheless, using Format As Table speeds up the formatting process 
and provides at least one formatting feature that is otherwise unavailable: automatic row 
and column banding, which was one attribute of the automatic format we applied in Figure 
9-6. Another cool part of using Format As Table is the automatic preview feature. After you 
define a table using the Format As Table command, you can then use the Format As Table 
gallery to preview other predefined formats. (It doesn’t work on raw data.) Rest the pointer 
on any format in the gallery, and the associated formatting is temporarily reflected in the 
table you have already created, but it is not actually applied unless you click.

After you create a table, a context-triggered tab appears on the ribbon only when you 
select a cell or cells within the table. Figure 9-7 shows the Table Tools Design tab.

The Design tab contains formatting commands in the Table Style Options and Table Styles 
groups. The latter group contains the same gallery as the Format As Table command on the 
Home tab. In Figure 9-7, we selected both the First Column and Last Column check boxes 
in the Table Style Options group, which in this particular predefined format applied bold 
formatting to the fonts in those columns. You can select and clear check boxes in this group 
and view the changes immediately. The Header Row check box actually adds or removes 
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the header row from the table. The Total Row check box adds a double border at the bot-
tom of the table and adds another row containing summary formulas. If you add the sum-
mary row, you can select which summary function you want to use by clicking the summary 
formula in the totals row and then clicking the menu arrow that appears. The menu offers 
a selection of functions—including Sum (the default), Average, Max, and Min— or you can 
select More Functions to display the Insert Function dialog box.

Figure 9-7  The Table Tools Design tab appears on the ribbon whenever you select a cell in a 
table.

TROUBLESHOOTING
Did your Design tab disappear?

The Table Tools Design tab appears only when you select a cell that is part of a table. 
When you select any cell outside the table, this context-triggered tab disappears, and 
the Home tab is activated.

The two “Banded” check boxes on the Table Tools Design tab—Banded Rows and Banded 
Columns—are useful. In large worksheets, row banding often makes it easier to track long 
rows of data across a screen or printed page. In previous versions of Excel, banding required 
you to construct an esoteric conditional formatting formula using the MOD function. Band-
ing is now easier than ever to apply in Excel thanks to these two options, and unlike the 
old MOD function approach, these table banding options are smart enough to survive just 
about any kind of editing, including inserting and deleting rows and columns.
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For more information, see “Formatting Conditionally” on page 309 and “Creating Conditional 
Formatting Rules” on page 315.

You can insert and delete rows in a table, even at the edges, and the table automatically 
does the right thing with formats and formulas. Another great feature of tables is that you 
can make them bigger just by dragging. As Figure 9-8 shows, the cell in the lower-right 
corner of the table contains a small triangular indicator (similar to a cell comment indicator) 
that you can drag horizontally or vertically to increase (or decrease) the size of the table.

Figure 9-8  Drag the lower-right corner of a table to make it bigger.

Options for Applying Table Formats

When you right-click an item in the Format As Table gallery, you’ll find a few more tools 
you can employ when you are working with table formats. Figure 9-9 shows the shortcut 
menu that appears when you right-click a gallery item.

The following are the options:

●● Apply And Clear Formatting sounds backward, because what really happens is that 
Excel removes the existing formatting first before applying the selected table format.

●● Apply (And Maintain Formatting) gives you the option of using the selected table 
format without disturbing any format attributes previously applied to the selected 
cells. This is handy if you have special number formats or conditional formats you 
want to preserve.

●● Duplicate copies the selected table format; opens the Modify Table Quick Style dialog 
box (which is identical to the New Table Quick Style dialog box shown in Figure 9-10), 
letting you make modifications; and places the resulting format in the Custom cat-
egory at the top of the Format As Table gallery.
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Figure 9-9  Right-click any table format thumbnail to reveal a shortcut menu containing helpful 
options.

Creating Custom Table Formats

If the built-in gallery of table styles doesn’t do it for you, you can create your own. To do so, 
click the Format As Table button on the Home tab, scroll to the bottom of the gallery, and 
click New Table Style to display the New Table Quick Style dialog box shown in Figure 9-10.

In the New Table Quick Style dialog box, you can assign font, border, and fill formats to 
each item included in the Table Element list. Select the element you want to format, and 
click the Format button to display the Format Cells dialog box shown on the right in Figure 
9-10. You can click the Clear button to remove the formatting from a selected element; 
select the Set As Default Table Quick Style For This Document check box to make yours the 
go-to style whenever you create tables in the current workbook. After you finish specifying 
formats and click OK, your custom style appears at the top of the Format As Table gallery in 
the Custom category.
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Figure 9-10  Click the New Table Style command in the Format As Table gallery to create your 
own table styles.

Removing the Automatic Table Features

If you like the formatting you get from tables but don’t want or need the special features of 
a table, use the Convert To Range button in the Tools group on the Table Tools Design tab. 
When you do so, all the special features applied to the selected table are removed, leaving 
most of the formatting intact. (Remember, you need to click a cell in the table to display 
the Table Tools Design tab.) Figure 9-11 shows the message that appears when you click 
Convert To Range.

Convert To Range removes the Filter menus from the selected table, discontinues displaying 
the Table Tools Design tab, turns off any additional table features (such as automatic cell 
banding and totals), and relegates the range formerly known as Table to simple “formatted 
cells” status. Any visible table formatting you applied remains (including the totals row), but 
the automatic table functionality disappears. Even the banding formats remain, but they 
are no longer dynamic or automatic. Converting your table in this way makes sense if you 
don’t want to deal with the automatic accoutrements such as Filter menus. This technique 
is a great way to take advantage of automatic table formatting features for cell ranges that 
you just want to format uniformly.
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the formatting.

Painting Formats

One of the most useful tools on your formatting tool belt is the Format Painter button. The 
Clipboard group on the Home tab is home to the Format Painter button, which looks like 
a little paintbrush. Select the cell or range from which you want to copy formatting, and 
click the Format Painter button. (A small paintbrush icon appears next to the pointer.) Then 
select the cell or drag through the range of cells to which you want to copy the formatting. 
It’s that simple.

If you copy formats from a range of cells and then select a single cell when you paste, For-
mat Painter selects and formats the same size range—from the selected cell down and to 
the right. However, if you select a range of cells when you paste formats, Format Painter 
limits the pasted formats to the shape of the destination range you select. If the range you 
want to format is a different shape from the copied range, the pattern is repeated or trun-
cated as necessary.

Note
To remove all formatting, select a cell or range, click the Clear menu (located in the 
Editing group on the Home tab of the ribbon), and click Clear Formats. To remove the 
values as well as the formatting in selected cells, click Clear All on the menu. For more 
information, see “Clearing Cells” on page 220.

Format Painter

Clear



Chapter 9

300	 Chapter 9  Worksheet Formatting Techniques

Using Themes and Cell Styles
Excel 2010 now offers a couple of ways to format globally—meaning you can perform cer-
tain tasks to help standardize the look of your worksheets and create a consistent appear-
ance for all your documents.

Formatting with Themes

A theme is a set of formatting attributes that apply specifically to the line and fill effects, the 
color palette, and the fonts that are available when formatting documents. The three but-
tons that control these attributes—Colors, Fonts, and Effects—appear in the Themes group 
on the Page Layout tab, shown in Figure 9-12. Themes give individuals or workgroups using 
Microsoft Office programs (versions 2007 and 2010) the ability to use the same sets of basic 
design attributes for all the documents they create. You’ll find corresponding themes in 
Microsoft PowerPoint and Microsoft Word as well. You can use themes to standardize all 
your internal documents, for example, or to maintain a consistent look between pages in a 
package of presentation handouts.

Figure 9-12  Themes control the overall palette of available colors, fonts, and effects.

When you apply a theme using the Themes button, all applicable formats in the active 
workbook change instantly, including the colors of text, background, accents and hyper-
links, heading and body text fonts, line and fill effects, and even graphics, as shown in Fig-
ure 9-13. This happens regardless of the number of cells you have selected.
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Figure 9-13  Changing the theme instantly changes the look of all the worksheets in the active 
workbook.

Just as when you choose a theme, changes you make using the Colors, Fonts, or Effects 
galleries are reflected immediately throughout the workbook. The Colors gallery contains 
a selection of coordinated color schemes that, when selected, change the available colors 
in all other galleries where colors are used. The Fonts gallery offers a selection of font sets 
including two fonts each—one for headings and one for body text. The Effects gallery gives 
you a choice of graphic “looks,” accomplished using various applications of line and fill 
effects that reflect the current color scheme.

CAUTION!
Themes have no effect on cells to which you have directly applied font, color, line, or 
fill formatting using settings that are not part of a theme.

Creating Custom Themes

You can save your own themes using the Save Current Theme command at the bottom 
of the Themes gallery, which you can see in Figure 9-12. Doing so creates a .thmx file and 
saves it in a special folder on your computer. The name you give the file when you save it 
becomes the name of the theme, which subsequently appears in the Custom category at 
the top of the Themes gallery, as shown in Figure 9-14. The Custom category appears only 
if a custom theme exists.
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Figure 9-14  The Custom category is created in the Themes gallery when you save a custom 
theme.

The Browse For Themes button at the bottom of the Themes gallery lets you load .thmx 
files from other locations, such as a company theme file on your network, for example.

INSIDE OUT  �
Mousing Around

Microsoft has gone to great lengths to try to make features more discoverable and 
self-explanatory. It crafted a new approach for many of the commands that used to 
live on menus, transforming them into drop-down galleries containing thumbnail rep-
resentations of the options they offer. In many cases, these galleries exhibit “live pre-
view” functionality, where you can rest the pointer on items in the gallery to get a live 
preview in the worksheet of what would happen if you actually clicked. This is a great 
feature, but it can be finicky. For example, if you convert an older Excel file and try to 
use the Themes gallery in this way, you might find that not much seems to happen. 
This can occur when formatting in the old file overrides the default font, color, line, or 
fill styles controlled by themes. For example, the default font in Excel 2003 is Arial, and 
the default font in Excel 2010 is Calibri. When you convert an old Excel file, the original 
fonts carry over as well. Resting the pointer on the Themes gallery might not show any 
changes in the font, and indeed, applying a theme might not have any effect either.
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To get around this problem, you can start with a fresh workbook and type everything 
again (but who wants to do that?), or you can copy the contents of each worksheet in 
the old workbook and click Paste, Paste Values (on the Home tab) to add the data to 
the new workbook. This requires you to redo all the formatting, but that should be a 
lot easier with the tools in Excel 2010. Another approach is to reformat all the text in 
the converted workbook using one of the fonts from the current theme. Use the same 
approach to convert any colors, lines, or fill styles to use current theme styles.

Formatting with Cell Styles

The relatively new Cell Styles feature bears little resemblance to the fairly old Styles feature, 
although the basic idea is the same: applying combinations of formatting attributes all at 
once to eliminate a lot of time clicking buttons, opening dialog boxes, and choosing indi-
vidual options. Cell styles help you achieve consistency in formatting, both within a work-
sheet and across worksheets and workbooks. Using cell styles, you can easily modify the 
formatting characteristics of many cells at once.

Note
Cell styles are based on the formatting attributes of the current theme. Changing the 
theme causes the displayed cell styles to update accordingly.

The Cell Styles button appears in the Styles group on the Home tab on the ribbon. Cell 
styles wield the following formatting attributes: number and fill formatting, cell alignment, 
fonts, borders, and even cell-level protection settings. Several built-in cell styles have spe-
cific purposes, as you can see in Figure 9-15, and you can create your own custom styles 
(designed in concert with your company theme, perhaps).

You’ll find the following six cell style categories, with individual styles that have uses sug-
gested by their titles and the categories in which they live:

●● Good, Bad And Neutral  If you want, you can use these styles when highlighting 
good news, bad news, and . . . just plain old news. The Normal style also lives here, 
which you can use to “reset” selected cells to default formatting.

●● Data And Model  These styles are intended for specific purposes, such as Input 
and Output styles for cells that are meant to accept user input or reveal the results of 
calculations.
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●● Titles And Headings  The intended use is self-explanatory, but it’s interesting to 
note that the top three Heading styles include bottom borders of different weights, 
making them useful for creating color-coordinated column headers in tables.

●● Themed Cell Styles  These Accent and Emphasis styles are heavily dependent on 
the current theme colors, offering four graduated percentages of each Accent color 
for quartile comparisons.

●● Number Format  Included for continuity, these styles are actually more accessible 
using the Number buttons on the Home tab on the ribbon.

●● Custom  This category does not appear in the gallery until you create a custom 
style. After you do, the Custom category appears at the top of the gallery.

The Cell Styles gallery exhibits “mouse hover” functionality, letting you see a live preview 
in selected cells on the worksheet when you rest the pointer on an item in the gallery. To 
apply a style, select the cells you want to format, and click your chosen style in the gallery.

Figure 9-15  The Cell Styles gallery offers categories of styles based on the current theme.

Creating Custom Cell Styles

You can create your own styles using one of two methods: by modifying an existing style 
or by clicking the New Cell Style command at the bottom of the Cell Styles gallery, which 
displays the Style dialog box shown in Figure 9-16.
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Figure 9-16  Use the Style dialog box to create your own cell styles.

The Style dialog box opens with the attributes of the default Normal style displayed. Styles 
can have a minimum of one and a maximum of six sets of attributes: Number, Alignment, 
Font, Border, Fill, and Protection, each with a corresponding check box in the Style dialog 
box. Use the check boxes to specify the attributes you want for your cell style. For example, 
you could clear all but the Protection check box to define a style that does nothing more 
than change selected cells to “unlocked” status, allowing user entries on a protected work-
sheet. Using such a style would have no effect on any of the other five style attributes in 
cells to which it is applied.

To specify style attributes, click the Format button to display the Format Cells dialog box, 
where you can specify your formatting choices in detail. The Format Cells dialog box con-
tains six tabs corresponding to the six categories of style attributes; you can make as many 
choices as you want on each tab. When you finish with the Format Cells dialog box, click 
OK to close it and return to the Style dialog box. Then type a name in the Style Name box, 
and click OK. Your custom style appears in the Custom category at the top of the Cell Styles 
gallery, as shown in Figure 9-17, where you can see the Unlocked style we created.

For more information about the Format Cells dialog box, see “Formatting Numbers” on 
page 324.
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Figure 9-17  Custom styles appear at the top of the Cell Styles gallery.

As you can see in Figure 9-17, you can right-click a cell style to display a shortcut menu you 
can use to delete, modify, or duplicate the style. Duplication is handy if, for example, you 
want to create a number of related styles with different fill percentages. Clicking the Dupli-
cate command would make it easier because it copies the other attributes for you—all you 
have to do is change the fill percentage.

Creating Cell Styles by Example  If you have formatted a cell using attributes you want to 
use often, you can use the style-by-example procedure to encapsulate those attributes in a 
new style. For example, suppose you format a cell with right alignment and 18-point Arial 
Black. To make this combination of attributes a new style, follow these steps:

	 1.	 Select the cell that contains the formatting you want.

	 2.	 On the ribbon, click Home, Cell Styles, New Cell Style.

	 3.	 Type a name such as HeadRight in the Style Name box.

	 4.	 Clear the Number, Border, Fill, and Protection check boxes in the Style Includes area, 
and click OK. The new style then appears in the Cell Styles gallery.
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CAUTION!
The safest way to create a style by example is to select only one cell—one you know 
has all the attributes you want to assign to the new style. If you select two or more cells 
that are not formatted identically, the new style assumes only those attributes that all 
cells in the selection have in common.

Modifying and Duplicating Cell Styles  The principal advantage of using styles is that if 
you change your mind about the appearance of a particular element in your workbook, 
you can revise every instance of that element at once by changing the style. For example, 
if you’d like the font in the custom HeadRight style—which is now 18-point Arial Black—to 
also be italic, you can redefine HeadRight.

To modify a style definition, follow these steps:

	 1.	 Click Home, Cell Styles.

	 2.	 Right-click the thumbnail for the style (in this case, HeadRight) in the gallery, and 
click Modify to display the Style dialog box.

	 3.	 Click the Format button to display the Format Cells dialog box, and select the 
appropriate format options, as shown in Figure 9-18. (For this example, click the Font 
tab, and select the Italic option in the Font Style list.)

	 4.	 Click OK to return to the Style dialog box, then click OK to confirm your changes.

You can also right-click an existing style and click the Duplicate command, which opens a 
Style dialog box similar to the one shown in Figure 9-18 and appends a number to the end 
of the style name. You can then change the name if you like and click the Format button to 
make adjustments to the formatting attributes. Using Duplicate is helpful when you want 
to create a number of similar styles or when you want to base a custom style on one of the 
built-in styles. When you finish defining the style, click OK; your new style appears in the 
Custom category of the Cell Styles gallery.

Note
The predefined Normal style is applied to every cell in every new workbook. Thus, if 
you want to use the standard set of formatting attributes, you don’t need to do any-
thing. If, however, you want to change the default attributes for all cells in a worksheet, 
you can redefine any or all attributes of the Normal style.
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Figure 9-18  Modify an existing cell style by right-clicking its thumbnail in the gallery and 
clicking Modify.

Merging Cell Styles from Different Workbooks  To maintain formatting consistency 
across a group of worksheets, you can keep the worksheets in the same workbook. If this is 
impractical but you still want to maintain stylistic consistency, you can copy style definitions 
between workbooks. (Of course, themes are also helpful in this regard and are covered in 
“Formatting with Themes” on page 300.)

To copy a style from one workbook to another, take the following steps:

	 1.	 Open both the source workbook (the one you’re copying from) and the destination 
workbook (the one you’re copying to).

	 2.	 Click the destination workbook to make it the active window.

	 3.	 On the ribbon, click Home, Cell Styles, Merge Styles. Excel displays a dialog box 
listing all the other open workbooks, as shown in Figure 9-19.
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Figure 9-19  Copy cell styles from any open workbook using the Merge Styles command.

	 4.	 Select the name of the workbook you want to copy styles from, and click OK.

CAUTION!
If a style in the source workbook has the same name as one already in your destina-
tion workbook, a message asks whether you want to merge styles that have the same 
names. You receive this warning only once, however, no matter how many duplicate 
style names exist. If you click Yes, the styles from the source workbook override those 
with the same names in the destination workbook.

Deleting a Cell Style  To delete a style, click Home, Cell Styles, and right-click the custom 
style you want to delete. (You cannot delete a built-in cell style.) Then click Delete. Any cells 
formatted using the deleted style revert to the Normal style.

Formatting Conditionally
Conditional formats respond to the contents of cells. They are almost always applied to 
groups of cells—often rows or columns of totals—if not entire tables. Click Home, Condi-
tional Formatting to display the menu shown in Figure 9-20.

Excel 2010 offers five flavors of formatting features you can use for your conditional 
creations:

●● Highlight Cells Rules  Formatting you apply to cells that stays “asleep” until the 
values (numeric or text) the cells contain achieve the specified state. Click Greater 
Than, Less Than, Between, Equal To, Text That Contains, A Date Occurring, or Dupli-
cate Values to display a dialog box where you can specify the appropriate criteria.
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●● Top/Bottom Rules  Selected formatting applied to all cells in a range that are 
greater than or less than a given threshold. Click Top N Items, Top N %, Bottom N 
Items, Bottom N %, Above Average, or Below Average to display a dialog box where 
you can specify the appropriate criteria.

●● Data Bars  Gradient fills of color within cells. The bars’ lengths indicate the values 
in the cells relative to all other adjacent cells formatted using the same conditions. 
Choose from a number of different colors, based on the current theme.

●● Color Scales  Two-color or three-color formats whose color indicates the values 
in the cells relative to all other adjacent cells formatted using the same conditions. 
Choose from a number of different color combinations, based on the current theme.

●● Icon Sets  Sets of three, four, or five tiny graphic images placed inside cells. The 
icons’ shape or color indicates the values in the cells relative to all other adjacent cells 
formatted using the same conditions. Choose from a number of different types of 
icons.

Figure 9-20  The conditional formatting features in Excel 2010 are powerful and easy to use.

For example, you could apply conditional formatting to a range of cells that contain sales 
totals, specifying that if any of the totals drops to less than $1,000, the format of the cell 
changes to stand out from the other cells. To do so, follow these steps:

	 1.	 Select the cells you want to format.

	 2.	 Click Conditional Formatting, Highlight Cells Rules, Less Than to display the dialog 
box shown in Figure 9-21.
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	 3.	 Type the number you want to use as the threshold for this condition; in this case, 
1000.

	 4.	 Select one of the options from the drop-down list of available formats.

Notice that when you select a format option from the Highlight Cells Rules menu, 
Excel previews it for you on the worksheet. Type a number in the Format Cells That 
Are Less Than box, select a format option from the drop-down list, and the preview 
adjusts accordingly. Clicking the Custom Format option at the bottom of the list dis-
plays a version of the Format Cells dialog box with the Number, Font, Border, and Fill 
tabs available.

	 5.	 Click OK.

Figure 9-21  Select the Less Than rule on the Highlight Cells Rules menu to create a stoplight 
chart using conditional formatting.

Figure 9-22 shows a table after applying conditional formatting. This example was format-
ted using two highlight cells conditions: one format for numbers greater than 9,000 and a 
different format for numbers less than 1,000.

You’ll find the Sales by Product.xlsx file with the other examples on the companion 
Web site.
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Figure 9-22  We created two conditions—one to flag high values and one to flag low values. 
These guys had a rough January.

This procedure is essentially the same for all the highlight cells and top/bottom rules, but 
several of these rules deserve additional comment:

●● Between  This is obvious perhaps, but although the Greater Than, Less Than, 
and Equal To rules require you to type a single number criterion, the Between rule 
requires two criteria.

●● Text That Contains  When you choose this rule, cells containing any form of the 
text string you type as a criterion are highlighted (entering “and” highlights cells con-
taining sand, Andrew, and so on).

●● A Date Occurring  This rule always uses the current date as the point of reference. 
The “occurring” options are all relative to this: Yesterday, Last Week, Next Month, and 
so on.

●● Duplicate Values  This rule actually has two options, highlighting either duplicate 
or unique values.

The highlight cells rules are the only ones that operate independently of other cells. That 
is, each cell is evaluated against criteria individually and formatted accordingly. All other 
conditional formats depend entirely on the rest of the cell values formatted using the same 
condition. For example, Figure 9-23 shows the same top/bottom rule applied to two differ-
ent selected regions (in this case, we specified the top five).
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Figure 9-23  We used the same top/bottom rule on two different selections, with different 
results.

As you can see in Figure 9-23, cell F10 drops out of the top five, and cell C14 is added 
to the top five when we select a different range of cells. Excel uses all the values in the 
selected cell range to determine which cells to format. For data bars, color scales, and icon 
sets, Excel actually applies formatting to every cell in the selected range but adjusts the 
color, size, or icon based on each cell’s value relative to the whole.

Data bars are a unique type of conditional format because each cell actually contains the 
same color (actually, a gradation of color), but the size of the colored area varies in each 
cell to reflect the cell’s value relative to the other selected cells. Figure 9-24 shows a live 
preview of the orange data bar.

All these conditional formats are pretty flashy, and they definitely help identify relative val-
ues in a range, but you can begin to see that too much conditional formatting can become 
counterproductive. As with any flashy feature, it’s easy to love it a little too much, so make 
sure you’re serving the purpose of your worksheet. Figure 9-25 shows what might be con-
sidered a more judicious application of conditional formatting using highlight cells and 
data bars.
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Figure 9-24  You can rest the pointer on items on the Data Bars menu to see a live preview on 
your worksheet.

Figure 9-25  We used highlight cells in the body of this table and data bars in the Totals column.



	 Formatting Conditionally	 315

Ch
ap

te
r 9

Creating Conditional Formatting Rules

Excel provides quite a nice variety of conditional formatting options, but you can always 
create your own as well. You may have noticed the New Rule command at the bottom of 
the Conditional Formatting menu and the ubiquitous More Rules command on each sub-
menu. These all do essentially the same task—display the New Formatting Rule dialog box 
shown in Figure 9-26.

Figure 9-26  Use the New Formatting Rule dialog box to construct your own conditional formats.

All these commands open the same dialog box, but based on the menu or submenu where 
you clicked the command, a different rule type is selected when it opens. Each rule type 
displays a different set of rule-description criteria below it. To display the dialog box in 
Figure 9-26, we clicked Conditional Formatting on the Home tab, then Icon Sets, and then 
the New Rule command. Each format style has a different set of controls for creating condi-
tional formatting rules.

The first rule type—Format All Cells Based On Their Values—contains all the controls for 
creating data bars, color scales, and icon sets. The rule description controls for the second 
rule type—Format Only Cells That Contain, shown in Figure 9-27—is what you use to create 
highlight cells rules. The controls for the remaining rule types are similar to this one.

We discuss the last rule type, Use A Formula To Determine Which Cells To Format, in “Creating 
Conditional Formatting Formulas” on page 319.
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Figure 9-27  Use the second rule type in the New Formatting Rule dialog box to create your own 
highlight cells rules.

Use the Edit The Rule Description area to define your formats. This area changes depending 
on the rule selected. With Format Only Cells That Contain selected, the first drop-down list 
in this area (shown in Figure 9-27) allows you to define rules for highlighting Specific Text, 
Dates Occurring (relative to now), Blanks, No Blanks, Errors, or No Errors. Then, select an 
operator (Between, Not Between, Equal To, Not Equal To, Greater Than, Less Than, Greater 
Than Or Equal To, Less Than Or Equal To) and type comparison values in the remaining text 
boxes.

After you establish the rule description criteria, click the Format button. An abbreviated 
version of the Format Cells dialog box appears, containing only Number, Font, Border, and 
Fill tabs. Specify any combination of formats you want to apply when your rule is triggered. 
When you finish, click OK to return to the New Formatting Rule dialog box, and click OK 
again to save your new rule. You can create as many rules as you want; next, we’ll discuss 
how to work with them.

Managing Conditional Formatting Rules

You can apply as many conditional formats as you think are necessary—using three or 
more per table is not uncommon. But it is also not uncommon for you to tweak some of 
the numbers or adjust some of the formatting. To do so, click Home, Conditional Format-
ting, Manage Rules to display a Conditional Formatting Rules Manager dialog box similar 
to the one shown in Figure 9-28.
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Figure 9-28  Use the Conditional Formatting Rules Manager dialog box to tweak any rules that 
have been applied in a workbook.

You can use the Show Formatting Rules For drop-down list at the top of the dialog box 
to choose where to look in the current workbook for rules: Each worksheet in the cur-
rent workbook is listed here, or you can choose This Worksheet or Current Selection (the 
default). As you can see in Figure 9-28, you can create, edit, and delete rules by using 
corresponding buttons. When you click New Rule, the now-familiar New Formatting Rule 
dialog box appears. When you click Edit Rule, a similar dialog box appears (Edit Formatting 
Rule) with the criteria for the selected rule displayed.

Excel applies the rules listed in the Conditional Formatting Rules Manager dialog box in the 
order in which they appear in the Rule list—new rules are added to the top of the list and 
are processed first. Use the two arrow buttons next to Delete Rule to move a selected rule 
up or down in the precedence list. The Applies To box contains the address of the cell range 
to which the rule is applied. If you want to change the cell range, click the Collapse button 
at the right end of the Applies To text box to collapse the dialog box, letting you see the 
worksheet, as shown in Figure 9-29. When you do so, you can drag to select the cell range 
you want and insert the range address in the text box. To restore the dialog box to its origi-
nal size, click the Collapse (now Expand) button again.

The Stop If True check box is present in this dialog box only for backward compatibility. 
Previous versions of Excel cannot recognize multiple conditional formatting rules, and 
instead they apply the rule that occurs last in precedence. If you need to share files with 
older versions, you need to choose which conditional formatting rule you prefer. Select 
the Stop If True check box for the last rule in the list if you want Excel to use the previous 
rule; select the Stop If True check box for the last two rules to use the third-to-last rule, 
and so on.



Chapter 9

318	 Chapter 9  Worksheet Formatting Techniques

Figure 9-29  Click the Collapse button in the Applies To text box to minimize the dialog box and 
allow direct selection of the cell range you want.

Note
When two (or more) conditional rules are true for a particular cell, but they are both set 
to apply a similar format, such as font color, the rule that is higher in the Conditional 
Formatting Rules Manager dialog box’s list of precedence wins. Try to make multiple 
conditions compatible by having each rule apply a different type of format, such as the 
first rule applying cell color, the second applying font color, and the third applying bold 
formatting. In addition, conditional formats override manual formats when the condi-
tion in the cell is true.

Copying, Clearing, and Finding Conditional Formats

You can copy and paste conditionally formatted cells and use the Fill features or the Format 
Painter button to copy cells that you have conditionally formatted. When you do, the con-
ditional rules travel with the copied cells, and a new rule is created that references the new 
location in the workbook.

To remove conditional formatting rules, click Home, Conditional Formatting, Clear Rules, 
and then click Clear Rules From Selected Cells or Clear Rules From Entire Sheet to clear all 
the corresponding rules. If your conditions have been applied to a table or a PivotTable, 
additional corresponding commands are available.
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You can use two commands on the Find & Select menu on the Home tab to locate cells on 
the current worksheet that conditional formats are applied to. The Conditional Formatting 
command locates and selects all the cells on the current worksheet to which conditional 
formats are applied. If conditional formatting exists in more than one cell region on the 
worksheet, using this command selects all the regions. This makes it easy to edit all the 
rules using the Conditional Formatting Rules Manager dialog box (refer to Figure 9-28). 
You can also use the Go To Special command on the Find & Select menu to get a little more 
specific. Clicking this command displays the Go To Special dialog box, shown in Figure 9-30.

Figure 9-30  Use the Go To Special dialog box to locate all conditional formats or just matching 
ones.

When you select the Conditional Formats option, two additional options—All and Same—
become available. Selecting All is the same as using the Conditional Formatting command 
on the Find & Select menu to select all conditionally formatted cells and regions. If you use 
the Same option, however, Go To Special finds only those cells that are formatted using the 
same condition that exists in the selected cell. Before clicking the Go To Special command, 
select a cell containing the conditional format you want to locate.

Creating Conditional Formatting Formulas

The last rule type in the New Formatting Rule dialog box shown in Figure 9-26 offers the 
ability to create your own conditional formatting formulas. When you select the rule type 
labeled Use A Formula To Determine Which Cells To Format, the dialog box looks similar to 
the one shown in Figure 9-31.
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Figure 9-31  Use the last rule type in the list to create your own conditional formatting formulas.

You can create formulas to perform tasks such as identifying dates that fall on specific days 
of the week, specifying particular values, or doing anything you can’t quite accomplish 
using the built-in conditional formatting tools. For example, using our worksheet example, 
we typed the following formula in the Format Values Where This Formula Is True text box in 
the New Formatting Rule dialog box:

=IF(ISERROR(B4),0)=0

Then we clicked the Format button and selected a color on the Fill tab. The formula 
applies the selected fill color to any cell that generates an error value. (The cell refer-
ence B4 is the relative reference of the top-left cell of the range to which the format is 
applied.) When you use this technique, you can type any formula that results in the logi-
cal values TRUE (1) or FALSE (0). For example, you could use a logical formula such as 
=N4>AVERAGE($N$4:$N$37), which combines relative and absolute references to apply 
formatting to a cell when the value it contains is less than the average of the specified 
range. When you use relative references in this situation, the formatting formulas adjust in 
each cell where you apply or copy them, just as regular cell formulas do.

For more information, see “Using Cell References in Formulas” on page 468 and “Understanding 
Logical Functions” on page 550; also see Chapter 14, “Everyday Functions,” and Chapter 15, “For-
matting and Calculating Date and Time.”
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Formatting in Depth
The formatting features in Excel 2010 control the display characteristics of numbers and 
text. It is important to keep in mind the difference between underlying and displayed 
worksheet values. Formats do not affect the underlying numeric or text values in cells. 
For example, if you type a number with six decimal places in a cell that is formatted with 
two decimal places, Excel displays the number with only two decimal places. However, the 
underlying value isn’t changed, and Excel uses the underlying value in calculations.

Note
When you copy a cell or range of cells, you copy both its contents and its formatting. If 
you then paste this information into another cell or range, the formatting of the source 
cells normally replaces any existing formatting. For more information about copying 
and pasting, see Chapter 8, “Worksheet Editing Techniques.”

Most of your formatting needs should be quickly and easily fulfilled using buttons and 
controls located on the Home tab on the ribbon, but for more options, you can employ the 
Format Cells dialog box. To display the Format Cells dialog box, press Ctrl+1. Alternatively, 
click one of the dialog box launchers adjacent to the titles of the Font, Alignment, and 
Number groups on the Home tab. Clicking a dialog box launcher also activates the corre-
sponding tab. Figure 9-32 shows the Format Cells dialog box.

Throughout the following sections we’ll discuss formatting options available directly on the 
ribbon, but we’ll go into more depth by employing the Format Cells dialog box.

Formatting Individual Characters

If you select a cell and apply formats, the entire contents of the cell receive the formats. 
However, you can also apply formatting to individual text characters within cells (but not 
numeric values or formulas). Select individual characters or words inside a cell, and apply 
the attributes you want. When you are finished, press Enter to see the results, an example 
of which is shown in Figure 9-33.

For more examples of formatting individual characters, see “Using Fonts” on page 351.
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Figure 9-32  Click the dialog box launcher in the Number group to display the Number tab of 
the Format Cells dialog box.

Figure 9-33  You can format individual characters within a cell.

Formatting as You Type

You can include special formatting characters—such as dollar signs, percent signs, commas, 
or fractions—to format numbers as you type them. When you type numeric-entry charac-
ters that represent a format Excel recognizes, Excel applies that format to the cell on the fly. 
The following list describes some of the more common special formatting characters:

●● If you type $45.00 in a cell, Excel interprets your entry as the value 45 formatted as 
currency with two decimal places. Only the value 45 appears in the formula bar after 
you press Enter, but the formatted value, $45.00, appears in the cell.
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●● If you type 1 3/8 (with a single space between 1 and 3), 1 3/8 appears in the cell and 
1.375 appears in the formula bar. However, if you type 3/8, then 8-Mar appears in 
the cell, because date formats take precedence over fraction formats. Assuming you 
make the entry in the year 2010, then 3/8/2010 appears in the formula bar. To display 
3/8 in the cell as a fraction so that 0.375 appears in the formula bar, you must type 0 
3/8 (with a space between 0 and 3). For information about typing dates and a com-
plete listing of date and time formats, see “Entering Dates and Times” on page 566.

●● If you type 23% in a cell, Excel applies the no-decimal percentage format to the cell, 
and 23% appears in the formula bar. Nevertheless, Excel uses the 0.23 decimal value 
for calculations.

●● If you type 123,456 in a cell, Excel applies the comma format without decimal places. 
If you type 123,456.00, Excel formats the cell with the comma format including two 
decimal places.

Note
Leading zeros are almost always dropped, unless you create or use a format specifically 
designed to preserve them. For example, when you type 0123 in a cell, Excel displays 
the value 123, dropping the leading zero. Excel provides custom formats for a couple 
of commonly needed leading-zero applications, namely ZIP codes and social security 
numbers, on the Number tab, Special category of the Format Cells dialog box. For 
more information, see “Using the Special Formats” on page 332. For information about 
creating your own formats, see “Creating Custom Number Formats” on page 333.

Understanding the General Format

The General format is the default format for all cells. Although it is not just a number for-
mat, it is nonetheless always the first number format category listed. Unless you specifically 
change the format of a cell, Excel displays any text or numbers you type in the General for-
mat. Except in the cases listed next, the General format displays exactly what you type. For 
example, if you type 123.45, the cell displays 123.45. Here are the four exceptions:

●● The General format abbreviates numbers too long to display in a cell. For example, 
if you type 12345678901234 (an integer) into a standard-width cell, Excel displays 
1.23457E+13.

●● Long decimal values are also rounded or displayed in scientific notation. Thus, if 
you type 123456.7812345 in a standard-width cell, the General format displays 
123456.8. The actual typed values are preserved and used in all calculations, regard-
less of the display format.



Chapter 9

324	 Chapter 9  Worksheet Formatting Techniques

●● The General format does not display trailing zeros. For example, if you type 123.0, 
Excel displays 123.

●● A decimal fraction typed without a number to the left of the decimal point is dis-
played with a zero. For example, if you type .123, Excel displays 0.123.

Formatting Numbers

The second option in the drop-down list displayed in the Number group on the Home tab 
is called, helpfully, Number. When you use the drop-down list, selecting Number applies 
a default number format, with two decimal places and comma separators. For example, if 
you apply the Number format with a cell selected containing 1234.556, the cell displays 
the number as 1,234.56. Excel rounds the decimal value to two places in the process, which 
does not change the actual value in the cell, just the displayed value.

Note
The Comma Style button in the Number group on the Home tab applies the same for-
mat as does the Number format in the drop-down list.

In the Format Cells dialog box, the Number category contains additional options, letting 
you display numbers in integer, fixed-decimal, and punctuated formats, as shown in Fig-
ure 9-34. It is essentially the General format with additional control over displayed decimal 
places, thousand separators, and negative numbers. You can use this category to format 
any numbers that do not fall into any of the other categories.

Follow these guidelines when using the Number category:

●● Select the number of decimal places to display (0 to 30) by typing or scrolling to the 
value in the Decimal Places box.

●● Select the Use 1000 Separator (,) check box to add commas between hundreds and 
thousands, and so on.

●● Select an example in the Negative Numbers list to display negative numbers pre-
ceded by a minus sign, in red, in parentheses, or in both red and parentheses.

Comma Style
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Note
When formatting numbers, always select a cell containing a number before opening 
the Format Cells dialog box so that you can see the actual results in the Sample area.

Figure 9-34  Use the Number category for general-purpose, noncurrency numeric formatting.

Using Currency Formats

The quickest way to apply currency formatting is by clicking Currency in the Number drop-
down list in the Number group on the Home tab, as shown in Figure 9-35. The Currency 
format is similar to the Number format that precedes it in the drop-down list, except it also 
includes the default currency symbol for your locale. Notice that most of the commands 
listed here display little previews showing you what the contents of the active cell will look 
like if you click that command.
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Note
Despite the button’s appearance, clicking the $ button on the Home tab actually 
applies a two-decimal Accounting format, which is similar to, but a little different from, 
the Currency format. We’ll discuss Accounting formats in the next section.

Figure 9-35  The contents of the selected cell are previewed below each command in the 
Number drop-down list.

For additional currency formatting options, select the Currency category in the Format Cells 
dialog box, which offers a similar set of options as the Number category (refer to Figure 
9-34) but adds a drop-down list of worldwide currency symbols. Besides clicking the dialog 
box launcher in the Number group on the Home tab to display the Format Cells dialog box, 
you can also select the More Number Formats command at the bottom of the Number 
drop-down list shown in Figure 9-35.
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Using the Decimal Buttons
You can change the number of displayed decimal places in any selected cell or range at 
any time using two buttons—Increase Decimal and Decrease Decimal—in the Number 
group on the Home tab:

The Increase Decimal button displays an arrow pointing to the left, and the Decrease 
Decimal button displays an arrow pointing to the right, which might seem backward 
to those of us in the left-to-right/smaller-to-larger world of Western culture, but of 
course these buttons address what happens only on the right side of the decimal point. 
Each click adds or subtracts one decimal place from the displayed value. Interestingly, 
although you can specify up to 30 decimal places using the Format Cells dialog box, 
you can increase the number of decimal places to a maximum of 127, one click at a 
time, using the Increase Decimal button.

Using Accounting Formats

The most-often-used Accounting format is directly available on the Home tab on the rib-
bon, using the Accounting Number Format button in the Number group. Clicking this 
button applies a standard two-decimal-place format with comma separators and currency 
symbols to the selected cells. Clicking the arrow button adjacent to the Accounting Num-
ber Format button displays a menu providing access to a few additional currency symbols, 
as shown in Figure 9-36.

Accounting Number 
Format
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Figure 9-36  The $ button applies a standard Accounting format and offers a few optional 
currency symbols.

The Accounting formats address the needs of accounting professionals, but they benefit the 
rest of us as well. When you use one of these formats with the Single Accounting or Double 
Accounting font formats (to add underlines to your numbers), you can easily create profit 
and loss (P&L) statements, balance sheets, and other schedules that conform to generally 
accepted accounting principles (GAAP). The Accounting formats correspond roughly to the 
Currency format in appearance—you can display numbers with or without your choice of 
currency symbols and specify the number of decimal places. However, the two formats have 
some distinct differences. The rules governing the Accounting formats are as follows:

●● The Accounting format displays every currency symbol flush with the left side of 
the cell and displays numbers flush with the right side, as shown in Figure 9-36. The 
result is that all the currency symbols in the same column are vertically aligned, which 
looks much cleaner than Currency formats.

●● In the Accounting format, negative values are always displayed in parentheses and 
always in black—displaying numbers in red is not an option.

●● The Accounting format includes a space equivalent to the width of a parenthesis on 
the right side of the cell so that numbers line up evenly in columns of mixed positive 
and negative values.

●● The Accounting format displays zero values as dashes. The spacing of the dashes 
depends on whether you select decimal places. If you include two decimal places, the 
dashes line up under the decimal point.

●● Finally, the Accounting format is the only built-in format that includes formatting cri-
teria for text. It includes spaces equivalent to the width of a parenthesis on each side 
of text so that it too lines up evenly with the numbers in a column.

Typically, when creating a GAAP-friendly worksheet of currency values, you would use 
currency symbols only in the top row and in the totals row at the bottom of each column 
of numbers. This makes good sense because using dollar signs with every number would 
make for a much busier table. The middle of the table is then formatted using a compatible 
format without currency symbols, as shown in Figure 9-37.
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Figure 9-37  It is standard practice to use currency symbols only in the top and bottom rows of a 
table.

Luckily, Excel makes it easy for you to format this way by using buttons in the Number 
group on the Home tab. Despite seemingly incompatible button names, both the Account-
ing Number Format button and the Comma Style button apply Accounting formats adher-
ing to the rules described earlier. So, to format the numeric entries in the table shown in 
Figure 9-37, select the first and last rows, click the Accounting Number Format button, then 
select all the cells in between, and click the Comma Style button. (We then selected all the 
numeric cells in the table and clicked the Decrease Decimal button twice to hide all the 
decimal values.)

Using Accounting Underlines
Generally accepted accounting principles specify the proper usage of single and double 
underlines in tables. The Underline button on the Home tab includes a menu letting 
you select single or double underlines, but unfortunately these do not rise to the 
accepted standard. But fear not—Excel provides two accounting-specific underline for-
mats in a drop-down list of the same name on the Font tab in the Format Cells dialog 
box. These differ from their regular counterparts in two ways. First, accounting under-
lines are applied to the entire width of the cell (minus a parenthesis-sized space on 
each side), whereas regular underlines are applied only under the actual characters in a 
cell. If the cell contains a text entry that extends beyond the cell border, the account-
ing underlines stop at the cell border. Second, the accounting underline formats appear 
near the bottom of cells, unlike regular underlines, which are applied much closer to 
the numbers or text in the cell, resulting in annoying lines through commas and the 
descenders of letters like g and p. Of course, you can also apply single-line and double-
line cell borders instead of underline formats, which is the approach used when you 
add a totals row to a table using the Totals Row option on the Table Tools Design tab.
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For information about font formats, see “Using Fonts” on page 351. For information about 
tables, see “Formatting Tables” on page 292.

Formatting Percentages

Not surprisingly, using the Percentage format displays numbers as percentages. The deci-
mal point of the formatted number, in effect, moves two places to the right, and a percent 
sign appears at the end of the number. For example, if you choose a percentage format 
without decimal places, the entry 0.1234 is displayed as 12%; if you select two decimal 
places, the entry 0.1234 is displayed as 12.34%. Remember that you can always adjust 
the number of displayed decimal places using the Increase Decimal and Decrease Decimal 
buttons.

An interesting (and helpful) quirk about percentage formats is that they behave differently 
depending on whether you type a number and then apply the format or type a number in 
a previously formatted cell. For example, Figure 9-38 shows two cells formatted as percent-
ages. We typed the same number—22.33—in each cell, but only cell A1 was previously 
formatted with the Percentage format; we clicked the Percent Style button after typing the 
value in cell A2.

Figure 9-38  When using percentages, it makes a difference whether you format before or after 
typing values.

As you can see, it makes a world of difference which way you do this. So, why is this behav-
ior helpful? For example, if a worksheet contains a displayed value of 12% and you need 
to change it to 13%, typing 13 in the cell would seem to make sense, even though this is 
technically wrong. It is not particularly intuitive to type .13 (including the leading deci-
mal point). Usability studies show that most people would type 13 in this situation, which 
would logically result in a displayed value of 1300% (if not for the quirky behavior), so Excel 
assumes that you want to display 13%. If you apply the Percentage format to a range of 
cells that already contain values (or formulas that result in values), check all the cells after-
ward to make sure you get the intended results.

Percent Style
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Formatting Fractions

The formats in the Fraction category in the Format Cells dialog box, shown in Figure 9-39, 
display fractional numbers as actual fractions rather than as decimal values. As with all 
number formats, the underlying value does not change despite the displayed value of the 
fraction.

Figure 9-39  Excel provides many fraction-formatting options.

You can generate some wild, nonstandard fractions unless you apply constraints using 
options in the Format Cells dialog box. Here is how Excel applies different fraction formats:

●● The Up To One Digit (single-digit) fraction format displays 123.456 as 123 1/2, round-
ing the display to the nearest value that can be represented as a single-digit fraction.

●● The Up To Two Digits (double-digit) fraction format uses the additional precision 
allowed by the format and displays 123.456 as 123 26/57.

●● The Up To Three Digits (triple-digit) fraction format displays 123.456 as the even 
more precise 123 57/125.

●● The remaining six fraction formats specify the exact denominator you want by round-
ing to the nearest equivalent; for example, displaying 123.456 using the As Sixteenths 
format, or 123 7/16.
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You can also apply fraction formatting on the fly by typing fractional values in a specific way. 
Type a number (or a zero), type a space, and then type the fraction, as in 123 1/2. For more 
details, see “Formatting as You Type” on page 322.

Formatting Scientific (Exponential) Values

The Scientific format displays numbers in exponential notation. For example, a two-decimal 
Scientific format (the default) displays the number 98765432198 as 9.88E+10 in a standard-
width cell. The number 9.88E+10 is 9.88 times 10 to the 10th power. The symbol E stands 
for exponent, a synonym here for 10 to the nth power. The expression “10 to the 10th 
power” means 10 times itself 10 times, or 10,000,000,000. Multiplying this value by 9.88 
gives you 98,800,000,000, an approximation of 98,765,432,198. Increasing the number of 
decimal places (the only option available for this format) increases the precision and will 
likely require a wider cell to accommodate the displayed value.

You can also use the Scientific format to display very small numbers. For example, in a 
standard-width cell this format displays 0.000000009 as 9.00E–09, which equates to 9 
times 10 to the negative 9th power. The expression “10 to the negative 9th power” means 
1 divided by 10 to the 9th power, 1 divided by 10 nine times, or 0.000000001. Multiplying 
this number by nine results in our original number, 0.000000009.

Understanding the Text Format

Applying the Text format to a cell indicates that the entry in the cell is to be treated as text, 
even if it’s a number. For example, a numeric value is ordinarily right-aligned in its cell. If 
you apply the Text format to the cell, however, the value is left-aligned as if it were a text 
entry. For all practical purposes, a numeric constant formatted as text is still considered a 
number because Excel is capable of recognizing its numeric value anyway.

Using the Special Formats

The four Special formats shown in Figure 9-40 are a result of many requests from users. 
These generally noncalculated numbers include two ZIP code formats, a phone number 
format (complete with the area code in parentheses), and a Social Security number format. 
Using each of these Special formats, you can quickly type numbers without having to type 
the punctuation characters.

The following are guidelines for using the Special formats:

●● Zip Code and Zip+4  Leading zeros are retained to correctly display the code, as in 
04321. In most other number formats, if you type 04321, Excel drops the zero and 
displays 4321.
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●● Phone Number  Excel applies parentheses around the area code and dashes 
between the digits, making it much easier to type many numbers at the same time 
because you don’t have to move your hand from the keypad. Furthermore, the num-
bers you type remain numbers instead of becoming text entries, which they would be 
if you typed parentheses or dashes in the cell.

●● Social Security Number  Excel places dashes after the third and fifth numbers. For 
example, if you type 123456789, Excel displays 123-45-6789.

●● Locale  This drop-down list lets you select from more than 120 locations with 
unique formats. For example, if you select Vietnamese, only two Special formats are 
available: Metro Phone Number and Suburb Phone Number.

Figure 9-40  Excel provides several frequently requested formats in the Special category.

Creating Custom Number Formats

Most number formats you need are available through commands and buttons on the rib-
bon, but you can use the Format Cells dialog box to accomplish minor feats of formatting 
that might surprise you. We’ll use the Custom category on the Number tab in the Format 
Cells dialog box, shown in Figure 9-41, to create custom number formats using special 
formatting codes. (To quickly display the Format Cells dialog box, press Ctrl+1.) Excel 
adds new formats to the bottom of the list of formatting codes in the Type list, which also 
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includes built-in formats. To delete a custom format, select the format in the Format Cells 
dialog box, and click Delete. You cannot delete built-in formats.

Creating New Number Formats  The quickest way to start creating a custom format is to 
use one of the built-in formats as a starting point. Here’s an easy way to build on an exist-
ing format, as well as to see what the codes in the Type list mean:

	 1.	 Type a number (or, in the case of our example, a date), and apply the built-in format 
that most closely resembles the custom format you want to create. Leave this cell 
selected.

	 2.	 On the Number tab in the Format Cells dialog box, select the Custom category. The 
format you selected is highlighted in the Type list, representing the code equivalent 
of the format you want to modify, as shown in Figure 9-41.

	 3.	 Edit the contents of the Type text box, using the codes listed in Table 9-1. The built-in 
format isn’t affected, and the new format is added to the bottom of the Type list.

Figure 9-41  Use the Custom category to create new formats using special codes.
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For example, to create a format that displays the date and time with the longest available 
format for day, month, and year, start by typing a date in a cell, and then select it. In the 
Custom category in the Format Cells dialog box, edit the format in the Type text box to 
read dddd, mmmm dd, yyyy – hh:mm AM/PM (including spaces and commas), and then 
click OK. Figure 9-42 shows the result.

Note
Saving the workbook saves your new formats, but to carry special formats from one 
workbook to another, you must copy and paste a cell with the Custom format. For easy 
access to special formats, consider saving them in one workbook.

Figure 9-42  We created a custom format by typing codes in the Type text box.

You can create any number format using the codes in Table 9-1.
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Table 9-1  Custom Format Symbols

Symbol Meaning

0 Digit placeholder. This symbol ensures that a specified number of digits 
appear on each side of the decimal point. For example, if the format is 0.000, 
the value .987 is displayed as 0.987. If the format is 0.0000, the value .987 is 
displayed as 0.9870. If a number has more digits to the right of the decimal 
point than the number of zeros specified in the format, the number displayed 
in the cell is rounded. For example, if the format is 0.00, the value .987 is dis-
played as 0.99; if the format is 0.0, .987 is rounded to 1.0.

? Digit placeholder. This symbol follows the same rules as the 0 placeholder, 
except that space is left for insignificant zeros on either side of the decimal 
point. This placeholder aligns numbers on the decimal points. For example, 1.4 
and 1.45 would line up on the decimal point if both were formatted as 0.??.

# Digit placeholder. This symbol works like 0, except that extra zeros do not 
appear if the number has fewer digits on either side of the decimal point than 
# placeholders specified in the format. This symbol shows Excel where to dis-
play commas or other separating symbols. The format #,###, for example, tells 
Excel to display a comma after every third digit to the left of the decimal point.

. Decimal point. This symbol determines how many digits (0 or #) appear to 
the right and left of the decimal point. If the format contains only # placehold-
ers to the left of this symbol, Excel begins numbers less than 1 with a decimal 
point. To avoid this, use 0 as the first digit placeholder to the left of the deci-
mal point instead of #. If you want Excel to include commas and display at 
least one digit to the left of the decimal point in all cases, specify the format 
#,##0.

% Percentage indicator. This symbol multiplies the entry by 100 and inserts the 
% character.

/ Fraction format character. This symbol displays the fractional part of a num-
ber in a nondecimal format. The number of digit placeholders that surround 
this character determines the accuracy of the display. For example, the decimal 
fraction 0.269 when formatted with # ?/? is displayed as 1/4, but when format-
ted with # ???/??? is displayed as 46/171.

, Thousands separator. If the format contains a comma surrounded by #, 0, 
or ? placeholders, Excel uses commas to separate hundreds from thousands, 
thousands from millions, and so on. In addition, the comma acts as a rounding 
and scaling agent. Use one comma at the end of a format to tell Excel to round 
a number and display it in thousands; use two commas to tell Excel to round 
to the nearest million. For example, the format code #,###,###, would round 
4567890 to 4,568, whereas the format code #,###,###,, would round it to 5.

E– E+ 
e– e+

Scientific format characters. If a format contains one 0 or # to the right of an 
E–, E+, e–, or e+, Excel displays the number in scientific notation and inserts E 
or e in the displayed value. The number of 0 or # placeholders to the right of 
the E or e determines the minimum number of digits in the exponent. Use E– 
or e– to place a negative sign by negative exponents; use E+ or e+ to place a 
negative sign by negative exponents and a positive sign by positive exponents.

$ – + / ( ) 
space

Standard formatting characters. Typing any of these symbols adds the actual 
corresponding character directly to your format.
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Symbol Meaning

\ Literal demarcation character. Precede each character you want to display 
in the cell—except for : $ – + / ( ) and space—with a backslash. (Excel does 
not display the backslash.) For example, the format code #,##0 \D;–#,##0 \C 
displays positive numbers followed by a space and a D and displays negative 
numbers followed by a space and a C. To insert several characters, use the 
quotation-mark technique described in the “Text” table entry.

_ Underscore. This code leaves space equal to the width of the next character. 
For example, _) leaves a space equal to the width of the close parenthesis. Use 
this formatting character for alignment purposes.

"Text" Literal character string. This formatting code works like the backslash tech-
nique except that all text can be included within one set of double quota-
tion marks without using a separate demarcation character for each literal 
character.

* Repetition initiator. This code repeats the next character in the format 
enough times to fill the column width. Use only one asterisk in the format.

@ Text placeholder. If the cell contains text, this placeholder inserts that text in 
the format where the @ appears. For example, the format code “This is a” @ 
displays “This is a debit” in a cell containing the word debit.

Table 9-2 lists the built-in formats and indicates how these codes relate to the other cate-
gories on the Number tab. (This table does not list date and time codes, which are covered 
in Chapter 15.)

Table 9-2  Built-In Custom Format Codes

Category Custom Format Codes

0 Digit
General No specific format
Number 0

0.00
#,##0
#,##0.00
#,##0_);(#,##0)
#,##0_);[Red](#,##0)
#,##0.00_);(#,##0.00)
#,##0.00_);[Red](#,##0.00)

Currency $#,##0_);($#,##0)
$#,##0_);[Red]($#,##0)
$#,##0.00_);($#,##0.00)
$#,##0.00_);[Red]($#,##0.00)
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Category Custom Format Codes

Percentage 0%
0.00%

Scientific 0.00E+00
##0.0E+0

Fraction # ?/?
# ??/??

Date (See Chapter 15)
Time (See Chapter 15)
Text @
Accounting _($* #,##0_);_($* (#,##0);_($* "-"_);_(@_)

_(* #,##0_);_(* (#,##0);_(* "-"_);_(@_)
_($* #,##0.00_);_($* (#,##0.00);_($* "-"??_);_(@_)
_(* #,##0.00_);_(* (#,##0.00);_(* "-"??_);_(@_)

Creating Four-Part Formats  Within each custom format definition, you can specify com-
pletely different formats for positive, negative, zero, and text values. You can create custom 
formats with as many as four parts, separating the portions by semicolons—positive num-
ber; negative number; zero; text. Figure 9-43 shows how three different formats are con-
structed using codes.

Figure 9-43  You can create your own four-part formats.

You’ll find the Formatting Numbers.xlsx file with the other examples on the companion 
Web site. It contains many of the custom formatting code examples described in this 
section.

Among the built-in formats, only the Accounting formats use all four parts, as shown in 
Figure 9-43, which breaks down each part of the third Accounting format in Table 9-2. The 
following are some guidelines for creating multipart formats:
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●● If your custom format includes only one part, Excel applies that format to positive, 
negative, and zero values.

●● If your custom format includes two parts, the first part applies to positive and zero 
values, and the second part applies only to negative values.

●● If your custom format has three parts, the third part controls the display of zero 
values.

●● The fourth and last element in a four-way format controls text-value formatting. Any 
formats with three or fewer elements have no effect on text entries.

Note
If you prefer, you can suppress the display of all zero values in a worksheet, including 
the displayed values of formulas with a zero result. Click the File tab, Options, and then 
click the Advanced category. In the Display Options For This Worksheet area, clear the 
Show A Zero In Cells That Have Zero Value check box.

Adding Color to Formats  You can also use the Number formats to change the color of 
selected cell entries. For example, you might use color to distinguish categories of informa-
tion or to make totals stand out. You can even create formats that assign different colors to 
specific numeric ranges so that, for example, all values greater than or less than a specified 
value appear in a different color.

Create Custom Billing and Part Number Formats
Suppose you create a billing statement and you want to format the totals in the 
Amount Due column so they display differently depending on the value in each cell. 
You might create the Custom Billing format shown in Figure 9-43, which was created 
using the following code:

"Amount due: "$#,##0.00_);"Credit: "($#,##0.00);"Let's call it even. ";"Please 
note: "@

Suppose you’re creating an inventory worksheet and you want all the entries in a par-
ticular column to appear in the format Part # XXX-XXXX, shown as the Custom Part # 
format in Figure 9-43, which was created using the following code:

"Part # "###-####

Using this code lets you type your part numbers as actual numbers rather than as text 
entries, which happens if you include any non-numeric characters, including dashes. 
This way, you can sort your part numbers properly and otherwise manipulate them as 
numeric data.



Chapter 9

340	 Chapter 9  Worksheet Formatting Techniques

Note
You can create codes that assign different colors based on the value in the cell, but 
an easier way is built into Excel: You can use the Conditional Formatting menu on the 
Home tab on the ribbon. For more information, see “Formatting Conditionally” on 
page 309.

To change the color of an entry, type the name of the new color in brackets in front of each 
segment of code. For example, if you want to apply a blue Currency format with two deci-
mal places, edit the $#,##0.00_);($#,##0.00) format as follows:

[Blue]$#,##0.00_);($#,##0.00)

When you apply this format to a worksheet, positive and zero values appear in blue, and 
text and negative values appear as usual, in black. The following simple four-part format 
code displays positive values in blue, negative values in red, zero values in yellow, and text 
in green (with no additional number formatting specified).

[Blue];[Red];[Yellow];[Green]

You can specify the following color names in your formats: Black, Blue, Cyan, Green, 
Magenta, Red, White, and Yellow. You can also specify a color as COLORn, where n is a 
number in the range 1 through 16. Excel selects the corresponding color from your work-
sheet’s current 16-color palette.

Note
If you define colors that are not among your system’s repertoire of solids, Excel pro-
duces them by mixing dots from solid colors. Such blended colors, which are said to 
be dithered, work well for shading. But for text and lines, Excel always uses the nearest 
solid color rather than a dithered color.
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TROUBLESHOOTING
Decimal points in my Currency formats don’t line up.

Sometimes when you use Currency formats with trailing characters, such as the French 
Canadian dollar (23.45 $), you want to use the GAAP practice of using currency symbols 
only at the top and bottom of a column of numbers. The numbers between should 
not display any currency symbols, so how do you make all the decimal points line up 
properly?

You can create a custom format code to apply to the noncurrency format numbers in 
the middle of the column. An underscore character (_) in the format code tells Excel 
to leave a space that is equal in width to the character that follows it. For example, the 
code _$ leaves a space equal to the width of the dollar sign. Thus, the following code 
does the trick for you:

#,##0.00 _$;[Red]#,##0.00 _$

Make sure you add a space between the zeros and the underscores to properly line the 
numbers up with the built-in French Canadian dollar format.

Using Custom Format Conditional Operators  You can create custom formats that are 
variable. To do so, you can add a conditional operator to the first two parts of the standard 
four-part custom format. This, in effect, replaces the positive/negative formats with either/
or formats. The third format becomes the default format for values that don’t match the 
other two conditions (the “else” format). You can use the conditional operators <, >, =, <=, 
>=, and <> with any number to define a format.

For example, suppose you are tracking accounts receivable balances. To display accounts 
with balances of more than $50,000 in blue, negative values in parentheses and in red, and 
all other values in the default color, create this format:

[Blue][>50000]$#,## 0.00_);[Red][<0]($# ,##0.00);$#,##0.00_)

Using these conditional operators can also be a powerful aid if you need to scale numbers. 
For example, if your company produces a product that requires a few milliliters of a com-
pound for each unit and you make thousands of units every day, you need to convert from 
milliliters to liters and kiloliters when you budget the use of this compound. Excel can make 
this conversion with the following numeric format:

[>999999]#,##0,," kl";[>999]##," L";#" ml"
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The following table shows the effects of this format on various worksheet entries:

Entry Display
72 72 ml
7286957 7 kl
7632 8 L

As you can see, using a combination of conditional formats, the thousands separator, and 
text with spaces within quotation marks can improve both the readability and the effective-
ness of your worksheet—and without increasing the number of formulas.

The Hidden Number Format
To hide values in a worksheet, assign a null format to them. To create a null format, 
type only the semicolon separator for that portion of the format. For example, to hide 
negative and zero values only, use this format:

$#,##0.00;;

To hide all entries in a cell, use this format:

;;;

The null format hides the cell contents in the worksheet, but the entry is still visible in 
the formula bar and accessible via reference in formulas. To hide the cell contents so 
they don’t appear in the worksheet or the formula bar, use the worksheet and cell pro-
tection features. For more information, see “Protecting Worksheets” on page 170.

Aligning Data in Cells

The Alignment group on the Home tab on the ribbon, shown in Figure 9-44, contains the 
most useful tools for positioning data within cells. For more precise control and additional 
options, click the dialog box launcher adjacent to the title of the Alignment group to dis-
play the Format Cells dialog box shown in Figure 9-45.

The Alignment tab in the Format Cells dialog box includes the following options:

●● Horizontal  These options control the right or left alignment within the cell. The 
General option, the default for Horizontal alignment, right-aligns numeric values and 
left-aligns text values.

●● Vertical  These options control the top-to-bottom position of cell contents within 
cells.
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●● Text Control  These three check boxes wrap text in cells, reduce the size of cell con-
tents until they fit in the current cell width, and merge selected cells into one.

●● Text Direction  The options in this drop-down list format individual cells for right-
to-left languages. The default option is Context, which responds to the regional 
settings on your computer. (This feature is applicable only if support is available for 
right-to-left languages.)

●● Orientation  These controls let you precisely specify the angle of text within a cell, 
from vertical to horizontal and anywhere in between.

                               Orientation button and menu
Vertical alignment buttons                Wrap Text

Horizontal alignment buttons           Merge & Center button and menu
                                       Indent buttons

Figure 9-44  Excel can address most of your alignment needs via tools on the ribbon.

Figure 9-45  Alignment means a lot more than just right, left, or justified.
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Aligning Text Horizontally

The Align Left, Center, and Align Right buttons on the ribbon correspond to three of the 
options in the Horizontal drop-down list on the Alignment tab in the Format Cells dia-
log box: Left (Indent), Center, and Right (Indent). These options align the contents of the 
selected cells, overriding the default cell alignment. Figure 9-46 shows the Horizontal align-
ment options in action, all of which we’ll discuss in detail in the following sections.

Figure 9-46  Use the Horizontal alignment options to control the placement of text from left 
to right.

Indenting Cell Contents  The Increase Indent button simultaneously applies left alignment 
to the selected cells and indents the contents by the width of one character. (One character 
width is approximately the width of the capital X in the Normal cell style.) Each click incre-
ments the amount of indentation by one. The adjacent Decrease Indent button does just 
the opposite, decreasing the indentation by one character width with each click.

In the Format Cells dialog box, the corresponding options are Left (Indent) and Right 
(Indent), shown in Figure 9-46. These are linked to the adjacent Indent control, whose dis-
played value is normally zero—the standard left-alignment setting. Each time you increase 
this value by one, the entry in the cell begins one character width to the right. For example, 
in Figure 9-46, row 2 is formatted with no left indent, row 3 with a left indent of 1, and row 
4 with a left indent of 2. The maximum indent value you can use is 250.

Distributing Cell Contents  Using the Distributed (Indent) option in the Horizontal drop-
down list, you can position text fragments contained in a cell with equal spacing within the 
cell. For example, in Figure 9-46, we first merged cells A8:B8 into one cell, then typed the 
word Distributed three times in the merged cell, and then applied the Distributed (Indent) 

Align Left 
 
 

Center 
 
 

Align Right

Increase Indent 
 

Decrease indent
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horizontal alignment. The result shows that Excel expanded the spaces between words in 
equal amounts to justify the contents within the cell.

To learn about merging, see “Merging and Unmerging Cells” on page 365.

Centering Text Across Columns  The Center Across Selection option in the Horizontal text 
alignment drop-down list centers text from one cell across all selected blank cells to the 
right or to the next cell in the selection that contains text. For example, in Figure 9-46, we 
applied the Center Across Selection format to cells A7:B7. The centered text is actually in 
cell A7.

Center Across Selection vs. Merge & Center
Although the result might look similar to that of the Merge & Center button on the 
Home tab, the Center Across Selection alignment option does not merge cells. When 
you use Center Across Selection, the text from the leftmost cell remains in its cell but is 
displayed centered across the entire selected range. Notice in the following figure that 
the selection shading shows that cells A1 and B1 are still two separate cells. The Merge 
& Center button creates a single cell in place of all the selected cells. Although Merge & 
Center merges rows and columns of cells, Center Across Selection works only on rows.

In the above figure, the text “Center Across Selection” actually spans two active cells, 
while the text “Merge & Center” is in a single cell that was created by selecting cells 
A2:B2 and clicking the Merge & Center button. Either method allows you to change 
column widths; the centering readjusts automatically. If you type anything in cell B1, 
the centered text “retreats” to cell A1; if you subsequently clear cell B1, the text is re-
centered across the two cells until you clear the format from both cells. You cannot 
type anything in cell B2 because it essentially no longer exists after being merged with 
cell A2. For more information, see “Merging and Unmerging Cells” on page 365.

Filling Cells with Characters  The Fill option in the Horizontal alignment drop-down list 
repeats your cell entry to fill the width of the column. For example, in Figure 9-46, cells 
A9:B9 contain the single word Fill and a space character, with the Fill alignment format 
applied. Only the first cell in the selected range needs to contain text. Excel repeats the text 
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to fill the range. Like the other Format commands, the Fill option affects only the appear-
ance, not the underlying contents, of the cell.

CAUTION!
Because the Fill option affects numeric values as well as text, it can cause a number to 
look like something it isn’t. For example, if you apply the Fill option to a ten-character-
wide cell that displays 3, the cell appears to contain the number 3333333333.

Wrapping Text in Cells  If you type a label that’s too wide for the active cell, Excel extends 
the label past the cell border and into adjacent cells—provided those cells are empty. If you 
click the Wrap Text button on the Home tab (or the Wrap Text option on the Alignment tab 
in the Format Cells dialog box), Excel displays your label entirely within the active cell. To 
accommodate it, Excel increases the height of the row in which the cell is located and then 
wraps the text onto additional lines within the same cell. As shown in Figure 9-46, cell A10 
contains a multiline label formatted with the Wrap Text option.

Justifying Text in Cells  The Alignment tab in the Format Cells dialog box provides two 
justify options—one in the Horizontal drop-down list and one in the Vertical drop-down 
list. The Horizontal Justify option not only forces text in the active cell to align flush with 
the right margin, as shown in cell B10 in Figure 9-46, but also wraps text within the cell and 
adjusts the row height accordingly.

Note
Do not confuse the Horizontal Justify option with the Justify command (on the Fill 
menu in the Editing group on the Home tab), which redistributes a text entry into 
as many cells as necessary below the selected cell by dividing the text into separate 
chunks. For more information about the Justify command on the Fill menu, see “Dis-
tributing Long Entries Using the Justify Command” on page 236.

The Vertical Justify option performs essentially the same task as its Horizontal counterpart, 
except it adjusts cell entries relative to the top and bottom of the cell rather than the sides, 
as shown in cell E3 of Figure 9-47.

The Justify Distributed option becomes available only when you select one of the Dis-
tributed options in either the Horizontal drop-down list or the Vertical drop-down list. It 
combines the effect of the Justify option with that of the Distributed option not only by 
wrapping text in the cell and forcing it to align flush right but also by spacing the contents 
of the cell as evenly as possible within each wrapped line of text.

Wrap Text
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Aligning Text Vertically

The Top Align, Middle Align, and Bottom Align buttons on the Home tab control the verti-
cal placement of cell contents and fulfill most of your needs in this regard. The Vertical 
drop-down list on the Alignment tab in the Format Cells dialog box includes two additional 
alignment options—Justify and Distributed—which are similar to the corresponding Hori-
zontal alignment options. Cells A3:C3 in Figure 9-47 show examples of the first three align-
ment options. As noted earlier, cell E3 shows the Justify option in action. We formatted cell 
D3, containing the percent signs, using the Distributed option.

The options in the Vertical drop-down list create the following effects:

●● Top, Center, and Bottom  These options force cell contents to align to each respec-
tive location within a cell. The default vertical cell orientation in new worksheets is 
Bottom.

●● Justify  This option expands the space between lines so that text entries align flush 
with the top and bottom of the cell.

●● Distributed  This option spreads the contents of the cell evenly from top to bottom, 
making the spaces between lines as close to equal as possible.

Controlling Text Orientation

Clicking the Orientation button in the Alignment group on the Home tab displays the 
menu shown in Figure 9-48, offering common orientation options.

Top Align 
 
 

Middle Align 
 
 

Bottom Align

Orientation
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Figure 9-48  Use the Orientation menu to rotate or stack text in a cell.

The Orientation area on the Alignment tab in the Format Cells dialog box contains addi-
tional controls, letting you change the angle of cell contents to read at any angle from 90 
degrees counterclockwise to 90 degrees clockwise.

A Cool Application of Angled Text
Many times the label at the top of a column is much wider than the data stored in it. 
You can use the Wrap Text option to make a multiple-word label narrower, but some-
times that’s not enough. Vertical text is an option, but it can be difficult to read and 
takes a lot of vertical space. Try using rotated text and cell borders:



	 Formatting in Depth	 349

Ch
ap

te
r 9

Here’s how to do it:

	 1.	 Select the cells you want to format, and click the dialog box launcher in the Font 
group on the Home tab to display the Format Cells dialog box.

	 2.	 Click the Border tab, and apply vertical borders to the left, right, and middle of 
the range.

	 3.	 Click the Alignment tab, and use the Orientation controls to select the angle you 
want. (It’s usually best to select a positive angle from 30 to 60 degrees.)

	 4.	 In the Horizontal Text Alignment drop-down list, select Center, and then click OK. 
Excel rotates the left and right borders along with the text.

	 5.	 Drag down the bottom border of the row 1 header (the line between 1 and 2) to 
make it deep enough to accommodate the labels without wrapping.

	 6.	 Select all the active columns, and double-click any one of the lines between the 
selected column headers (for example, the line between the column letters C and 
D) to shrink all the columns to their smallest possible width.

Using the Angle Counterclockwise command on the Orientation button’s menu (in 
the Alignment group on the Home tab) rotates the text to +45 degrees for you, but 
because we wanted to apply borders and alignment options as well, using the Format 
Cells dialog box was a more efficient method.

Note
Interestingly, as you experiment with orientation, you won’t see a Horizontal option on 
the Orientation button’s menu. This means that you need to use either the Format Cells 
dialog box or the Undo command (Ctrl+Z) to restore cells to their default orientation.

Excel automatically adjusts the height of the row to accommodate vertical orientation 
unless you manually set the row height either before or after changing text orientation. Cell 
G3 in Figure 9-47 shows what happens when you click the tall, skinny Text button on the 
left side of the Orientation area. Although the button is labeled Text, you can also apply this 
“stacked letters” effect to numbers and formulas.

The angle controls let you rotate text to any point in a 180-degree arc. You can use either 
the Degrees box at the bottom or the large dial above it to adjust text rotation. To use the 
dial, click and drag the Text pointer to the angle you want; the number of degrees appears 
in the spinner below. You also can click the small up and down arrows in the Degrees box 
to increment the angle one degree at a time from horizontal (zero), or you can highlight 
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the number displayed in the Degrees box and type a number from –90 through 90. Cells 
H3:K3 in Figure 9-47 show some examples of rotated text.

You’ll find the Angled Text.xlsx file with the other examples on the companion Web site.

For more about cell borders, see “Customizing Borders” on page 353. For more about row 
heights, see “Changing Row Heights” on page 364.

Shrinking Text to Fit in Cells

The Shrink To Fit check box on the Alignment tab in the Format Cells dialog box reduces 
the size of the font in the selected cell until the contents can be completely displayed in the 
cell. This is useful when you have a worksheet in which adjusting the column width to allow 
a particular cell entry to be visible has undesirable effects on the rest of the worksheet or 
where angled text, vertical text, and wrapped text aren’t feasible solutions. In Figure 9-49, 
we typed the same text in cells A1 and A2 (and increased the font size for readability) and 
applied the Shrink To Fit option to cell A2.

Figure 9-49  The Shrink To Fit alignment option reduces the font size until the cell contents fit 
within the cell.

The Shrink To Fit format is dynamic and readjusts if you change the column width, either 
increasing or decreasing the font size as needed. The assigned size of the font does not 
change; therefore, no matter how wide you make the column, the font will not expand 
beyond the assigned size.
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The Shrink To Fit option can be a good way to solve a problem, but keep in mind that this 
option reduces the font to as small a size as necessary. If the cell is narrow enough and the 
cell contents long enough, the result might be too small to read.

Using Fonts

The term font refers to a typeface (such as Calibri), along with its attributes (such as point 
size and color). The Font group on the Home tab on the ribbon, shown in Figure 9-50, 
is the easiest way to apply general font formatting to selected cells. Here are a few facts 
about the controls in the Font group:

●● The Font, Font Size, Underline, Borders, Fill Color, and Font Color buttons all include 
arrows to their right, which you can click to display a menu or gallery with additional 
options.

●● The appearance of the Font Color, Fill Color, and Borders buttons changes to reflect 
the last-used option. This lets you apply the same option again by clicking the but-
ton, without using the menu or gallery.

●● The Bold and Italic buttons are toggles; click once to apply the format, and click 
again to remove it.

Font style
buttons

Font       Font Size      Increase/Decrease Font Size buttons

                        Font Color button and palette
                 Fill Color button and palette
        Borders button and palette
Underline button and palette                 

Figure 9-50  The Font group contains font-formatting controls, as well as border and fill controls.

For more extensive control over fonts, use the Font tab in the Format Cells dialog box. To 
specify a font, select the cell or range, click the dialog box launcher in the Font group, and 
then click the Font tab, shown in Figure 9-51.
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Figure 9-51  On the Font tab you can assign fonts, character styles, sizes, colors, and effects to 
your cell entries.

Note
You can also press Ctrl+1 to display the Format Cells dialog box.

The numbers in the Size list show the point sizes at which Excel can optimally print the 
selected font, but you can type any number in the text box at the top of the list—even 
fractional point sizes up to two decimal places. Unless you preset it, Excel adjusts the row 
height as needed to accommodate the largest point size in the row. The available font 
styles vary depending on the font you select in the Font list. Most fonts offer italic, bold, 
and bold italic styles. To reset the selected cells to the font and size defined as the Normal 
cell style, select the Normal Font check box.

For more information about using cell styles, see “Formatting with Cell Styles” on page 303.
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INSIDE OUT  �
Automatic Font Color Isn’t Really Automatic

If you select Automatic (the default font color option) in the Color drop-down list (or 
use its equivalent in the Font group on the Home tab on the ribbon), Excel displays the 
contents of your cell in black. You might think that Automatic should select an appro-
priate color for text on the basis of the color you apply to the cell, but this isn’t the 
case. If, for example, you apply a black background to a cell, you might think the auto-
matic font color would logically be white. This isn’t so; Automatic is always black unless 
you select another Window Font color in the Display Properties dialog box (accessed 
from Windows Control Panel). For more information about applying colors to cells, see 
“Applying Colors and Patterns” on page 357.

Customizing Borders

Borders and shading can be effective devices for defining areas in your worksheet or for 
drawing attention to important cells, and the Borders button in the Font group on the 
Home tab is the easiest way to apply them. Clicking this button applies the last-used border 
format and displays a thumbnail representation of it on the button. Click the arrow to the 
right of the button to display the menu shown in Figure 9-52.

Figure 9-52  Click the arrow next to the Borders button to display the Borders menu.

Borders
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Note
As does the image displayed on the button, the button name also reflects the last-used 
border format when you rest the pointer on the button to display a ScreenTip.

The most-often-used border options are represented on the Borders menu, but for more 
precise control, click the More Borders command on the menu to display the Border tab in 
the Format Cells dialog box, shown in Figure 9-53. (As always, the dialog box launcher next 
to the Font group opens the dialog box as well.) If you have more than one cell selected 
when you open the dialog box, the Border preview area includes tick marks in the middle 
and at the corners, as shown in Figure 9-53.

Figure 9-53  Using the Border tab, you can assign 13 styles of borders in 70 colors.

Note
A solid gray line in the preview area means that the format applies to some but not all 
of the selected cells.
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An Angled Border Trick
Sometimes you might want to use that pesky cell that generally remains empty in the 
upper-left corner of a table. You can use an angled border to create dual-label corner 
cells (we expanded the formula bar in the following figure to show all the text in cell 
A3):

Here’s how to do it:

	 1.	 Select the cell you want to format, and type about 10 space characters. You can 
adjust this later (there are 20 spaces before the Exam # label in the example).

	 2.	 Type the label you want to correspond to the column labels across the top of the 
table.

	 3.	 Hold down the Alt key, and press Enter twice to create two line breaks in the cell.

	 4.	 Type the second label, which corresponds to the row labels down the left side of 
the table, and press Enter.

	 5.	 With the cell selected, click the More Borders command on the Borders menu.

	 6.	 Select a line style, and click the upper-left to lower-right angled border button.

	 7.	 Click the Alignment tab, select the Wrap Text check box, and then click OK.

You will probably need to fine-tune a bit by adjusting the column width and row height 
and by adding or removing space characters before the first label. In the example, we 
also selected cells B3:F3 and then clicked the Top Align button in the Alignment group 
on the Home tab so that all the labels line up across the top of the table.
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For more information about alignment, see “Aligning Data in Cells” on page 342. For more about 
entering line breaks and tabs in cells, see “Formula-Bar Formatting” on page 497.

You’ll find the Angled Borders.xlsx file with the other examples on the companion Web site.

To apply borders, you can click the preview area where you want the border to appear, or 
you can click the buttons located around the preview area. An additional preset button, 
Inside, becomes active only when you have more than one cell selected. If you click the 
Outline button, borders are applied only to the outside edge of the entire selection. The 
None preset removes all border formats from the selection.

Note
Borders often make a greater visual impact on your screen when you remove work-
sheet gridlines. Click the View tab on the ribbon, and clear the Gridlines check box in 
the Show/Hide group to remove gridlines from your worksheet. For more information 
about gridlines, see “Controlling Other Elements of the Excel 2010 Interface” on page 103.

The default, or Automatic, color for borders is black. To select a line style, click the type of 
line you want to use in the Line area, and then click any of the buttons in the Border area 
or click the preview box directly to apply that style in the selected location. (The first finely 
dotted line in the Style area is a solid hairline when printed.) To remove a border, click the 
corresponding button—or the line in the preview window—without selecting another style.

By using the commands in the Draw Borders group at the bottom of the Borders menu 
(shown in Figure 9-52), you can create complex borders quickly and easily. When you click 
Draw Border, you enter “border-drawing mode,” which persists until you click Draw Border 
again or press Esc. After you activate this mode, you can drag to create lines and boxes 
along cell gridlines, as shown in Figure 9-54. If you click Draw Border Grid, not only are bor-
ders drawn along the boundaries of the selected cells, but they’re also drawn along all the 
gridlines in the selection rectangle, as shown at the bottom of Figure 9-54.

If you make selections in the Line Color and Line Style galleries at the bottom of the Bor-
ders menu prior to using either Draw Border command, the borders you draw reflect 
your color and style selections. Clicking Erase Border predictably activates the opposite of 
border-drawing mode: “border-erasing mode.” Dragging while in erase mode removes all 
borders within the selection rectangle.
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Figure 9-54  We created two boxes using the Draw Border command and another using the 
Draw Border Grid command.

Applying Colors and Patterns

The Fill Color button in the Font group on the Home tab offers colors you can apply to 
selected cells. Click the button’s arrow to display the options shown in Figure 9-55.

Figure 9-55  Use the Fill Color palette to add color to cells.

If you want to do more than just fill cells with color, the Fill tab in the Format Cells dialog 
box provides additional control. (Click the dialog box launcher in the Font group on the rib-
bon to display the Format Cells dialog box.) The main feature of the Fill tab is a palette of 
colors, mimicking the palette available on the ribbon. A feature not available on the ribbon 
is the Pattern Style drop-down palette, shown in Figure 9-56. You use this palette to select 

Fill Color
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a pattern for selected cells and the Pattern Color drop-down palette above it to choose a 
color.

Figure 9-56  Using the Fill tab, you can select colors and patterns for cell backgrounds.

Follow these guidelines when using the Fill tab:

●● The Background Color area controls the background of selected cells. When 
you choose a color and do not select any pattern, Excel applies a solid colored 
background.

●● To return the background color to its default state, click No Color.

●● If you pick a background color and then select a pattern style, the pattern is overlaid 
on the solid background. For example, if you select red from the Background Color 
area and then click one of the dot patterns, the result is a cell that has a red back-
ground and black dots.

●● The Pattern Color options control the color of the pattern, not the cell. For example, 
if you leave Background Color set to No Color and select a red for Pattern Color and 
any dot pattern for Pattern Style, the cell is displayed with a white background with 
red dots.
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Note
When selecting colors for cell backgrounds, select one on which you can easily read any 
text or numbers in the cell. For example, yellow is the most visible background color 
you can choose to complement black text, which is why you see this combination on 
road signs. A dark blue background with black text—that’s not so good.

The More Colors button on the Fill tab displays the Colors dialog box shown in Figure 9-57, 
where you can select colors that are not otherwise represented on the color palettes. The 
Standard tab in the Colors dialog box displays a stylized color wheel using the current 
theme colors, most of which are already available on the palettes. The Custom tab shown 
in Figure 9-57 lets you pinpoint colors, use specific color values, and switch between the 
default RGB (red, green, blue) color model or HSL, a color model defined by hue, satura-
tion, and luminosity values instead of RGB color values.

The Fill Effects button on the Fill tab in the Format Cells dialog box opens up another world 
of possibility, offering gradient fills you can apply to cells. Clicking this button displays the 
Fill Effects dialog box shown in Figure 9-58. You can select different colors and shading 
styles, but this version of the Fill Effects dialog box offers only two-color effects. The One 
Color and Preset options are not available. Note that Fill Effects gradient fills are static, 
unlike data bars, which are conditional gradient fills that respond to cell values and interact 
with adjacent cells by applying proportional amounts of fill to each cell.

For more about gradients, see “Filling an Area with a Color Gradient” on page 702. For more 
about data bars, see “Formatting Conditionally” on page 309.

Figure 9-57  Click the More Colors button on the Fill tab in the Format Cells dialog box to select 
the colors you need.
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Figure 9-58  Click the Fill Effects button on the Fill tab in the Format Cells dialog box to use 
gradient fills in cells.

Adding Graphic Backgrounds to Worksheets

Adding background images to worksheets is easy. Click the Page Layout tab on the rib-
bon, and click the Background button. A standard Windows file-management dialog box 
appears, from which you can open most types of image files, located anywhere on your 
computer or network. Excel then applies the graphic image to the background of the active 
worksheet, as shown in Figure 9-59.

Here are some tips for working with background images:

●● The example in Figure 9-59 is a cover sheet for a large workbook; be careful when 
using backgrounds behind data. It can be difficult to read cell entries with the wrong 
background applied.

●● You might want to turn off the display of gridlines, as shown in Figure 9-59. To do so, 
clear the Gridlines View check box, which is also located on the Page Layout tab.

●● If you don’t like the way the background looks with your data, click the Background 
button again, whose name changes to Delete Background when a background is 
present.
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●● The graphic image is tiled in the background of your worksheet, which means the 
image is repeated as necessary to fill the worksheet.

●● Cells to which you have assigned a color or pattern override the graphic background.

●● Backgrounds are preserved when you save the workbook as a Web page.

Figure 9-59  Add a background graphic to any worksheet.

For more information about saving workbooks as Web pages, see Chapter 26, “Collaborating 
Using the Internet.”

Controlling the Size of Cells

The primary methods you use to control the size of cells are adjusting the row height and 
changing the column width. In addition, you can adjust the size of cells by merging several 
cells into one or by unmerging previously merged cells. The Format menu, located in the 
Cells group on the Home tab, is the central command location for cell sizing, as shown in 
Figure 9-60.
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Figure 9-60  You can use the Cell Size commands on the Format menu to manage row height 
and column width.

Here are the options you can use:

●● Column Width and Row Height  These two commands display a dialog box where 
you can type a different value to be applied to selected cells. Column width is limited 
to 255, and row height can be up to 409. The default column width for Excel is 8.43 
characters; however, this does not mean each cell in your worksheet can display 8.43 
characters. Because Excel uses proportionally spaced fonts (such as Arial) as well as 
fixed-pitch fonts (such as Courier), different characters can take up different amounts 
of space. A default-width column, for example, can display about eight numerals in 
most 10-point fixed-pitch fonts.

●● AutoFit Row Height  This command adjusts the row height in selected cells by 
adjusting them to accommodate the tallest item in the row. (Row height is usually 
self-adjusting based on font size.)

●● AutoFit Column Width  This command adjusts column widths in selected cells by 
adjusting them to accommodate the widest entry in the column.

●● Default Width  This command displays a dialog box where you can change the 
starting column width for all selected worksheets in the current workbook. This has 
no effect on columns whose width you have previously specified.
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Changing Column Widths

If the standard column width isn’t enough to display the complete contents of a cell, one of 
the following will occur:

●● Text that is too long runs over into adjacent cells.

●● Long text entries are truncated at the border if the adjacent cell isn’t empty.

●● Long numbers appear in scientific notation (for example, 1.23E+12).

●● A series of number signs (#) appears if you assign a numeric format.

To change column widths using the mouse, drag the lines between column headings. As 
you drag, the width of the column and the number of pixels appear in a ScreenTip, as 
shown in Figure 9-61. This figure also illustrates how to change the width of multiple col-
umns at the same time: Drag to select column headings; alternatively, hold down Ctrl, and 
click headings to select nonadjacent columns. Then, when you drag the line to the right of 
any selected column, all the selected column widths change simultaneously.

Figure 9-61  The cursor looks like a double-headed arrow when you adjust column width or row 
height with the mouse.

Note
Depending on the font you are using, characters that appear to fit within a column on 
your screen might not fit when you print the worksheet. You can preview your output 
before printing by pressing Ctrl+P to display the Print screen in Backstage View, where 
you can see an image of the worksheet as it will look when printed. For information 
about print preview, see Chapter 11, “Printing and Presenting.”
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Tricks for Tailoring Cells
Here are a few methods you can use to speed up your cell-sizing chores:

●● When you select a number of rows or columns, you can tailor all of them to fit 
their contents—essentially the same as using one of the AutoFit commands—by 
double-clicking any line to the right of a selected column header or any line 
below a selected row header. Doing so automatically snaps all the selected cells 
to accommodate the widest or tallest displayed values.

●● To tailor all the cells in the worksheet at once, first click the gray square at the 
intersection of the row and column headers to select the entire worksheet (or 
press Ctrl+A). Then double-click any line in the row header to autofit all rows, 
and double-click any line in the column header to autofit all columns.

●● To change the widths of all the columns in the current worksheet, select any 
entire row by clicking a row heading (or pressing Shift+Spacebar), and then click 
the Column Width command on the Format menu on the Home tab.

●● To change the height of all of the rows in the current worksheet, select any entire 
column by clicking a column heading (or pressing Ctrl+Spacebar), and then click 
the Row Height command on the Format menu on the Home tab.

Changing Row Heights

The height of a row always changes dynamically to accommodate the largest font used in 
that row. Thus, you don’t usually need to worry about characters being too tall to fit in a 
row. Adjusting row height is the same as adjusting column width—just drag one of the lines 
between row headings.

To restore the default height of one or more rows, select any cell in those rows, and click 
AutoFit Row Height on the Format menu on the Home tab. Unlike column width, you can-
not define a standard row height. The AutoFit command serves the same function, return-
ing empty rows to the standard height needed to accommodate the default font and fitting 
row heights to accommodate the tallest entry. When you create or edit a multiline text 
entry using the Wrap Text button or the Justify option on the Alignment tab in the Format 
Cells dialog box, Excel automatically adjusts the row height to accommodate it.

For more information, see “Wrapping Text in Cells” on page 346 and “Justifying Text in Cells” on 
page 346.
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Hiding a Column or Row
If you want to hide information within a worksheet, you can hide entire columns or 
rows. To do so, select any cell in the row or column you want to hide. Then, on the 
Format menu on the Home tab, click Hide & Unhide, and then click Hide Rows or Hide 
Columns. This sets the width of the column to zero. You can also hide rows and col-
umns by dragging the line between headings up or to the left until the height or width 
is zero. When a row or column’s width is set to 0, Excel skips over it when you move the 
active cell, and the column letter or row number disappears. For example, if you hide 
column C, the column heading line reads A, B, D, and so on.

To redisplay a hidden row or column, drag to select the headings on both sides, and 
click Unhide Rows or Unhide Columns on the Hide & Unhide menu. The Hidden check 
box on the Protection tab of the Format Cells dialog box hides only formulas in the 
formula bar.

Merging and Unmerging Cells

The spreadsheet grid is arguably the most versatile type of document, and the ability to 
merge cells makes it all the more versatile. Select the cells you want to merge, and click the 
arrow to the right of the Merge & Center button in the Alignment group on the Home tab 
to display the menu shown in Figure 9-62.

Figure 9-62  The Merge & Center button offers a variety of merge commands.

CAUTION!
When you merge several cells that contain data, only the data in the uppermost, left-
most cell is preserved. Excel overwrites data in subsidiary cells. Copy any data you need 
to another location before merging.

Merge & Center
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When you merge cells, you end up with a single cell that comprises the original cells. If 
in the worksheet shown in Figure 9-63, we were to select cells A4:B5 and click the Merge 
Across command, the result would be two merged cells, A4 and A5, each spanning two col-
umns. Here are the differences between the Merge & Center commands:

●● Merge & Center  This command consolidates all selected cells—both rows and col-
umns—into one big cell and centers the contents across the newly merged cell.

●● Merge Across  This command consolidates each row of selected cells into one wide 
cell per row.

●● Merge Cells  This command consolidates all selected cells into one big cell, but it 
does not center the contents.

●● Unmerge Cells  This command returns a merged cell to its original component cells 
and places its contents in the upper-leftmost cell. Clicking the Merge & Center but-
ton (not the Merge & Center command) when a merged cell is selected has the same 
effect, like a toggle “turning off” the merge.

Figure 9-63  Most of the cells in the top five rows of this worksheet, and a couple in the sixth 
row, are merged in various combinations.

Figure 9-63 shows the same worksheet shown in Figure 9-62 after merging cells A1:B3, 
C1:F3, G1:J5, A4:B4, A5:B5, D4:F4, D5:F5, and D6:E6. We had to shuffle some of the text, 
before merging so that we wouldn’t lose it to the merging process. For example, the text in 
the original range G1:J5 was unevenly spaced because of the different row heights needed 
to accommodate the text in cells A1 and C2. To eliminate this problem, we used the Merge 
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Cells command on the range A1:B3, we used the Merge & Center command on the ranges 
C1:F3 and G1:J5, and then we reentered the text.

You’ll find the School Financial Application Form.xlsx file with the other examples on the 
companion Web site.

When you merge cells, the new big cell uses the address of the cell in the upper-left corner, 
as shown in Figure 9-63. Cell A1 is selected, as you can see in the Name box. (In the figure, 
we also expanded the formula bar to show the three rows of text in the merged cell.) The 
headings for rows 1, 2, and 3 and columns A and B are highlighted, which would ordinar-
ily indicate that the range A1:B3 is selected. For all practical purposes, however, cells A2:A3 
and B1:B3 no longer exist. The other merged cells, or the subsidiary cells, act like blank cells 
when referred to in formulas and return zero (or an error value, depending on the type of 
formula).

Note
In Figure 9-63, the information in the formula bar is on three lines. To enter line breaks 
within a cell, press Alt+Enter. For more information, see “Formula-Bar Formatting” on 
page 497.

Merging cells obviously has interesting implications, considering that it seems to violate the 
grid—one of the defining attributes of spreadsheet design. That’s not as bad as it sounds, 
but keep in mind these tips:

●● If you select a range to merge and any single cell contains text, a value, or a formula, 
the contents are relocated to the new big cell.

●● If you select a range of cells to merge and more than one cell contains text or values, 
only the contents of the uppermost, leftmost cell are relocated to the new big cell. 
Contents of subsidiary cells are deleted; therefore, if you want to preserve data in 
subsidiary cells, make sure you add it to the upper-left cell or relocate it.

●● Formulas adjust automatically. A formula that refers to a subsidiary cell in a merged 
range changes to refer to the address of the new big cell. If a merged range of cells 
contains a formula, relative references adjust. For more about references, see “Using 
Cell References in Formulas” on page 468.

●● You can copy, delete, cut and paste, or click and drag big cells as you would any 
other cell. When you copy or move a big cell, it replaces the same number of cells at 
the destination. The original location of a cut or deleted big cell returns to individual 
cells.
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●● You can drag the fill handle of a big cell as you can drag the fill handle of regular 
cells. When you do so, the big cell is replicated, in both size and content, replacing all 
regular cells in its path. For more about using the fill handle, see “Filling and Creating 
Data Series” on page 229.

●● If you merge cells containing border formatting other than along any outer edge of 
the selected range, border formats are erased.

Using Template Files to Store Formatting
A template is a model that can serve as the basis for new worksheets. A template can 
include both data and formatting information. Template files are great timesavers. They’re 
also an ideal way to ensure a consistent look among reports, invoices, and other documents 
you tend to create repeatedly. Figure 9-64 shows an example of a template for an expense 
report. This worksheet would make a good template because expense reports are used 
repeatedly, but each time you want to start with a fresh, clean copy.

Figure 9-64  This template file serves as the basis for creating new expense reports.

You’ll find the Expense Report.xltx file with the other examples on the companion Web site.

The advantages to using templates are standardization and protection. It is difficult to over-
write the original accidentally, because when you save a new template-based workbook for 
the first time, you must supply a new name for it. This way you can repeatedly create new 
workbooks with the same appearance without worrying about overwriting the original.
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To create a template file, follow these steps:

	 1.	 Open the workbook you want to use as a template.

	 2.	 Click the File tab, Save As, and supply a file name.

	 3.	 Choose Excel Template (*.xltx) from the Save As Type drop-down list, and click Save.

When you choose the Excel Template format in the Save As dialog box, Excel switches to 
the Templates folder and saves your new template there. This is the location that ensures 
that your template is always available when you click the New command on the File tab 
and click My Templates.

When you install Excel, a folder named Templates is installed on your hard disk in the fol-
lowing location:

●● Windows 7, Windows Vista  C:\Users\<your name>\AppData\Roaming\Microsoft\
Templates

●● Windows XP  C:\Documents and Settings\<your name>\Application Data\
Microsoft\Templates

When you create a new document by clicking the File tab, New, and then selecting one 
of the many templates available,, a fresh copy of the workbook is created, and the copy is 
given a temporary name consisting of the original file name plus a number. If the template 
file is named Expenses, for example, the working copy is named Expenses1.

INSIDE OUT  �
Full Disclosure

Windows tries to keep secrets from you—for your own good, of course. But fearless 
readers of this book need no such accommodation, so here are a couple of actions you 
can take to make life a little easier. First, let’s show hidden files and folders. If you go 
looking, the Templates folders described in this chapter can be hard to find because 
they are in locations Windows likes to keep hidden from view. To make them more 
findable, click the Windows Start menu, Control Panel, Appearance And Personaliza-
tion, and Folder Options; then, on the View tab, select Show Hidden Files, Folders, And 
Drives. Second, let’s display all the file extensions. The old-style MS-DOS extensions 
used to be three characters in length and now can be four, such as .xltx for templates 
and .xlsx for regular workbooks. These may be “retro,” but they are also still helpful, let-
ting you tell at a glance in which format a file is saved. To make extensions visible, clear 
the Hide Extensions For Known File Types check box, which is also on the View tab in 
the Folder Options dialog box.
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CHAPTER 23

Analyzing Data with PivotTable Reports

A PivotTable report is a special kind of table that summarizes information from 
selected fields of a data source. The source can be a Microsoft Excel 2010 list or 
table, a relational database file, or an online analytical processing (OLAP) cube. 

When you create a PivotTable, you specify which fields you’re interested in, how you want 
the table organized, and what kinds of calculations you want the table to perform. After 
you build the table, you can rearrange it to view your data from alternative perspectives. 
This ability to “pivot” the dimensions of your table—for example, to transpose column 
headings to row positions—gives the PivotTable its name and its analytical power.

Introducing PivotTables
PivotTables are linked to the data from which they’re derived. If the PivotTable is based on 
external data (data stored outside Excel), you can choose to have it refreshed at regular 
time intervals, or you can refresh it whenever you want.

Figure 23-1 shows Books.xlsx, a list of sales figures for a small publishing firm. The list is 
organized by year, quarter, category, distribution channel, units sold, and sales receipts. The 
data spans a period of eight quarters (2009 and 2010). The firm publishes six categories of 
fiction (Mystery, Western, Romance, Sci Fi, Young Adult, and Children) and uses three dis-
tribution channels—domestic, international, and mail order. It’s difficult to get useful sum-
mary information by looking at a list like this, even though the list itself is well organized.

You’ll find the Books.xlsx file with the other examples on the companion Web site.
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Figure 23-1  It’s difficult to see the bottom line in a flat list like this; turning the list into a 
PivotTable will help.

Figures 23-2 through 23-4 show several ways you can transform this flat table into Pivot-
Tables that show summary information at a glance.

The example on the left in Figure 23-2 breaks the data down first by category, second by 
distribution channel, and finally by year, with the total sales at each level displayed in col-
umn B. Looking at this table, you can see (among many other details) that the Children cat-
egory generated domestic sales of $363,222, with more revenue in 2010 than in 2009.

In the example on the right in Figure 23-2, the per-category data is broken out first by year 
and then by distribution channel. The data is the same; only the perspective is different.
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Figure 23-2  These two PivotTables provide summary views of the information in Figure 23-1.

Both the PivotTables shown in Figure 23-2 are single-axis tables. That is, we generated a 
set of row labels (Children, Mystery, Romance, and so on) and set up outline entries below 
these labels. (And, by default, Excel displays outline controls beside all the headings, so we 
can collapse or expand the headings to suit our needs.)

Figure 23-3 shows a more elaborate PivotTable that uses two axes. Along the row axis, we 
have categories broken out by distribution channel. Along the column axis, we have years 
(2009 and 2010), and we added the quarterly detail (not included in the Figure 23-2 exam-
ples) so we can see how each category in each channel did each quarter of each year. With 
four dimensions (category, distribution channel, year, and quarter) and two axes (row and 
column), we have a lot of choices about how to arrange the furniture. Figure 23-3 shows 
only one of many possible permutations.
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Figure 23-3  In this PivotTable, we arranged the data along two axes—rows and columns.

Figure 23-4 presents a different view. Now the distribution channels are arrayed by them-
selves along the column axis, while the row axis offers years broken out by quarters. The 
category, meanwhile, has been moved to what you might think of as a page axis. The data 
has been filtered to show the numbers for a single category, Mystery, but by using the filter 
control at the right edge of cell B2, we could switch the table to a different category (or 
combination of categories). Filtering the Category dimension by one category after another 
is like flipping through a stack of index cards.

None of these tables required more than a few clicks to generate.
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Figure 23-4  This PivotTable presents a filtered view, confining the report to a single category.

Creating a PivotTable
You can create a PivotTable from either an Excel range or an external data source. If you’re 
working from an Excel range, your data should meet the criteria for a well-constructed list. 
That is, it should have column labels at the top (the headings become field names in the 
PivotTable), each column should contain a particular kind of data item, and you should not 
have any blank rows within the range. If the range includes summary formulas (totals, sub-
totals, or averages, for example), you should omit them from the PivotTable; the PivotTable 
performs its own summary calculations.

For information about connecting to and querying external data sources, see Chapter 24, 
“Working with External Data.”

The source range on your Excel worksheet can be a table (as described in Chapter 22, 
“Managing Information in Tables”) or an ordinary list. Starting from a table has the advan-
tage of allowing for expansion. When you create a PivotTable from a table, Excel references 
your source data by its table name (either a default name, such as Table1, or the name you 
assign to the table). If you add rows to a table, the table dimensions automatically adjust 
to encompass the new data, and hence your PivotTable stays in sync with the expanded 
source data.
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For information about converting a list to a table, see “Creating a Table” on page 731.

To create a PivotTable, select a single cell within the source data and do either of the 
following:

●● Click the Insert tab, and then click PivotTable in the Tables group.

●● If your source data is a table and you’re currently displaying the Design tab under 
Table Tools, click Summarize With PivotTable in the Tools group.

Either way, the Create PivotTable dialog box appears. If your source data has a name (we 
assigned the name BookSales to the source table in our example), that name appears in the 
Table/Range box. Otherwise, Excel discerns the extent of your source data and presents a 
range reference in that box:

By default, your PivotTable arrives on a new worksheet, and that’s generally a good 
arrangement. If you want it elsewhere, specify where in the Location box. After you click 
OK, Excel generates a blank table layout on the left side of the worksheet and displays the 
PivotTable Field List window on the right. (See Figure 23-5.) The PivotTable Field List win-
dow is docked at the right by default. You can make it wider or narrower by dragging the 
split bar on its left edge. You can also undock it or drag it across the worksheet and dock it 
on the left.

Note
If you want to work with only a subset of items in a field, you can filter the field before 
you add it to the table. If your data source is large, and particularly if the source is 
external, you can save some time by filtering in advance. (You can also filter fields after 
you have created the table, of course.) To filter a field before you add it to the table, 
select the field name in the PivotTable Field List window, and then click the arrow on 
the right. For more details, see “Filtering PivotTable Fields” on page 793.
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Figure 23-5  As you select the check boxes for fields in the PivotTable Field List window, Excel 
populates the table layout at the left side of the worksheet.

To put some fields and data on that blank layout, begin by selecting the check boxes for 
those fields in the Choose Fields To Add To Report area of the PivotTable Field List window. 
As you select fields, Excel positions them in the four boxes at the bottom of the window. 
These four boxes represent the various components of the table. The Row Labels and Col-
umn Labels boxes hold the fields that appear on the row and column axes. The Report 
Filter box holds the field (or fields) you want to use to filter the table (comparable to the 
Category field in Figure 23-4), and the Values box holds the field (or fields) you want to use 
for calculations—the data you’re summarizing (your sales, for example).

Initially, Excel puts selected fields in default table locations that depend on their data types. 
Most likely you’ll want some arrangement other than the one you get by default. That’s not 
a problem, because you can move fields from one location to another easily; just drag them 
between the various boxes at the bottom of the PivotTable Field List window. Let’s look at 
an example.

To create the table shown in Figure 23-3, we want to put the Category and Channel fields 
in the Row Labels box, the Year and Quarter fields in the Column Labels box, and the Sales 
field in the Values box. When we select the check boxes for those fields, Excel drops the 
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Category and Channel fields in the Row Labels box (because they are text fields) and the 
Sales field in the Values box (because it’s a numeric field). These are all good guesses on the 
part of Excel—and, in fact, it’s just what we want. In addition to putting field headings in 
the appropriate boxes, Excel begins creating our PivotTable—as Figure 23-6 shows.

Figure 23-6  Excel builds the table, piece by piece, as you select fields.

So far, so good. The numeric formats aren’t right, but we can fix that easily enough.

What remains is to put the Year and Quarter fields into the Column Labels box. Unfor-
tunately, if we simply select their check boxes, Excel drops these fields in the Values box 
because the fields are numbers and the program has a predilection for adding numbers. 
This (see Figure 23-7) is definitely not what we want.

The solution is simple: Select the check boxes for the Year and Quarter fields, and then drag 
the Sum of Quarter and Sum of Year headings from the Values box to the Column Labels 
box. (Alternatively, you can make sure your field headings go where you want them by 
dragging them directly from the Choose Fields To Add To Report box to the appropriate 
boxes below, disregarding the defaults.)
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Figure 23-7  By default, Excel puts all numeric fields, including years and quarters, in the Values 
box. You can fix that by dragging field headings to the appropriate locations.

Rearranging PivotTable Fields
To pivot, or rearrange, a PivotTable, drag one or more field headings from one part of the 
PivotTable Field List window to another. For example, by using the mouse to change this 
configuration of the PivotTable Field List window:
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to this one:

we can change the table from the form shown in Figure 23-3 to this:

Note
If you don’t see the PivotTable Field List window, select a cell in the PivotTable. (The 
window disappears when your selection is not within the table.) If you still don’t see 
it, click the Options tab under PivotTable Tools on the ribbon, and then click Field List. 
This button is a handy way to toggle the field list in and out of view, letting you reduce 
distraction when you don’t need to do any field rearrangement.

To rearrange fields within the same axis—for example, to put Year before Quarter or Chan-
nel before Category in Figure 23-3, you can drag field headings from one place to another 
within the same area of the PivotTable Field List window. Often it’s simpler to click the arrow 
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to the right of the field heading you want to move. (For example, you might click the arrow 
to the right of Category in the Row Labels box.) The menu that appears includes easy-to-
use positioning commands:

INSIDE OUT  �
Pivot Your Tables the Excel 2003 Way If You Prefer

Earlier versions of Excel let you move fields around by dragging them directly on the 
table, instead of requiring you to work with the PivotTable Field List window. If you 
prefer that way of working, right-click any cell in the PivotTable, and click PivotTable 
Options. In the PivotTable Options dialog box, click the Display tab. Then select the 
Classic PivotTable Layout (Enables Dragging Of Fields In The Grid) check box. Note, 
however, that this option also changes the appearance of your table from the compact, 
outline-style presentation of Excel 2010 to the more space-consuming, tabular style of 
earlier versions. See “Choosing Report Layout Options” on the next page.

Refreshing a PivotTable
Because users often generate PivotTables from large volumes of data (and in many cases 
that data resides on external servers), Excel doesn’t automatically update PivotTables when 
their source data changes. To refresh a PivotTable, right-click any cell within it, and click 
Refresh. Alternatively, under PivotTable Tools, click the Options tab, and then click Refresh 
in the Data group. If you prefer keyboard shortcuts, press Alt+F5.

To ensure that your PivotTable is up to date whenever you open the file, right-click any cell 
in the table, choose PivotTable Options from the shortcut menu, and click the Data tab in 
the PivotTable Options dialog box. Select the Refresh Data When Opening The File check 
box, and then click OK.
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Changing the Numeric Format of PivotTable Data
As Figure 23-6 shows, Excel initially displays numeric PivotTable data in the General format, 
regardless of how it’s formatted in your source range. To fix that, right-click a cell in the 
field you want to change, and then click Number Format.

Choosing Report Layout Options
In Excel 2010, PivotTables by default use a more compact presentation style than some 
earlier versions used. This default layout (called Compact) indents inner fields on the row 
axis beneath their outer fields, letting you see more information at a glance. If you prefer, 
you can select from two alternative layouts, called Outline and Tabular. To switch from one 
layout to another, select a cell within the table, click the Design tab under PivotTable Tools, 
click Report Layout in the Layout group, and then click one of the displayed layouts (Show 
In Compact Form, Show In Outline Form, or Show In Tabular Form). Figure 23-8 compares 
the three layout options.

Figure 23-8  Excel offers three PivotTable layout options: Compact (left), Outline (center), and 
Tabular (right).
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Note that the layout options affect the row axis only. For example, the outline form simply 
indents the distribution channels below each category of book.

Formatting a PivotTable
The Design tab that appears on the ribbon under PivotTable Tools when you select any part 
of a PivotTable includes a large selection of professionally designed PivotTable styles. These 
work just like—and, in fact, are similar to—the styles available with ordinary tables. By 
choosing from the PivotTable Styles gallery, you can ensure that your PivotTable looks good 
and uses colors consistent with the rest of your workbook. You can customize the built-in 
style choices by selecting or clearing the check boxes in the PivotTable Style Options group, 
and you can add your own designs by clicking New PivotTable Style at the bottom of the 
PivotTable Styles gallery. To display the PivotTable Styles gallery, click the More button at 
the bottom of the scroll bar. (This button is a small arrow with a line above it.) For more 
information about using and customizing built-in styles, see “Formatting Tables” on page 770.

Customizing the Display of Empty or Error Cells

Empty cells in a PivotTable are usually displayed as empty cells. If you prefer, you can have 
your PivotTable display something else—a text value such as NA, perhaps—in cells that 
would otherwise be empty. To do this, right-click any cell in the PivotTable, and click Pivot-
Table Options. On the Layout & Format tab in the PivotTable Options dialog box, select the 
For Empty Cells Show check box, and in the text box type the text or value that you want 
to see.

If a worksheet formula references a cell containing an error value, that formula returns the 
same error value. This is usually true in PivotTables as well. Error values in your source data 
propagate themselves into the PivotTable. If you prefer, you can have error values generate 
blank cells or text values. To customize this aspect of PivotTable behavior, right-click any cell 
in the PivotTable, and click PivotTable Options. On the Layout & Format tab in the Pivot-
Table Options dialog box, select the For Error Values Show check box. Then, in the text box, 
type what you want to see.

Merging and Centering Field Labels

When you have two or more fields stacked either on the column axis or on the row axis 
of a PivotTable, centering the outer labels over the inner ones can sometimes improve the 
table’s readability. Just right-click a PivotTable cell, click PivotTable Options, and then select 
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the Merge And Center Cells With Labels check box on the Layout & Format tab in the 
PivotTable Options dialog box. With this option, you can change this kind of presentation:

to this:

Hiding Outline Controls

You’ll probably find outline controls useful in some contexts and not in others. They’re great 
when you have large or complex PivotTables and you want to be able to switch quickly 
from a details view to an overview. But if you find that they clutter the picture instead of 
enhance it, you can banish them easily: Select a PivotTable cell, click the Options tab under 
PivotTable Tools, and then click +/– Buttons in the Show group.

Note
With outline controls suppressed, you can still expand and collapse field headings. 
Select a heading in the field you’re interested in, click the Options tab under PivotTable 
Tools on the ribbon, and then click Expand Entire Field or Collapse Entire Field in the 
Active Field group.

Hiding Row Labels and Column Labels

The headings Row Labels and Column Labels that Excel displays near the upper-left cor-
ner of your PivotTable may prove distracting at times. You can suppress them by selecting 
a PivotTable cell, clicking the Options tab under PivotTable Tools, and then clicking Field 
Headers in the Show group. Note, however, that removing these labels also removes their 
associated filter controls—and you might want those controls from time to time. (See “Fil-
tering PivotTable Fields” on page 793.) The Field Headers command is a toggle. Click it again 
to restore the headings—and the filter controls.

Note
You can change the name of a PivotTable field or an item within a field by selecting any 
occurrence of it and typing the name you want. When you change one occurrence, all 
occurrences in the table change.



	 Displaying Totals and Subtotals	 789

Ch
ap

te
r 2

3

Displaying Totals and Subtotals
By default, Excel generates grand totals for all outer fields in your PivotTable by using the 
same summary function as the body of the table. In Figure 23-3, for example, row 30 dis-
plays grand totals for each quarter of each year, as well as for the years themselves. Column 
L, meanwhile, displays per-category totals by channel. The intersection of column L and row 
30 displays the grandest of totals, the sum of all sales for the period covered by the table. 
Because the body of the table uses the SUM function, all these grand totals use that func-
tion as well.

To remove grand totals from a PivotTable, right-click any cell in the table, and click Pivot-
Table Options. On the Totals & Filters tab in the PivotTable Options dialog box, clear the 
Show Grand Totals For Rows check box, the Show Grand Totals For Columns check box, or 
both check boxes.

Naturally, PivotTables are not restricted to calculating sums. For other calculation options, 
see “Changing PivotTable Calculations” on page 800.

Customizing Subtotals

By default, Excel creates subtotals for all but the innermost fields. For example, in Figure 
23-3, cell B6 displays the sum of cells B7:B9 (the Children subtotal for Quarter 1 of 2009), 
cell C10 displays the sum of cells C11:C13 (the Mystery subtotal for Quarter 2 of 2009), and 
so on. Columns F and K display yearly subtotals. The innermost fields, Channel (for the row 
axis) and Quarter (for the column axis), do not have subtotals.

To find options affecting all subtotals, select a cell in the PivotTable, click the Design tab 
under PivotTable Tools, and then click Subtotals on the left edge of the ribbon:
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You can use this menu to turn subtotaling off altogether or to move row-axis subtotals 
from their default position above the detail items to a position below.

To customize subtotals for a particular field, right-click an item in the field, and then click 
Field Options. (Alternatively, select an item in the field, click the Options tab under Pivot-
Table Tools, and then click Field Settings in the Active Field group.) Figure 23-9 shows the 
Field Settings dialog box for the Category field in our PivotTable example.

Figure 23-9  In the Field Settings dialog box, you can override the default subtotaling behavior 
for a particular field.

The Automatic option on the Subtotals & Filters tab in this dialog box means—as Auto-
matic means throughout Excel—that you’re letting the program decide what to do. In other 
words, this option gives you the default behavior. You can turn off subtotals for the selected 
field by selecting None. Selecting Custom lets you change the default subtotal calculation, 
such as from Sum to Average. And, as the text above the function list suggests, you’re not 
limited to one function. You can select as many as you need by holding down Ctrl while 
you click. Figure 23-10 shows a PivotTable with four subtotaling calculations applied to the 
Category field. (Note that when you have multiple subtotals for a field, Excel moves them 
below the detail.)

By using the Field Settings dialog box, you can also generate subtotals for innermost 
fields—subtotals that Excel usually does not display. Such inner subtotals appear at the 
bottom of the table ( just above the grand total row) or at the right side of the table 
( just to the left of the grand total column). Figure 23-11 shows an example of inner-field 
subtotaling.
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Figure 23-10  You can generate subtotals using more than one summary function; this table uses 
four for the Category field.

Figure 23-11  Subtotals for Channel, an inner field, appear in rows 30–32 of this table.
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Sorting PivotTable Fields
You can sort a PivotTable field either by its own items (for example, alphabetizing the cat-
egories in Figure 23-11) or on the basis of values in the body of the table (for example, 
sorting categories in descending order of sales totals so that the best-selling categories 
appear at the top). To sort a field, right-click any item in that field, and then click Sort. On 
the menu that appears, you can specify how you want to sort (for example A to Z or Z to A 
in the case of a text column). If you want to sort the field by values in the body of the table, 
click More Sort Options. You’ll see a dialog box similar to the one shown here (with the 
name of the field you selected in the title of the dialog box).

To sort by values in the table body instead of by items in the selected field, open the 
Ascending or Descending list. The list will include the available value fields.

Note
To ensure that Excel retains your sort specification when you update your PivotTable, 
click More Options in the dialog box shown above. Then select Sort Automatically 
Every Time The Report Is Updated.
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Filtering PivotTable Fields
Filtering a field lets you focus your table on a subset of items in that field. You can filter 
on the basis of the field’s own content (only the Children and Young Adult categories, for 
example) or on the basis of values associated with the field (for example, the three catego-
ries with the best overall sales). You can apply filters in a variety of ways—one of which is 
new in Excel 2010.

Filtering with the Report Filter Axis

Figure 23-4, on page 779, shows a PivotTable in which one field, Category, appears on the 
Report Filter Axis. To create this table, we simply dragged the Category field from the Pivot-
Table Field List to the Report Filter area below the field list. With the table arranged in this 
manner, we can focus on one category at a time.

When you put a field heading in the Report Filter area, the table initially aggregates all val-
ues of the field and displays the heading (All) next to the field name—like this:

To filter the report so that it shows a particular field value, click the drop-down arrow 
beside the field name, and select a value:
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To select two or more field values, select the Select Multiple Items check box. Note, how-
ever, that if you filter on multiple field values, the indication beside the field name, above 
the table, does not tell you which values you’re looking at. It simply says (Multiple Items):

Correcting this deficiency is one of the principal virtues of Excel’s newest PivotTable feature, 
the slicer.

Filtering with Slicers

A slicer is an independently movable and formattable window containing buttons for each 
item in a field. You can use the buttons to filter your PivotTable. Figure 23-12 presents an 
example. Here, we selected three members of the Category field—Children, Romance, and 
Young Adult. Because these field items appear in a contrasting color in the slicer, you can 
see at a glance how the table has been filtered.

Figure 23-12  A slicer makes it easy to see how the table has been filtered.
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To use a slicer, select any cell in your PivotTable, click Insert Slicer in the Sort & Filter group 
on the PivotTable Tools Options tab, and then click Insert Slicer. The Insert Slicers dialog box 
presents a check box for each field in your table. Select a field, and then click OK. You can 
select multiple fields to create more than one slicer. Figure 23-13 shows a table filtered by 
two slicers.

Figure 23-13  You can use multiple slicers to filter in more complex ways.

Connecting a Slicer to Multiple PivotTables

A single slicer can slice many tables. If you create multiple PivotTables to show a common 
set of data in different perspectives, you might find it convenient to set up slicers that are 
linked to all the related tables. To connect an existing slicer to another PivotTable, select the 
slicer. Then click PivotTable Connections in the Slicer group on the Slicer Tools Options tab. 
The PivotTable Connections dialog box displays the name of the selected slicer and a check 
box for each available PivotTable, as shown here.

Select the tables you want to slice, and click OK.
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Formatting Slicers

You can style your slicers by using the same techniques you use to style a PivotTable or an 
ordinary table. Select a slicer, click the Slicer Tools Options tab, and then take your pick of 
styles from the Slicer Styles gallery. As with styles elsewhere in Excel, the available choices 
are keyed to your current workbook theme, so your slicer uses colors that are consistent 
with the rest of your workbook. For more information about using and customizing built-in 
styles, see “Formatting Tables” on page 770.

Filtering in the Field List Window

If you’re working with a large external data source and you need only a subset of the data, 
you can save yourself some time by setting up a filter in the PivotTable Field List window 
before you execute the query and create your PivotTable. To filter in the PivotTable Field 
List window, select the heading for the field you want to filter, and then click the arrow to 
the right of the field heading. The dialog box that appears includes check boxes for each 
unique item in the selected field:
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You can use the check boxes to select one or more particular items in your selected field. If 
your field is more complex than the example here, you might want to click Label Filters, in 
response to which Excel presents many additional filtering options:
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The options that appear on this menu are tailored for the data type of the selected field. If 
your field holds dates instead of text, for example, you see these options:
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To filter a field on the basis of values associated with that field, click the arrow next to the 
field heading in the PivotTable Field List window, and then click Value Filters on the menu 
that appears. For example, to filter the PivotTable in Figure 23-3 so that it shows only the 
three categories with the highest total sales, click the arrow beside Category, and then click 
Value Filters to see the following menu.

Then click Top 10 to display the Top 10 Filter dialog box:

Replace the 10 with a 3, and then click OK. Figure 23-14 shows the result.
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Figure 23-14  This table has been filtered to show only the three best-selling categories; the 
rankings are based on values in the Grand Total column.

Note that when you apply a value filter to a field, Excel bases its calculations on the current 
grand total associated with that field. If you wanted to see the three top-selling categories 
for the year 2009 (in the example shown in Figure 23-3), you would need to filter the Year 
field as well as the Category field.

Changing PivotTable Calculations
By default, Excel populates the Values area of your PivotTable by applying the SUM function 
to any numeric field you put there or by applying the COUNT function to any nonnumeric 
field. But you can choose from many alternative forms of calculation, and you can add your 
own calculated fields to the table.

Using a Different Summary Function

To switch to a different summary function, right-click any cell in the Values area of your 
PivotTable, and then click Value Field Settings. (Alternatively, click the Options tab under 
PivotTable Tools, and then click Field Settings in the Active Field group.) Excel displays the 
Value Field Settings dialog box, shown in Figure 23-15. Select the function you want from 
the Summarize Value Field By list, and then click OK.

Excel fills in the Custom Name line in this dialog box according to your selection in the 
Summarize Value Field By list. If you switch from SUM to AVERAGE, for example, the Cus-
tom Name line changes to include the word Average. You can type whatever you like there, 
though.
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Figure 23-15  Using this dialog box, you can change the function applied to a field in the Values 
area of your PivotTable.

Applying Multiple Summary Functions to the Same Field

You can apply as many summary functions as you want to a value field. To use a second 
or subsequent function with a field that’s already in the Values area of your PivotTable, 
drag another copy of the field from the PivotTable Field List window to the Values box. 
Then select a Values area cell, return to the Value Field Settings dialog box, and select the 
function you want to use. The available functions are SUM, COUNT, AVERAGE, MAX, MIN, 
PRODUCT, COUNT NUMBERS, STDDEV, STDDEVP, VAR, and VARP.

Using Custom Calculations

In addition to the standard summary functions enumerated in the previous paragraph, 
Excel offers a set of custom calculations. With these you can have each item in the Values 
area of your table report its value as a percentage of the total values in the same row or 
column, create running totals, or show each value as a percentage of some base value.

To apply a custom calculation, right-click a cell in the Values area, and then click Value Field 
Settings. Click the Show Values As tab in the Value Field Settings dialog box. Then select a 
calculation from the Show Values As list. Table 23-1 lists the available options.

When you select a calculation in the Show Values As list, the Base Field and Base Item boxes 
display choices that are relevant to your calculation. For example, as Figure 23-16 shows, if 
you select Difference From in our books example, the Base Field box displays Quarter, Cat-
egory, Channel, and so on. If you select Quarter in this list, the Base Item box presents the 
four quarters, along with the self-explanatory items Previous and Next.
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Table 23-1  Custom Calculation Options

Difference From Displays data as a difference from a specified base field and base 
item

% Of Displays data as a percentage of the value of a specified base field 
and base item

% Difference From Displays data as a percentage difference from a specified base field 
and base item

Running Total In Displays data as a running total
% Of Row Displays each data item as a percentage of the total of the items in 

its row
% Of Total Displays each data item as a percentage of the grand total of all 

items in its field
Index Uses this formula: ((Value in cell) * Grand Total of Grand Totals)) / 

((Grand Row Total) * (Grand Column Total))

Figure 23-16  When you choose a calculation such as Difference From, the Base Field and Base 
Item boxes display relevant options.

Figure 23-17 and Figure 23-18 illustrate some ways you can modify default calculations and 
Values field names. The table in Figure 23-17 lists 2006–2007 performances at major opera 
houses around the world by theater, country, opera, composer, and performance date. 
The PivotTable in Figure 23-18 includes the Date field twice in the Values box. The default 
summary calculation for date data is Count, and that’s fine because we want the number 
of performances, and counting dates is a way to get that. But we used the Custom Name 
box in the Value Field Settings dialog box (refer to Figure 23-15) to change the name from 
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Count of Date to No. of Performances. When we dragged the second instance of the Date 
field to the Values box, we used the Value Field Settings dialog box to make the field report 
the percentage of total. You could use similar techniques with other kinds of polling or sur-
vey applications.

Figure 23-17  From this table, a PivotTable will apply the COUNT function to the Date field to 
count performances.

You’ll find the OperaSked.xlsx file with the other examples on the companion Web site.

Note
If you filter a field, percentage-of-total calculations are based on the data that meets 
the filter criterion, not the unfiltered data set.
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Figure 23-18  The PivotTable uses the Date field from Figure 23-17 twice—once to count 
performances and a second time to calculate percentage of total.

Using Calculated Fields and Items

In case custom calculations don’t meet all your analytical needs, Excel lets you add cal-
culated fields and calculated items to your PivotTables. A calculated field is a new field, 
derived from calculations performed on existing fields in your table. A calculated item is a 
new item in an existing field, derived from calculations performed on other items that are 
already in the field. After you create a custom field or item, Excel makes it available to your 
table as though it were part of your data source.

Custom fields and items can apply arithmetic operations to any data already in your Pivot-
Table (including data generated by other custom fields or items), but they cannot reference 
worksheet data outside the PivotTable.

Creating a Calculated Field

To create a calculated field, select any cell in the PivotTable. Then click the Options tab 
under PivotTable Tools, and click Field, Items, & Sets in the Calculations group. On the 
Fields, Items, & Sets menu, click Calculated Field. Figure 23-19 shows the Insert Calculated 
Field dialog box.
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Figure 23-19  Create a calculated field in this dialog box.

Type a name for your calculated field in the Name box, and then type a formula in the For-
mula box. To enter a field in the formula, select it from the Fields list, and click Insert Field. 
Figure 23-20 shows an example of a calculated field.

Figure 23-20  This calculated field multiplies an existing field by a constant.

Excel adds a new calculated field to your PivotTable when you click either Add or OK. You 
can then work with the new field using the same techniques you use to work with existing 
fields.

Creating a Calculated Item

To create a calculated item for a field, select any existing item in the field or the field head-
ing. Then click the Options tab under PivotTable Tools, and click Fields, Items, & Sets in the 
Calculations group. On the Fields, Items, & Sets menu, click Calculated Item. Excel displays a 
dialog box comparable to the one in Figure 23-21.
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Figure 23-21  Use this dialog box to create a calculated item for a field.

To create a calculated item, type a unique name for the item in the Name box, and then 
enter a formula in the Formula box. You can select from the Fields and Items lists and click 
Insert Field and Insert Item to enter field and item names in the formula.

Note
You cannot create calculated items in fields that have custom subtotals.

Figure 23-22 shows an example of a calculated item. In this case the new item represents 
domestic sales divided by the sum of international and mail order sales.

Figure 23-22  This calculated item appears by default whenever you include the Channel field in 
the PivotTable.
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Note
You cannot create a calculated field or a calculated item in a PivotTable based on OLAP 
source data.

Displaying a List of Calculated Fields and Items

To display a list of your calculated fields and items, along with their formulas, click the 
Options tab under PivotTable Tools, and then click Fields, Items, & Sets in the Calculations 
group. On the Fields, Items, & Sets menu, click List Formulas. Excel displays the list on a new 
worksheet, as shown in Figure 23-23.

Figure 23-23  Excel lists calculated fields and items on a new worksheet

As the note in Figure 23-23 indicates, you need to be careful when a cell in your table is 
affected by more than one calculated field or item. In such cases, the value is set by the 
formula that’s executed last. The Solve Order information in the list of calculated fields and 
items tells you which formula that is. If you need to change the solve order, select the work-
sheet that contains the PivotTable, click the Options tab under PivotTable Tools, and then 
click Fields, Items, & Sets in the Calculations group. Then click Solve Order.
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Grouping and Ungrouping Data
PivotTables group inner field items under each outer field heading and, if requested, create 
subtotals for each group of inner field items. You might find it convenient to group items 
in additional ways—for example, to collect monthly items into quarterly groups or sets of 
numbers into larger numeric categories. Excel provides several options for grouping items.

Creating Ad Hoc Item Groupings

Suppose that after looking at Figure 23-3 you decide you’d like to see the domestic and 
international sales figures grouped into a category called Retail. To create this group, select 
the Domestic and International items anywhere in the table. Then click the Options tab 
under PivotTable Tools, and click Group Selection in the Group group. Excel creates a new 
heading called Group1:

Now you can rename Group1 by typing over any instance of it.
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Grouping Items in Date or Time Ranges

Figure 23-24 shows a PivotTable that summarizes daily transactions by payee. As you can 
see, the data in this table is extremely sparse. Most intersections between a day item and a 
payee item are blank.

Figure 23-24  To make the data in this table more meaningful, you can group the date field.

You’ll find the Transactions.xlsx file with the other examples on the companion Web site.

To make this kind of table more meaningful, you can group the date field. To do this, select 
an item in the field. Then click the Options tab under PivotTable Tools, and click Group 
Field. Excel responds by displaying the Grouping dialog box, shown in Figure 23-25.
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Figure 23-25  Excel gives you lots of ways to group by date.

Excel gives you a great deal of flexibility in the way your date and time fields are grouped. 
In the By list, you can choose any common time interval, from seconds to years, and if the 
standard intervals don’t meet your needs, you can select an arbitrary number of days. You 
can also create two or more groupings at the same time (hold down Ctrl while you select); 
the results of grouping by both Quarter and Month are shown in Figure 23-26.

Figure 23-26  In this table, daily data is grouped by months and then by quarters.
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Displaying the Details Behind a Data Value
If you double-click any PivotTable value that represents a summary calculation, Excel dis-
plays the details behind that calculation on a new worksheet. For example, in Figure 23-26, 
cell G11 informs us that we spent $681.21 at Coho Vineyard during the month of June. 
Double-clicking G11 reveals the details:

Creating PivotCharts
PivotCharts, like PivotTables, summarize tabular information and allow for easy transposi-
tion of fields and axes. They’re a great way to study or present elements of your data set.

You can create a PivotChart directly from your source data by selecting a cell in the origi-
nal data range, clicking the Insert tab, clicking the arrow beneath PivotTable in the Tables 
group, and then clicking PivotChart. After you specify or confirm your data source and indi-
cate where you want the new PivotChart to reside (in a location on the existing worksheet 
or on a new worksheet), Excel presents both a PivotTable layout and a blank chart canvas, 
along with a PivotChart Filter Pane. (See Figure 23-27.) Excel creates a PivotTable at the 
same time it creates a PivotChart—and hence you see a blank table layout.
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Figure 23-27  When you create a new PivotChart, Excel draws a blank chart canvas as well as a 
blank table layout. The program creates a PivotTable at the same time it creates the PivotChart.

Figure 23-28 shows a simple PivotChart created from this chapter’s Books table. Because 
charts are generally most effective when applied to a modest amount of data, we used the 
Report Filter box to restrict the presentation to a single category (Children), and we filtered 
the Channel field to show international and mail order sales only. We also tidied up a bit by 
closing the PivotTable Field List window and dragging the PivotChart Filter Pane to a less 
obtrusive position.

As you can see, when you select a PivotChart, Excel adds a new set of tabs to the ribbon, 
under PivotChart Tools. With these tabs, you can manipulate and format your PivotChart 
the same way you do an ordinary chart. (For details about working with charts, see Chapter 
19, “Basic Charting Techniques,” and Chapter 21, “Advanced Charting Techniques.”) While 
the chart is selected, changes in the four boxes below the field list reflect the fact that 
you’re working with a chart instead of a table: the Row Labels box becomes the Axis Fields 
box, and the Column Labels box becomes the Legend Fields box. You can pivot the chart 
the same way you would pivot a PivotTable—by dragging field names from one box to 
another. You can also change the filter applied to the chart by manipulating the drop-down 
lists that appear alongside the chart axes and above the legend.
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Figure 23-28  We used a PivotChart to plot two distribution channels for one book category.

A PivotChart and its associated PivotTable are inextricably linked. Changes to one are 
immediately reflected in the other.

In Figures 23-27 and 23-28, we created a PivotChart directly from the source data. You 
can also create one from an existing PivotTable. Select any cell in the PivotTable, click the 
Options tab under PivotTable Tools, and then click PivotChart in the Tools group.
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Symbols and Numbers
& (ampersand) concatenation operator, 477–478
' (apostrophe) left-alignment prefix, 155–156
* (asterisk)

precedence as multiplication sign, 467–468
repetition initiator formatting symbol, 337
wildcard character, 244
wildcard filter character, 752

@ (at sign)
formatting text placeholder, 337
structured reference tag for current row, 767–768

\ (backslash)
literal demarcation character for formats, 337
text-alignment prefix, 155–156

^ (caret) text-alignment prefix, 155–156
: (colon), reference range operator, 502
, (comma)

Comma Style button, 324, 329
as number separator, 151, 323
structured reference union operator, 502

{ } (curly braces), 513–514
$ (dollar sign)

$ button, Home tab, 326
absolute references, signifying, 470
currency character, 322
data entry with, 151

... (ellipsis)
commands, additional, 30
entering as data, 156–157

= (equal sign)
equality, conditional test symbol, 522
formulas, leading entry for, 467

> (greater than operator), 522
# (hash mark) error value indicator, 479
< (less than operator), 522
– (minus sign), entries beginning with, 151
< > (not equal to operator), 522
###... (number signs filling cells), 153
() (parentheses)

around values, 151
functions, closing automatically, 479
precedence effects in formulas, 467–468

% (percent sign), data entry with, 152, 323
+ (plus sign)

entries beginning with, 151

precedence of, 467–468
? (question mark)

wildcard character, 244
wildcard filter character, 752

" (quotation mark) text-alignment character, 155–156
/ (slash)

data entries with, 152
formatting resulting from, 323
precedence as division sign, 467–468

~ (tilde), finding strings with wildcard characters, 244
_ (underscore) formatting symbol, 337
3-D charts, 716
3-D formatting options, 403, 415–417
3-D references, 496–497
64-bit Edition, 10

A
ABS (absolute value) function, 1022
absolute references

copying, 473–474
defined names as, 484
formulas, defined for, 470, 473–474
macro use of, default, 899–900
pasting links, 208
sorting, recommended for, 744

access control for documents
Change permissions, 876
Copy command control, 877
Information Rights Management (IRM), 874
modifying permissions, 878
print permissions, 877
programmatic access, 878
Read permissions, 876
requesting permissions option, 876–877

Access databases
adding tables to the Query data pane, 837
data connection icons for, 816
editing queries against, 835–839
fields, editing on importation, 837–838
filtering query result sets, 840–844
filtering records to import, 831–832
join operations on data from, 837
opening an entire Access table in Excel, 819–820
opening saved queries to, 834–835
queries, selecting Access as a source type, 829
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Access databases, continued
saving queries to, 833–834
selecting databases for importing, 830
selecting fields for columns, 830–831
sorting data being imported, 832–833, 838–839
sorting data while importing, 832–833

accessibility features, 107–110
accounting

DAYS360 function, 1033
DB (declining balance), 1033
DDB (double-declining balance) function, 1034
functions. See financial functions

accounting formats, 327–329, 542
ACCRINT, ACCRINTM functions, 592–593, 1021
ACOS (arccosine) function, 1022
ACOSH (inverse hyperbolic cosine) function, 1022
Across Worksheets command, 236, 260–261
Activate method, VBA, 907
activation, 17–18
active areas, 137
active cells

ActiveCell objects, VBA, 905
defined, 20
fill handles, 138
formula bar display of, 37
moving without selection loss, 147
Name box reference to, 25
references of, 140
selections, relationship to, 140

active content
add-ins, 115
defined, 111
enabling documents with, 113–114

active ranges, 140. See also ranges
ActiveX control security settings, 115–116
Add To Selection mode, 138
add-ins

AddIns folder, 926
data analysis. See Analysis Toolpak
enabling custom, 926
Euro Currency Tools, 596–599
installing, 616–617
options for enabling, 115
saving workbooks as, 925–926
Solver, 655–666

addition
+ sign precedence, 467–468
entries beginning with +, 151
function for. See SUM function

ADDRESS function, 559, 1022
Advanced Filter command, 752–762
Advanced options

Display area, 104–107
Edit Custom Lists, 237–238
editing options, 227–229
Extend Data Range Formats And Formulas option, 238
zeros, hiding, 106–107

After Pressing Enter, Move Selection option, 38

aggregation functions
AVEDEV (average of absolute deviations), 1024
AVERAGE, AVERAGEA functions, 544, 602, 800–801, 1024
COUNT function, 603, 736–737, 800–801, 845–848, 1028
CUBESETCOUNT function, 1032
CUBEVALUE function, 1032
DAVERAGE function, 1033
DCOUNT function, 1033
DCOUNTA function, 1034
DSUM, 1036
Microsoft Query aggregation calculations, 845–848
SUBTOTAL function, 736–737, 748–749, 1063
SUM. See SUM function

alignment
Alignment group, 342–343
Alignment tab options, 342–343
Fill alignment format, 345–346
formatting, Cell Style attribute for, 305
graphic objects, of, 428–429
horizontal options, 342
horizontal text alignment, 344–346
indenting cell content, 344
justifying text, 346–347
orientation of text, 347–350
orientation options, 343
Shrink To Fit option, 350–351
text control options, 343
text direction options, 343
vertical options, 342
vertically aligning text, 347

#All tag, 768–769
Allow Editing Directly In Cells option, 228
Alt+= (SUM function), 480–481
Alt+F11 keyboard shortcut, 903
Alt key activation of command labels, 34–36
Alt Text data, 427
AMORDEGRC function, 1022
amortization. See depreciation; investment functions
ampersand (&) concatenation operator, 477–478
Analysis Toolpak. See also securities analysis functions

Data Analysis button, 616
Descriptive Statistics tool, 618–619
Histogram tool, 619–622
installing, 616–617
Moving Average tool, 631–633
Rank And Percentile tool, 623–625
Sampling tool, 630–631

AND function, 551–552, 1023
AND operator, filtering with, 756, 758
angled text, 347–350
angles. See trigonometric functions
apostrophe (') left-alignment prefix, 155–156
AppData folders, 46–47
Apple computers. See Macintosh computers
Application objects, 921
Apply Names command, 494–495
arccosine (ACOS) function, 1022
arcsine (ASIN) function, 1023
arctangent (ATAN, ATAN2) functions, 1023
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AREAS function, 563, 1023
arguments, array, 512, 517, 533
arguments of formulas, 263, 533
arguments of functions

array arguments in, 533
autocompletion in VBA, 931
custom function arguments, 919
expressions as, 531
Function Arguments dialog box, 528–529, 534
functions without arguments, 531
inserting references with mouse devices, 535
inserting with dialog box, 528–529, 534
logical values in, 532
maximum number of, 11
named references in, 532
numeric values in, 532
optional, custom coding for, 923–925
parentheses, placement in, 479
ranges in, 531
Select Arguments dialog box, 534
syntax of, 531
text values in, 532

arguments to methods, VBA, 908–909
Arrange Windows dialog box, 180–181
arranging objects, 423–429
arrays

{ } curly braces, 513–514
arguments, 512, 517, 533
clearing, 514
COLUMNS function, 1028
commas and semicolons in formulas for, 516–517
constants, 512, 516–517
editing, 514
expansion of arguments, 517
formulas, 512–516
Go To dialog box, selecting with, 146
INDEX function, as argument for, 560–562, 1045
locking formulas, 513–514
lookup functions with, 555–558
MDETERM function, 1049
MINVERSE function, 1051
moving, 514
one-dimensional, 512–513
pasting values from, 208
range selection for, 513–514
ROWS function, 562, 1061
selecting, 514
single-cell formulas, 515–516
terminology for, 512
TRANSPOSE function, 563, 1066
two-dimensional, creating, 514–515

ASCII encoding
ASC function, 1023
CHAR function, 545–546, 1026
CODE function, 545–546, 1028
Symbol box, selecting in, 156

ASIN (arcsine) function, 1023
ASINH (inverse hyperbolic sine) function, 1023
Assert method of Debug, 934–935

assignment statements, VBA, 920–921
asterisk (*)

precedence as multiplication sign, 467–468
repetition initiator formatting symbol, 337
wildcard filter character, 752

at sign (@)
formatting text placeholder, 337
structured reference tag, 767–768

ATAN (arctangent) function, 1023
ATAN2 (arctangent) function, 1023
ATANH (inverse hyperbolic tangent) function, 1024
audiences, design considerations for, 132–133
audio feedback for accessibility, 108
auditing

Error Checking dialog box, 261–263
Evaluate Formula dialog box, 263–265
Formula Auditing group, 261
tracing references, 267–272
Watch Window feature, 265–267

authentication with digital signatures, 121–125
Auto Fill

AutoFill feature, 569–570
dates and times with, 233
double-clicking to extend series, 232
Fill Series option of, 229–231

AutoCalculate feature, 41
AutoComplete

accessibility feature, as, 109
Enable AutoComplete For Cell Values option, 228
operation of, 249–250

AutoCorrect
AutoFormat As You Type options, 239
capitalization errors, 247
customized actions, 248–249
functionality of, 246–247
hyperlinks option, 944
Internet addresses, conversion to hyperlinks, 248
options in dialog box, 247
other Office programs, list shared with, 248
Replace Text As You Type option, 247
shorthand, adding individual, 250

autoexpansion of tables, 729
AutoFill feature, 569–570. See also Auto Fill
AutoFit Row Height command, 362
AutoFormat, 238–239
automatic range expansion, 538
Automatically Insert A Decimal Point option, 139, 227
AutoRecover information, 78–81
AutoSum function button, 480–481
averages

AVEDEV (average of absolute deviations) function, 1024
AVERAGE, AVERAGEA functions, 544, 602, 800–801, 1024
AVERAGEIF(S) functions, 602, 1024
AVG (average) function, Query, 845–848
DAVERAGE function, 1033
GEOMEAN function, 1041
HARMEAN (harmonic mean) function, 1041
Mean statistic, 619
MEDIAN function, 603–606, 619, 760–761, 1050
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averages, continued
moving averages. See trendlines
PivotTable value fields with AVERAGE, 800–801
RANK.AVG function, 606, 1059
status bar display of, 481
table total rows, inserting in, 736–737

axes of charts
category axes, 680
color selection, 706
data series assignment to secondary axes, 717–718
date base unit options, 713–715
date category axes, 712–715
depth axes, 716
Display Units scaling factor options, 709
Fixed Maximum/Minimum options, 707–708, 713
Format Axis dialog box, 708, 710, 712
formatting basics, 699–700
gridline spacing, 708, 710
intersection point specification, 708, 711–712
label overlap issues, 711
labels, positioning, 706–707
line style specification, 706
logarithmic scaling, 709
Major/Minor Unit values, 708, 713
manipulation of, 679–681
numeric formats of labels, 707
options overview, 706
reversing data point order, 680, 709
scaling factor options, 679–680, 707–716
Show As options, 679–680
switching from text to date, 712
text category axes scaling, 709–712
tick marks specification, 706–707, 708
time-scaled, 709
titles, adding, 681
value axes, 680, 707–709

B
background areas of charts

gradient fills, 702–704
image fills, 704–705
texture fills, 704–705
transparency, 702
types of items that are, 701

background colors, 358–359
background images, worksheet, 360–361
backslash (\)

literal demarcation character for formats, 337
text-alignment prefix, 155–156

Backstage view
accessing, 41–42
printing from, 455–457
properties, setting for workbooks, 58–59
as replacement for Microsoft Office button, 4

backup files, automatic creation setting, 56–57
backups, AutoRecover information, 78–81
BAHTTEXT function, 1024
banding, 295
Bernoulli distributions, 628

BESSEL functions, 1024–1025
BETA.DIST function, 1025
BETA.INV function, 1025
bevels for graphic objects, 407–408, 416
BIN2DEC (binary to decimal) function, 1025
BIN2HEX (binary to hexadecimal) function, 1025
BIN2OCT (binary to octal) function, 1025
binomial distributions, 628, 1026, 1052
bins, histogram, 619–622
Bitmap format, pasting Excel data into Word as, 968
blank cells, counting, 553–554
Blank Workbook template, 42–43
Body font styles, 771
Bold command, 351
bonds. See also interest; securities analysis functions

COUP (coupon) functions, 595, 1030
ODDFPRICE function, 1054
ODDFYIELD function, 1054
ODDLPRICE function, 1054
ODDLYIELD function, 1055
YIELD functions, 594, 1070

Boolean functions. See logical functions
borders

angled borders, 355
applying, 356
Borders button, 353
Contour 3-D property, 417
Draw Borders commands, 356–357
erasing, 356
formatting, Cell Style attribute for, 305
line style selection, 356
More Borders command, 354

bottom alignment, 347
break mode, 930–931, 937
breakpoints, 933–935
brightness, image, 401–402
Bring Forward button, 423–424
Browsed Pages button, Insert Hyperlinks box, 946
browsers, copying Web data into Excel, 855
bugs in Excel 2010, 19–20. See also debugging macros and 

custom functions
button modifiers, 86–87

C
calculated columns, structured references for, 499
calculated items, PivotTable, 804–807
calculation

Automatic Except For Data Tables option, 506
Calculate Now button, 507
Calculate Sheet button, 507
Calculation Options button, 506–507
defined, 506
iterative, enabling, 510–511
legacy version recalculations, 506
manual, option for, 506–507
multithreaded/multiprocessor acceleration of, 507
partial formula calculations, 508
Recalculate Workbook Before Saving option, 506
status bar indication of, 506
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volatile functions, frequency of, 626
callout shapes, 383–385
Camera command, 435–436
candlestick charts, 715, 719, 726
capitalization errors, AutoCorrect for, 247
Caps Lock mode, 139
caret (^) text-alignment prefix, 155–156
case

failure to distinguish for file names, 50
LOWER function, 544, 547, 1049
PROPER function, 544, 547, 1058
sorting criteria, 746–747
UPPER function, 544, 547, 1067

Case structures, VBA, 932
cash flow functions. See investment functions
CEILING function, 542–543, 1026
CELL function, 1026
cell selection rectangles, 138, 221–222
Cell Styles

advantages of, 303
attributes of, 305
categories of, 303–304
copying between workbooks, 308–309
creating custom, 304–307
Custom category, 304
deleting, 309
duplicating, 306–307
example, creating by, 306–307
live previews of, 304
modifying, 307
Normal style, 307
Style dialog box, 304–305

cells
active cells, 20
Allow Editing Directly In Cells option, 228
Copy As Picture command, 433–434
deleting, 217–220
disabling in-cell editing, 226
empty, function for counting, 553
entering data directly in, 149–150
hiding formulas, 176
hyperlinks to, creating, 947–948
inserting, 214–216
merging, 365–368
mode indicators, 40
naming, 483–486
properties, linking to, 60–61
Show Formulas In Cells option, 105–106
sizing, 361–365
unlocking individual, 171–172

Cells group of Home tab
Delete menu, 217
Insert menu, 212, 214

centering text, 344–346
centering worksheets on pages, 444
certificates, digital, 121–125
change tracking, 861–863, 870
changes, combining from multiple workbooks, 869–871
CHAR function, 545–546, 1026

characters
blank characters, removing, 546
CHAR function, 545–546, 1026
CODE function, 545–546, 1028
coding of, 156–157
double-byte character sets, 548
formatting individual, 321–322
furigana, 1056
JIS function (single to double byte), 1047
orientation of, 347–350
PHONETIC function, 1056
sort order of, 745

charts
3-D, 716
adding data points to, 719–720
All Chart Types option, 670–671
area transparency, 702
axes. See axes of charts
background areas of items, formatting, 701–705
borders, 685, 699–700
candlestick, 715, 719, 726
category axes, 680
Change Type command, 675
changing types, 672
Chart Objects list, 685, 697–698
Charts group of Insert tab, 670
color selection, 674–675, 683–684, 699–700
context-sensitive tools for, 33
creation, basic steps for, 671–672
data label options, 716–717
Data Labels command, 678
data points per series, new limitation on, 9
data series assignment to secondary axes, 717–718
data tables, adding to, 679
date category axes, 712–715
depth axes, 716
Design tab display, 672
double-clicking elements of, 698
effects options, 685
elements of, selecting, 697–698
e-mail, sending by, 873
empty cells as data, 721
error bars for, 725
Excel 2007 improvements for, 13
Excel Web App issues with, 892
fills, 685
filter controls for, 670
formatting text in, 683–684
galleries of types, navigating to, 670–671
Glow And Soft Edges command, 686
gradient fills, 702–704
Gradient Line option, 699–700
gridline spacing, 708, 710
gridlines, 682–683
handles for elements of, 697
hidden cells as data, 721
high-low lines, 726
hyperlinks, assigning to, 949
image fills, 704–705
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charts, continued
improvements over legacy Excel versions, 669
intersection point specification, 708, 711–712
labels for, 678, 716–717
layouts gallery, 674
legends for, 677–678
Line Style options, 700
lines, changing appearance of, 685, 699–700
log scales for, 679–680
logarithmic scaling, 709
Microsoft Graph Chart, 974–975
modifying data sources for, 718–721
Move Chart command, 675
multilevel categories for, 721–723
No Fill option, 702
noncontiguous source ranges, 720–721
objects, initial display of, 671–672
Office common charting engine, 973
open-high-low-close, 713–715
Other Charts button, 671
pasting into Word documents, 975
PivotCharts. See PivotCharts
removing data inside ranges, 720
repositioning elements of, 699
rotating text in, 681–682
scaling factor options, 707–716
scaling factors, 679–680
ScreenTips for items in, 697
Select Data Source dialog box, 677, 719–720
selecting data for, 669–670
selecting members of item sets, 698
separate sheets, moving charts to, 675
Shape Styles for, 684–685
Solid Line option, 700
sparkline. See sparklines
stock chart types, 715
style selection, 674–675
Switch Row/Column command, 672–673
tables, adding data points to, 718–719
tables, creating for charting, 670
templates, saving formats to, 686–687
text boxes, adding, 683
text formatting, 705
texture fills, 704–705
themes, format options related to, 674–675, 684–685
tick marks specification, 706–707, 708
titles, axis, 681
titles for, 675–677
titles, rotating text of, 681–682
transparency options, 699
trendlines, adding, 724–725
trendlines, formatting, 699–700
two type combinations, 672, 718
type, choosing, 670–672, 675
up and down bars, 726
value axes, 680
Word documents, Excel charts in, 973–975
WordArt Styles for, 684–685

Chinese characters, 1056

CHOOSE function, 559, 1027
circles, drawing, 376–377
circular references, 508–511
classes, VBA, 905–906
CLEAN function, 544, 546, 1027
clearing

cells, 220–222
conditional formatting, 318
formatting, 299

clip art, inserting, 394–396
Clipboard

collecting multiple items on, 198–200
Excel data, pasting to Word with, 963–964
parsing pasted text strings from, 824
Paste All command, 200

Close button, 25
cloud computing, 888. See also Office Web Apps; Windows 

Live
CMA (Competitive Market Analysis), 612
CODE function, 545–546, 1028
collaboration

access control with. See IRM (Information Rights 
Management)

advanced sharing options, 863–864
allowing changes by multiple simultaneous users, 861–863, 

870
change tracking, 861–863
The Changes Being Saved Win option, 864
changes, combining from multiple workbooks, 869–871
closing shared sessions, 869
conflict management, 861–863
e-mail, sharing workbooks by, 872–874
filtering options, 864
formatting of changed cells, 861
guidelines, establishing, 863
highlighting changes, 865–868
history worksheets, 867
Keep Change History For specification, 870
legacy Excel versions, issues with, 862
limitations of, 862
merging workbooks, 870–871
password protection of workbooks, 865
print settings options, 864
Protect Shared Workbook command, 867
real-time on Web, issues of, 890
remote computers, saving files to, 859
Resolve Conflicts dialog box, 862–863
reviewing changes, 868
seeing just other users' changes option, 864
Send For Review command, 873–874
sharing workbooks on networks, 860–863
SkyDrive folders for, 884–886
tracking changes in shared workbooks, 863–868
update options, 864
user names, editing, 861
Web Apps for, 887–892. See also Office Web Apps

Collect and Copy, 198–200
collections of VBA objects, 906–907
colon (:) structured reference range operator, 502
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color
accessibility features with, 109
background colors, 358–359
chart styles for, 674–675
chart text, selecting for, 683–684
Color command options, 404–405
color scales conditional formatting, 310
Colors dialog box, 359–360
fills. See fills
font Automatic color option, 353
gradients. See gradients, color
grayscale, printing as, 454
Gridline Color options, 109
number formatting, custom with, 339–341
pattern colors, 358
Recolor options, 405
saturation in graphic objects, 403, 404
schemes for Excel, 102
Shape Fill color palette, 407
Tab Color command, 160
themes, changing for, 771
themes Colors gallery, 301
unique colors, number available, 11
worksheet tabs, selecting individually, 109

columns
AutoFit Column Width command, 362
banding, 295
bracketed names in table formulas, 763–764
Column Differences option, 149
COLUMN function, 562, 1028
Default Width command, 362
deleting, 217–220
delimited text files, converting to, 821–824
designing, 129–130
elements of style for tables, 773
filtering, selecting specific for, 747
grouping, 280
hiding, 176, 365
inserting, 212–214
Keep Source Column Widths pasting option, 202
mapping XML elements to, 826–828
maximum number allowed, 11
multiple, auto setting widths, 364
nonadjacent, selecting, 142
Page Layout view, width adjustment in, 441
pasting widths only, 205
range of, 20
reference operators with specifiers, 502
selecting, 142–143, 214, 734
shortcut menu for, 212–213
sorting within, 738–743
structured reference specifiers for, 499, 501
titles, printing on every page, 452–453
ungrouping, 280
widening, double-click method, 154
width option of Format menu, 362
widths, dragging, 363

COM automation, RTD (real-time data) function, 1061
COMBIN function, 540, 1028

comma (,)
Comma Style button, 324, 329
as number separator, 151, 323
structured reference union operator, 502

comma delimited (CSV) format, 70
command groups

adding to custom tabs, 89–91
creating custom, 88–89

command modifiers, 86–87
commands

adding groups to custom tabs, 89–91
adding to Quick Access Toolbar, 93–96
groups in ribbon. See command groups; ribbon
hiding labels of, 89
keyboard. See keyboard commands
Quick Access Toolbar, 34
ribbon. See ribbon
shortcut menus for, 36–37

comments
Clear Comments command, 221
documentation, as, 133
Edit Comment button, 272, 273
finding, 241
icon indication of, 272
New Comment button, 272
pasting only, 205
printing, 274, 454
Review tab buttons for, 272–274
shared workbook comment indicators, 861
showing/hiding, 274
user names with, 272
VBA code, documenting with, 922–923
VBA syntax for, 903

Compare And Merge Workbooks command, 869–870
comparisons. See conditional tests
compatibility functions

BETADIST and BETAINV, 1025
CONFIDENCE, 1029
COVAR function, 9, 1030
CRITBINOM, 1026
defined, 8–9, 603
EXPONDIST, 1038
LOGNORMDIST, 1048
POISSON, 1057
RANK, 603, 606, 1059
STDEV functions, 603, 1063
TDIST, 1065
WEIBULL, 1069
ZTEST, 1070

Compatibility mode, 52–53, 732
Competitive Market Analysis (CMA), 612
complex numbers

COMPLEX function, 1028
IMABS function, 1043
IMAGINARY function, 1043
IMARGUMENT function, 1043
IMCONJUGATE, 1043
IMCOS function, 1043
IMEXP function, 1044
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complex numbers, continued
IMLN function, 1044
IMLOG functions, 1044
IMPOWER functions, 1044
IMPRODUCT function, 1044
IMREAL function, 1044
IMSIN function, 1044
IMSQRT function, 1044
IMSUB function, 1044
IMSUM function, 1044

compressing images, 411–412
computed criteria for searches, 759–761
concatenation

& operator for, 477–478
CONCATENATE function, 550–551, 1028
dates, of, 551

conditional breakpoints, 934–935, 936
conditional formatting

backward compatibility issues, 317
clearing, 318
color scales, 310
Conditional Formatting command, 309
copying, 205, 318
creating new rules, 315–316
data bars, 310, 313–314
A Date Occurring rule, 312
Duplicate Values rule, 312
finding and selecting formatted cells, 319
Format All Cells Based On Their Values rule type, 315
Format Only Cells That Contain rule type, 315–316
formulas with, 319–320
Highlight Cells Rules feature, 309–311
icon sets, 310
improvements in Excel 2010, 8
limit on number of conditions per cell, 11
managing rules, 316–319
MOD function with, 540
multiple regions with, 312–313
priority of rules, 317–318
Between rule, 312
selecting all cells with, 146
steps for applying, 310–311
Text That Contains rule, 312
Top/Bottom rules, 310, 312–313

conditional functions
AVERAGEIF(S) functions, 602, 1024
COUNTIF, COUNTIFS functions, 523–525, 1029
DAVERAGE function, 1033
DCOUNT function, 1033
DCOUNTA function, 1034
DGET, 1034
DSUM, 1036
AND function, 551–552, 1023
HYPGEOMDIST, 1043
IF function, 551, 552, 1043
IFERROR, 1043
OR function, 551–552, 1055
SUMIF, SUMIFS functions, 523–524, 551

conditional operators
custom number formats using, 341–342
table of, 522

Conditional Sum Wizard discontinued, 523
conditional tests

conditional functions, 523–525, 546
EXACT function, 546, 1038
lookup functions, 525–526
operators for, 522
results of, 523

CONFIDENCE compatibility function, 1029
confidence, statistical

CONFIDENCE.NORM function, 1028
CONFIDENCE.T function, 1029
Descriptive Statistics tool formula for, 619
error bars for charts, 725

conflict management for shared files, 861–863
connections. See data connections
connector shapes, 383–385
consolidating worksheets

adding worksheets for, 282
category, consolidating by, 284–286
Consolidate button, 280
functions available for, 281
links method of, 286–287
merging compared to, 871
methods available with, 281
position, consolidating by, 281–284
refreshing reference values, 283

constants
array, 512, 516–517
Go To dialog box, selecting with, 146
naming, 490– 491
types of, 149

constrained graphic objects, 376–377
constraint-based analysis. See Solver
context-sensitive tools, 33
contrast, image, 401–402
convergence scenario, 510
CONVERT function, 1029
copying. See also pasting

Across Worksheets command, 260–261
cells, 197–202
Clipboard, collecting multiple items on, 198–200
controlling for shared workbooks, 877
Copy As Picture command, 433–434
Copy button, 197
Ctrl+C shortcut, 198
dragging with a mouse, 211–212
embedding Word text, 954–956
fill handles, dragging, 221–222
Fill menu for, 234–236
Insert Copied Cells command, 215–216
linked workbook cells, 521–522
math operators, using, 206–207
Open As Copy option, 63
partial formulas, 225–226
Paste Special, Microsoft Word, 966–971
Paste Special options, 203–209
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pasting into multiple cells, 200–201
previews of pasting, 5–6
references, effects on, 472–476
Refreshable Web Query command, 855
right-mouse button drag options for, 223
Shift key with, 211–212
structured references, 504–505
Visible Cells Only option, 279
Web data to Excel, 855

copyright symbol, inserting, 156, 247
Corrections gallery, 401–402
CORREL (correlation coefficient) function, 1029
COS (cosine) function, 1029
COSH (hyperbolic cosine) function, 1029
COUNT function

defined, 1029
Microsoft Query totals with, 845–848
PivotTable value fields with, 800–801
purpose of, 603
table total rows, inserting in, 736–737

COUNT NUMBERS function, PivotTable, 800–801
COUNTA function

# structured-reference tags with, 768–769
defined, 604, 1029

COUNTBLANK function, 553, 1029
COUNTIF, COUNTIFS functions, 523–525, 539, 1029
COUP (coupon) functions, 595, 1030
covariance functions, 9, 1030
Create From Selection button, 489
CRITBINOM compatibility function, 1026
Criteria Equals button, Microsoft Query, 840–842
cropping images, 403, 412
CSV (comma delimited) file format, 70, 821
Ctrl+' (display formulas) shortcut, 105
Ctrl+Arrow keystrokes, 138
Ctrl+C (Copy), 198
Ctrl+Home, 24
Ctrl+L, 731
Ctrl+Page Down, 24
Ctrl+Shift+Enter, 513–515
Ctrl+Shift+Spacebar command, 143
Ctrl+Spacebar, 214
Ctrl+T command, 731–732
Ctrl+V (Paste), 198
Ctrl+X (Cut), 198
Ctrl+Y (Redo), 198, 224
Ctrl+Y (Repeat), 225
Ctrl+Z (Undo), 198
CUBE functions for OLAP, 1031–1032
CUMIPMT (cumulative interest paid) function, 1032
CUMPRINC (cumulative principal paid) function, 1032
curly braces ({}), 513–514
currency

$ character for, 322
accounting formats, 327–329
Currency format, 325–326
decimal point issues for certain currencies, 341
DOLLAR function, 545, 1035
DOLLARDE function, 1035

DOLLARFR function, 1035
Euro Currency Tools add-in, 596–599
EUROCONVERT function, 1037

Curve tool, 378–381
custom functions. See functions, custom
Custom Lists feature, 237–238
Customer Experience Improvement Program, 120
Customize Quick Access Toolbar button, 92, 95, 98
customizing the workspace

General category of Options, 102
Quick Access Toolbar customization, 92–102
ribbon customization, 83–91

cutting. See also pasting
Ctrl+X shortcut, 198
Cut button, 197
Insert Cut Cells command, 215–216
linked workbook cells, 522
Paste Special options, 203–209
rules of, 203

Cycle Through Totals button, 840, 845

D
Data Analysis tools

Analysis Toolpak, installing, 616–617
Data Analysis button, 616–617
Descriptive Statistics tool, 618–619
Histogram tool, 619–622
Moving Average tool, 631–633
Rank And Percentile tool, 623–625
Sampling tool, 630–631

Data And Model Cell Styles, 303
data bars conditional formatting, 310, 313–314
data connections

browsing for, 815
Connection Properties button, 817–818
Existing Connections command, 834–835
external content security options, 117–118
Import Data dialog box with, 816
manual refreshes, 819
Microsoft Query, creating with, 829
ODC (Office Data Connection) files, 815
opening connection files, 816
passwords for new, 829
passwords, refreshing, 819
PivotTable creation with, 816–817
refresh options, 817–819
security warning with, 817
types of, icons for, 816
Usage tab of Connection Properties box, 818
viewing existing, 815–816
Web queries, launching, 850

data entry
(### ...) number signs, 153
apostrophe (') prefixes, 155–156
AutoCorrect with text entry, 246–250
cell entry method, 149–150
commas (,), 151
constant types for, 149
copying partial formulas, 225–226
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data entry, continued
dates, 566–569
displayed vs. underlying values, 152–153
dollar sign ($), 151
E and e (exponents), 151, 1038
Edit mode, 157–159
error messages during, 156
floating option buttons with, 159
formula bar buttons, 150
keyboard shortcuts for, table of, 150
numeric text entries, 155–156
numeric value entry, 151
parentheses (), 151
percent sign (%), 152
Pick From Drop Down List command, 250
quotation mark (") text alignment character, 155–156
ranges of cells, within, 157
redoing, 158
scientific notation, conversion to, 152–153
series entry. See data series
special character guidelines, 151–152
Special Characters tab with, 156–157
symbol entry, 156–157
text alignment prefix characters, 155–156
text value entry, 151
undoing, 158–159

data labels on charts, 716–717
data series

assignment to secondary chart axes, 717–718
Columns option, 235
dates and times, 231, 233, 568–570
decreasing series, 229–230
double-clicking to extend, 232
Fill Series option of Auto Fill, 229–230
Growth option, 235
Growth Trend command, 233–234
interval specification, 231–232, 235
limited to 255 characters, 231
Linear option, 235
Linear Trend command, 233–234
Rows option, 235
Series command, 234–235, 568–569
step and stop values, 235
text with numbers, 231

Data tab
Auto Outline command, 274–276
Consolidate button, 280. See also consolidating worksheets
Data Analysis button, 616
Edit Links command, 960–961
Existing Connections command, 834–835, 850
Group button, 280
From Microsoft Query command, 829, 835
Remove Duplicates command, 762–763
Sort & Filter group, 738–739, 749
From Text command, 820–821
Ungroup button, 280
From Web command, 852–854
From XML Data Import command, 826

Data Table what-if analysis
Automatic Except For Data Tables calculation option, 506
editing tables, 640–641
input cells, 637, 640
one-variable, multiple-formula tables, 638
one-variable, one-formula tables, 635–638
placeholder cells, 636–637
results ranges, 637
TABLE function, 637, 641
two-variable tables, 638–640

#Data tag, 768–769
Data Tools group, Remove Duplicates command, 762–763
databases

dBase queries, 829
importing data to spreadsheets from, 134–135
Microsoft Access. See Access databases
SQL Server, 874
terminology for, 135

dates
1904 Apple alternative system, 68, 566
Auto Fill series, 233
calculations with, 574–575
codes, formatting, 572–573
concatenation of, 551
current, shortcut for entering, 567
custom formats for, 571–573
date category axes of charts, 712–715
DATE function, 1033
A Date Occurring conditional formatting rule, 312
DATEVALUE function, 516, 577, 1033
DAY function, 577, 1033
DAYS360 function, 1033
EDATE function, 578, 1036
elapsed time, measuring, 573–574
EMONTH function, 578
entering, 566–569
EOMONTH function, 1037
filtering, 750–751
formats for entering, 566
formatting, 570–571
functions, 574–580
headers and footers, inserting in, 446
Macintosh date system, 68, 566
macro for inserting current, 901
MONTH function, 577, 1051
negative results of calculations, 574
NETWORKDAY functions, 579–580, 1052
NOW function, 576, 901, 1053
PivotTable grouping by, 809–810
regional settings for, 566
serial date values in formulas, 516, 1033
serial values of, 565
series creation, 231, 568–570
slash (/), data entries with, 152
sort order of, 745, 746
TODAY function, 576, 1066
two-digit year entry issues, 567
WEEKDAY function, 576–577, 1068
WORKDAY functions, 579–580, 1069
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YEAR function, 577, 1069
YEARFRAC function, 578–579, 1069

DAVERAGE function, 1033
DAY function, 577, 1033
days of the week, sort order for, 746
DAYS360 function, 1033
DB (declining balance) function, 589, 1033
dBase queries, selecting as a source type, 829
DCOUNT function, 1033
DCOUNTA function, 1034
DDB (double-declining balance) function, 589, 1034
death, planning for, 133
debugging formulas, 149. See also auditing
debugging macros and custom functions

Assert method of Debug, 934–935
Auto Syntax Check option, setting, 930–931
break mode, 930–931, 937
breakpoints, setting, 933–935
conditional breakpoints, 934–935, 936
Debug.Print statements, 936–937
Err object Number property, 939–940
On Error GoTo statements, 938–940
Immediate Window, 936–937
Quick Watch, 936
requiring variable declarations, 931–932
Run To Cursor command, 933
run-time error fixes, 937–940
stepping through code, 932–933
syntax errors, prompts at, 930–931
Watch Window feature, 935–936

DEC2BIN (decimal to binary) function, 1034
DEC2HEX (decimal to hexadecimal) function, 1034
DEC2OCT (decimal to octal) function, 1034
decimal numbers

BIN2DEC (binary to decimal) function, 1025
DEC2 (decimal to) functions, 1034
HEX2DEC function, 1042
OCT2DEC function, 1054

decimal points
Automatically Insert A Decimal Point option, 139, 227
currency formats, lining up for, 341
decimal places, setting number to display, 324–325
Decrease Decimal command, 327
FIXED function, 1039
fixed vs. floating, 229
Increase Decimal command, 327
maximum number of decimal places, 327
ROUND functions, 531, 542, 921, 1061
ROUNDDOWN function, 542, 1061
scientific notation formatting, 332
TRUNC (truncate decimals) function, 543, 1067

declining balance (DB) function, 589
Decrease Decimal command, 327
Default Width command, 362
Define Name button, 485, 488, 490–491
DEGREES function, 1034
deleting

clearing cells, 220–221
Delete menu, 217

files, 62
fill handles, dragging, 221–222
formula errors caused by, 218–220
names, 486
worksheets, 161

delimited files, 820–823
DELTA function, 1034
dependent cells

definition of, 268
selection, 148

depreciation
AMORDEGRC (amortization) functions, 1023
arguments for, 588
DB (declining balance) function, 589, 1033
DDB (double-declining balance) function, 589, 1034
SLN (straight line) function, 589, 1062
SYD (sum of years’ digits depreciation), 590, 1065
VDB (variable declining balances) function, 590, 1068

depth axes, 716
Descriptive Statistics tool, 618–619
Design tabs

Chart, 672
PivotTable Tools, 786–787
Sparkline, 692
Table Tools. See Table Tools Design tab

designing worksheets
audiences, considerations for, 132–133
comments, adding, 133
documentation of designs, 133–134
expansion, allowing for, 135–136
hierarchical designs, 135
imported data, reliance on, 134
modular designs, 135
presentation issues, 131–133
printing, designing for, 131–132
row or column choice for data, 129–130
summary sheets, 131–133
survivability of worksheet designs, 133

determinants, MDETERM function, 1049
developers, definition of reputable, 111–112
deviations

AVEDEV (average of absolute deviations) function, 1024
DEVSQ function, 1034
standard. See standard deviation

DGET function, 1034
diagnostic file options, 120
Dialog Box Launchers, 29–30
dialog boxes, custom, 922
DIF file format, 71
differences of squares, SUMX2MY2, 1064
digital signatures, 121–125
DISC (discount rate) function, 594, 1035
DISCOUNT example custom function, 918–923
discount rate (INTRATE) function, 593, 1045
discrete distributions, 629
Display area of Advanced options, 104–107, 187
Distribute (objects) Horizontally/Vertically command, 429
Distributed (Indent) option, 344–345
distributed vertical text alignment, 347
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distributions. See also probability
analyzing. See statistics
Bernoulli distributions, 628
BETA.DIST function, 1025
binomial distributions, 628, 1026
error (ERF) functions, 1037
EXPON.DIST function, 1038
F.DIST functions, 1038
F.INV functions, 1039
GAMMA functions, 1041
generating. See Random Number Generation tool
HYPGEOM.DIST function, 1043
LOGNORM functions, 1048
MULTINOMIAL function, 1052
NEGBINOM.DIST, 1052
NORM.DIST function, 1052
NORM.INV function, 1053
NORM.S.DIST function, 1053
NORM.S.INV function, 1053
POISSON.DIST function, 1057
Random Number Generation tool, 627–630
SKEW function, 1062
STANDARDIZE function, 1063
Student’s t-distribution, 1029, 1065, 1066, 1067
T.DIST (Student’s t-distribution) functions, 1065
T.INV (inverse Student’s t-distribution) functions, 1066
T.TEST (Student’s t-test), 1067
WEIBULL.DIST function, 1069
Z.TEST function, 1070

divergence scenario, 510
division

division sign (/), 467–468
GCD (greatest common divisor) function, 1041
IMDIV function, 1043
MOD function, 540–541, 1051
QUOTIENT function, 1059

DMAX function, 1035
DMIN function, 1035
Document Inspector, 121–122
Document Properties, adding summary information, 58–59
documentation

of macros and custom functions, 922–923
of worksheet designs, 133–134

documents
Inspect Document command, 121–122
Trusted Documents list, 114
Word. See Word documents

DOLLAR function, 545, 1035
dollar sign ($)

$ button, Home tab, 326
absolute references, signifying, 470
currency character, 322
data entry with, 151

DOLLARDE, DOLLARFR functions, 592, 1035
double declining balance (DDB) function, 589
DQY files, 833–834, 849
draft versions feature, 79–81
dragging

cells and ranges, 211–212

fill handles, 221–222
right mouse button, with the, 223

drawing. See shapes
Drawing Tools Format tab, 375, 387–388, 407–408
drop-down lists for ribbon, 28–29, 87
DSTDEV, DSTDEVP (standard deviation) functions, 1036
DSUM functions, 1036
DURATION function, 596, 1036
DVAR, DVARP functions, 1036

E
e (mathematical constant)

EXP function, 1038
IMEXP function, 1044
LN (natural log) function, 1048

E or e (exponent characters), 151, 332
EDATE function, 578, 1036
Edit controls, 87
Edit In 2-D button, SmartArt, 408
Edit Links command, 520–521, 960–961
Edit mode, 157–159
Edit Shapes command, 379
editing. See also copying; cutting; pasting

After Pressing Enter, Move Selection option, 227
Allow Editing Directly In Cells option, 228
arrays, 514
AutoCorrect with text entry, 246–250
Automatically Insert A Decimal Point option, 227
in cells vs. in formula bar, 225–226
copying cells, 197–202
disabling in-cell editing, 226
Edit mode, 157–159
Enable AutoComplete For Cell Values option, 228
errors introduced by, 135–136
floating option buttons with, 159
formulas, 476
grouping worksheets for, 255–260
options for dragging, 211
Overtype mode, 139
Pick From Drop Down List command, 250
protection from, 170–171
redoing, 158–159
spelling, checking, 251–252
undoing, 158–159

Editing group of Home tab
Clear menu, 220–221
Find & Select commands. See Find & Select menu
Sort & Filter menu. See filtering; sorting

editing in place, 956
Effects gallery for themes, 301
ellipsis (...)

commands, additional, 30
entering as data, 156–157

Else statements, VBA, 920
em dashes, 156–157
e-mail

hyperlinks to addresses for, 949
launching with hyperlinks, 944
mail-merging Excel data into Word for, 976–979
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sharing workbooks by, 872–874
embedding

bounding rectangle, hiding, 956
defined, 953
display options for, 953–954
document types available for, 959
editing with creating application, 397–399, 956
EMBED formulas, 954–955
Excel objects in Word documents, 966–967, 971–972
file size issues, 954
files, creating objects from, 959–960
formatting embedded objects, 420–421
graphic objects with Object button, 397–399
icons for, 953–954, 958
links compared to, 953–954
new object creation with Object command, 958–959
No Line option, 956
Object command for, 958–960
Paste command, embedded defaults for, 957
resizing embedded table objects, 972
static pasting compared to, 954–956
transparency for, 956
Windows Packager, 959–960
Word documents, viewing full, 954

EMONTH function, 578
empty cells

counting, 553–554
ISBLANK function, 553–554, 1046
plotting in charts, 721

Enable All Macros option, 897
Enable Automatic Percent Entry option, 228
Enable Live Preview option, 102
encrypting workbooks, 191–192
End Function statements, VBA, 917–918
End If statements, VBA, 920
End key, 140
End mode, 139
END SUB statements, VBA, 903, 912–913
Enhanced Metafile (Picture) format, 968
Enter mode, 469
entering data. See data entry
envelopes, mail-merging Excel data into Word for, 976–979
EOMONTH function, 1037
equal sign (=)

as conditional operator, 522
formulas, leading entry for, 467

Equation Editor
embedding or linking with, 959
Excel Web App issues with, 892
improved in Excel 2010, 9

ERF (error) functions, 1037
error bars for charts, 725
Error Checking dialog box, 261
error handling code, VBA, 938–940
errors

# (hash mark) error value indicator, 479
circular references, 508–511
coloring cells containing, 320
compatibility messages, 52–53

Err object Number property, 939–940
Error Checking dialog box, 261–263
On Error GoTo statements, 938–940
error trapping for custom functions, 924–925
ERROR.TYPE function, 553, 1037
Evaluate Formula dialog box, 263–265
IFERROR function, 1043
ISERR, ISERROR functions, 554, 1046
ISNA function, 554, 1046
NA function, 1052
printing options for codes, 454
Resume statements, 939–940
text entry. See AutoCorrect
tracing references, 267–272
#VALUE! errors from custom functions, 922–923
values of, 479
VBA run-time error messages, 930–931
VBA run-time, fixing, 937–940
Watch Window feature, 265–267

Euro Currency Tools add-in, 596–599
EUROCONVERT function, 1037
Evaluate Formula dialog box, 263
EVEN function, 542, 1038
even numbers, ISEVEN function, 554, 1046
EXACT function, 546, 1038
Excel 2003

file formats, legacy, 55
menu to ribbon command reference, 983–999
new features, 15

Excel 2007
discontinued features, 13–15
new features, 10–13, 729–731

Excel Options dialog box. See Options dialog box, Excel
Excel Web App, 887–892
Existing Connections command, 834–835, 850
Exit Function statements, 924
EXP function, 1038
expansion of worksheets, allowing for, 135–136
explicit intersections, 496
exploits, 116
EXPON.DIST function, 1038
exponential regression

defined, 607
equations for, 615
GROWTH function, 616, 1041
LOGEST function, 616, 1048

exponents
data entry of, 151
E or e characters representing, 332

exporting
help documentation for, 66
Internet Explorer data to Excel, 855
Macintosh computer files, 67–68
PDF, to, 462–464
Quick Access Toolbar, 99
ribbon, custom, 91–92
Save As command for, 67
text files, 70
XPS, to, 462–464
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expressions as arguments of functions, 531
Extend Data Range Formats And Formulas option, 228, 238
Extended Selection mode, 138
extensions, file name, 50–51
external content security options, 117–118
external data

Access, selecting as a source type for, 829
aggregation calculations with, 845–848
data connections with. See data connections
dBase, selecting as a source type for, 829
design considerations for worksheets, 134–135
fields, editing, 837–838
Internet Explorer, exporting data to Excel, 855
OLAP, selecting as a source type for, 829
opening an entire Access table in Excel, 819–820
refresh options, 817–819
result sets, 836
text files as data, 820–824
Web data, importing. See Web queries
XML data, importing, 825–829

Extract Data command, 65
Extract, ranges named, 762
extrapolation, linear, 613–614

F
F probability distribution functions, 1038, 1039, 1040
F1 (help) command, 28
F4 keyboard shortcut, 242, 470
F9 key (partial formula calculation), 508
FACT (factorial) function, 1038
FACTDOUBLE function, 1038
FALSE function, 1038
FALSE logical value, 523, 550
feedback for accessibility, 108
Field Settings dialog box, PivotTable, 790
fields, database, 135
File menu commands. See File tab
File tab. See also Backstage view

Backstage view, 41–42
Check Compatibility command, 52–53
Check For Issues, 121–122
digital signature commands, 123–124
Office Button, replacement of, 4
Open, Access Databases command, 820
Open command, 61–62, 859
Options dialog box, opening, 31. See also Options dialog 

box, Excel
Save As command, 859
Save To Web command, 881
Send Using E-Mail command, 872–873
summary information, steps for adding, 58–59

files
access control for. See IRM (Information Rights 

Management)
allowing changes by multiple simultaneous users, 861–863, 

870
backup files, automatic generation setting, 56–57
backward compatibility, ensuring, 52–54

case, failure to distinguish for names, 50
conflict management, 861–863
deleting, 62
delimited vs. fixed-width, 820
digital signatures for, 121–125
extensions, showing, 369
File In Use dialog box, 859–860
File Now Available dialog box, 860
file type block settings, 118
format attacks, 121
format validation options, 120–121
formats, discontinued Excel, 14
formats for saving, specifying, 51
formats, XL, 54–55
Lotus 1-2-3 formats, 14–15
name extensions, 50–51
naming, 50
opening, 61–64
password protection of, 57–58
Protected View option, opening in, 63
read-only, opening files as, 63
recovering corrupted, 64–66
remote, saving and opening, 859
saving, 49–50
Show Previous Versions option, 64–65
showing hidden, 369
space required for, 50
specifying default format for, 56
startup, opening files on, 64
storing on the Internet. See SkyDrive, Windows Live
summary information, adding to, 58–59

fill handles
chart data, dragging to change, 719
Ctrl key, effects on copying, 231
date series creation, 568–570
dragging with, 221–222
enabling, 138
Fill Series option, 229–231
making visible, 222
right mouse button options, 233–234

Fill menu
Across Worksheets command, 236, 260–261
direction commands in, 235–236
Justify command, 236–237
Series command, 234–235

filling cells with characters, 345–346
fills

background colors, 358–359
Cell Style attribute for formatting, 305
chart item area options, 701–705
Colors dialog box, 359–360
effects, 359–360
Fill Color button, 357
Fill tab of Format Cells, 357–358
Format Picture dialog box control of, 403
Gradient Fill option, 412–413
gradient fills. See gradients, color
No Fill option for charts, 702
patterns, 358
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Picture or Texture Fill option, 414
Shape Fill color palette, 407, 413
Text Effects menu for, 388

filtering
Advanced Filter command, 752–762
alphabetical ranges of text values, 752
automatic addition to header row, 747
blank entry row selection, 750
blank rows in criteria ranges, effect of, 757
computed criteria for, 759–761
Copy To ranges, 761–762
Criteria, auto naming of ranges as, 757
custom filters, 751–752
data type column specialized functions, 751
dates, 750–751
defined, 747
duplicate elimination, 762–763
external data when importing, 831–832
extracting filtered rows, 761–762
extracting rows to separate worksheets, 753
header row requirement, 747
listing unique column values, 747
multiple column filtering, 749
multiple criteria on single columns, 758–759
Number filters, 749–751
number of rows matching criteria, displaying, 748–749
AND operator, 756
OR option, 751–758
OR with AND example, 758
PivotTable fields. See filtering PivotTables
query result sets, 840–844
range specification, 753
ranges, between, 751
references for computed criteria, 759–761
referencing all rows in a column, 761
relational operators with, 751–752
removing filters, 749
selecting criteria for, 748
shared workbooks settings for, 864
Simple vs. Advanced method, 747
slicers for, 7–8
SUBTOTAL function with, 748–749
tables, 729, 756
Text filters, 751
three ORs on one column, 757
top or bottom n items, 749–750, 799–800
two columns joined by OR, 753–757
Unique Records Only option, 762
wildcard comparisons, 751–752

filtering PivotTables
during creation, 780
external data sources, filtering before table creation, 

796–800
Field List window for, 796–800
Report Filter Axis for, 793–794
slicers for, 794–796
Top 10 Filter dialog box, 799–800
Value Filters options, 799

financial functions
ACCRINT, ACCRINTM functions, 592–593
AMORDEGRC function, 1022
arguments for, 581–582, 588
COUP (coupon) functions, 595, 1030
CUMIPMT function, 1032
CUMPRINC (cumulative principal paid) function, 1032
DB (declining balance) function, 589, 1033
DDB (double-declining balance) function, 589, 1034
depreciation, functions for calculating, 588–590
DISC (discount rate) function, 594, 1035
DOLLARDE, DOLLARFR functions, 592, 1035
DURATION function, 596, 1036
Financial drop-down list, 581–582
FV (future value) function, 584, 1040
FVSCHEDULE function, 1040
INTRATE function, 593, 1045
investment functions, 581–588
IPMT (interest payments) function, 585, 1046
IRR (internal rate of return) function, 587–588, 1046
ISPMT (interest paid) function, 1047
MDURATION function, 596, 1050
MIRR (modified internal rate of return) function, 588, 1051
NOMINAL function, 1052
NPER (number of periods) function, 586, 1053
NPV (net present value) function, 583–584, 1053
ODDFPRICE function, 1054
PMT (payments) function, 584–585, 636, 1056
PPMT (principal payments) function, 586, 1057
PRICE functions, 593, 1057–1058
PV (present value) function, 582–583, 1058
RATE function, 586–587, 1059
RECEIVED function, 593, 1060
securities analysis. See securities analysis functions
SLN (straight-line depreciation) function, 589, 1062
SYD function, 590, 1065
TBILL functions, 594–595, 1065
VDB (variable declining balance) function, 590, 1068
XIRR (internal rate of return, nonperiodic) function, 1069
XNPV (net present value, nonperiodic) function, 1069
YIELD functions, 594, 1070

financial tools
Goal Seek tool, 652–655
Moving Average tool, 631–633
Scenario Manager, 641–652
Solver, 655–666
what-if analysis. See what-if analysis tools

Find & Select menu
Find command, 240
Formulas command, 144
Go To command. See Go To dialog box
Go To Special command, 319
opening, 144

Find command
buttons for, 240
maximum number of items returned by, 11

FIND function, 547, 1039
FINDB function, 548, 1039
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finding
cells, Go To for. See Go To dialog box
conditionally formatted cells, 319
Within drop-down list, 240
Find And Replace dialog box, 240
Find command, 240
Find What box, 240
formatting, 242–244
Look In drop-down list, 241
Match Case option, 240
Match Entire Cell Contents option, 240
replacing found items, 244–246
Search drop-down list, 240–241
underlying vs. displayed values, 241
Visible Cells Only option, 279
wildcard characters for, 244

FISHER functions, 1039
Fixed Decimal mode, 139
FIXED function, 1039
fixed-width files, 820–823
floating workbooks, 22
FLOOR function, 542–543, 1040
folders, showing hidden, 369
fonts

Automatic color option, 353
Body fonts in tables, 771
chart text, selecting for, 683–684
default, 2010 vs. 2003, 302
display font, 107
Font group buttons, 351
Font tab of Format Cells, 351–352
formatting, Cell Style attribute for, 305
Heading font, 771–772
live preview functionality, 30–32
point sizes, 352
selecting options for new workbooks, 107
Shrink To Fit option, 350–351
table, customizing, 774
themes, Fonts gallery, 301

footers, 442, 444–450
For . . . Next statements, VBA, 907
FORECAST function, 615, 1040
Format Cells dialog box

Alignment tab. See alignment
Border tab, 354
Cell Styles, using with, 305–306
custom number formats with, 333–342
date and time formats, 570–571
displaying, 30
Fill tab, 357–358
Hidden option, 176

Format menu
Hidden option in Format Cells box, 176
Lock Cell command, 171–172

Format Picture dialog box, 401–404
Format Shape dialog box

3-D formatting options, 415–417
Alt Text tab, 427
capabilities of, 412

Format Picture, twin of, 402
Gradient Fill option, 412–413
Keep Text Flat in 3-D graphics option, 417
Line options, 414
Locked option, 429
Object Positioning options, 425–426
Picture or Texture Fill option, 414
Print Object option, 426
Shadows options, 414–415
Size tab, 426
Stretch options, 414
Text Box controls, 418–420
Tile Picture As Texture option, 414

formats, file
DIF format, 71
legacy Excel formats, 71
PDF format, 71
specifying, 51, 54
specifying default, 56
SYLK format, 71
text files, 70
validation of, 120–121
Web formats, 69
XL formats, 54–55
XLK backup file format, 56–57
XML, 55
XPS format, 71

formatting
% (percent sign), 323
/ (slash), 323
$ currency character, 322
accounting formats, 327–329, 542
advantages of, 289–290
alignment in cells. See alignment
CELL function, 1026
chart items. See formatting charts
Clear Formats command, 221
clearing, 299
currency formats, 325–326
dates, 570–571
default format for cells, 323–324
display values vs. underlying values, 321
elements of style for tables, 773
embedded objects, 420–421
Excel 2007 improvements in, 10
Extend Data Range Formats And Formulas option, 238
extending existing, 238–239
eyedroppers, 243
filling cells with characters, 345–346
finding, 242–244
floating Insert Options button, 213
Format Cells dialog box, launching, 290, 321
formulas, 497
fractions, 331–332
fundamentals, 290–291
General format, 323–324
graphics. See formatting graphics
Home tab formatting commands, 290–291
individual characters, 321–322
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justifying text, 346
locale formats, 333
numbers. See numbers, formatting
pasting without content, 202
percentages, 330
phone number format, 333
rules of, basic, 291
slicers, 796
Social Security number formatting, 333
Special formats, 332–333
special formatting characters, entering, 322–323
tables. See formatting tables
tables with themes, 771–772
templates, saving in, 368–369
text in graphics, 409–411
themes for. See themes
times, 570–571
when to format, 291
wrapping text, 346
ZIP code formats, 332

formatting charts
3-D axis options, 716
axes options, 699–700
axis label overlapping options, 711
axis scaling factor options, 707–716
background areas of chart items, 701–705
color selection, 699–700
data label options, 716–717
date category axes, 712–715
fill options, 701–705
Format Data Labels options, 716–717
Format Plot Area dialog box, 701
gradient fills, 702–704
Gradient Line option, 699–700
gridline spacing, 708, 710
image fills, 704–705
Line Style options, 700
No Fill option, 702
Solid Line option, 700
text options, 683–684, 705
texture fills, 704–705
tick marks specification, 708
transparency options, 699
trendline options, 699–700

formatting graphics
3-D formatting options, 403, 415–417
Adjust group, Picture Tools Format tab, 401–402
advanced formatting effects, 401–404. See also Format 

Shape dialog box
Artistic Effects menu, 403, 406
brightness, adjusting, 401–402
chart graphics. See formatting charts
Color command options, 404–405
color correction, 403–405
contrast, adjusting, 401–402
Corrections gallery, 401–402
cropping images, 403, 412
Distribute (objects) Horizontally/Vertically command, 429
fill control, 403

hidden tabs for, 400
Picture Tools Format tab, 400
shadows in graphic objects, 403
Shape formatting controls, 407
sharpening, 401–402
sizing images, 404
sizing shapes, 426
text formatting, 409–411
transparency, 405–406

formatting tables
Apply options, 296
automatic row and column banding, 294
Banded options, 295
boundaries for tables, 294
converting to ranges, 298–299
default Quick Style, setting a custom format as, 297–298
Duplicate option, 296
elements, formatting by, 297–298
enlarging tables, 296
Format As Table command, 292–295
gallery, Format As Table, 292, 294
headers, including, 293, 294–295
inserting or deleting rows, accommodation of, 296
New Table Style command, 297–298
preview process, 294
Quick Style dialog boxes, 296–297
summary function selection for, 295
Table Style Light 4, 294
Table Tools Design tab, 294–295
Total Row option, 295

Formula Auditing group
cell tracer buttons, 267
Evaluate Formula button, 263
location of, 261
Trace Dependents command, 148
Trace Precedents command, 148
Watch Window button, 265

Formula AutoComplete feature, 482, 492, 503–504
formula bar

{ } (curly braces) in, 513–514
buttons in, 150
editing in, 225–226
entering formulas in, 150
Expand Formula Bar button, 497
frequently used functions drop down list, 150
hiding, 38
Insert Function button, 37–38
long formula display, 38–39
Name box name assignment, 483–484
Name box reference to active cells, 25, 37
split handles, 37–38
undoing actions in, 224

formulas
@ structured reference tag for current row, 767–768
{ } (curly braces), 513–514
3-D references in, 496–497
#All tag, 768–769
arguments of, 263
array, 512–516



1090	 Formulas command

formulas, continued
array constants, using in, 516–517
auto naming of references in tables, 763
autocompletion feature, 482, 492, 503–504
bracketed names in, 763–764
calculating. See calculation
characters, maximum number in, 11
circular reference issues, 508–511
conditional formatting, for, 319–320
conditional tests in, 522–526
copying, effects on references, 472–476
copying without formatting, 204, 205
custom functions, entering in, 919. See also functions, 

custom
#Data tag, 768–769
deleting cells referred to by, 218
dependent cell selection, 148
dependent workbook, updating, 519
editing, 476
EMBED formulas, 954–955
Enter mode, 469
equal sign (=) required, 467
Error Checking dialog box, 261–263
error values of, 479
Evaluate Formula dialog box, 263–265
explicitly referencing current table rows, 767–768
Extend Data Range Formats And Formulas option, 228, 238
finding, 241
fixing after row and column changes, 219
formatting for, 497
functions in, 479. See also functions
#Headers tag, 768–769
hiding cells with, 176
hyperlink construction with, 950–951
implicit intersection of references, 765–767
inserting functions in, 533–535
intersections, 496
iterative calculations, enabling, 510–511
line breaks in, 497
meaning of, interpreting, 763
names, using in, 483–484, 492–493. See also named cells 

and ranges
naming, 490– 491
natural-language formulas feature discontinued, 499
nesting, defined, 263
nesting levels, maximum number of, 11
NLFs (Natural Language formulas) discontinued, 14
numeric text in, 477
partial formula calculations, 508
PivotTable calculated items and fields, in, 805–806
precedence of operators, 467–468
precedent cell selection, 148
range finders for references, 226
references to other cells, 468–472. See also references
referencing table total rows, 766–767
relative references in named formulas, 491
replication in columns added to tables, 730
row selection, implicit, 765
Show Formulas In Cells option, 105–106

sorting issues, 743–744
structured references in. See structured references
table names in, 733
tables, auto copying to columns, 763–764
text values in, 477–478
#Totals tag, 768–769
tracing references, 267–272
Use Table Names In Formulas option, 499
Watch Window feature, 265–267

Formulas command, 144
Formulas tab

Apply Names command, 494–495
AutoSum button, 480–481, 538
Calculation Options button, 506–507
Create From Selection button, 489
Define Name button, 485, 488, 490–491
Error Checking button, 509
Formula Auditing. See Formula Auditing group
Function Library group, 534–535
Insert Function button, 481
Text button, 544
Use In Formula button, 492

fractions
/ (slash) in data entries, 152
formatting, 331–332
securities, fractional pricing of, 592, 1035

Freeform tool, 378–381
freezing panes, 166–167
FREQUENCY function, 622–623, 1040
frequency, histogram, 619–622
FTP (File Transfer Protocol), 859
Function Arguments dialog box, 528–529
functions

ABS (absolute value), 1022
accessing from VBA, 921
ACCRINT, ACCRINTM, 592–593, 1021
ACOSH (inverse hyperbolic cosine), 1022
ADDRESS, 559, 1022
AMORDEGRC function, 1022
AREAS reference function, 563, 1023
arguments of. See arguments of functions
ASC, 1023
ASIN (arcsine), 1023
ASINH (inverse hyperbolic sine), 1023
ATAN (arctangent), 1023
ATAN2 (arctangent), 1023
ATANH (inverse hyperbolic tangent), 1024
AutoComplete lists of, 479, 530
AVEDEV (average of absolute deviations), 1024
AVERAGE, AVERAGEA functions, 544, 602, 800–801, 1024
AVERAGEIF(S) functions, 602, 1024
BAHTTEXT, 1024
BESSEL functions, 1024–1025
BETA.DIST, 1025
BETA.INV, 1025
BIN2DEC (binary to decimal), 1025
BIN2HEX (binary to hexadecimal), 1025
BIN2OCT (binary to octal), 1025
BINOM (binomial distribution) functions, 628, 1026
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categories for function, maximum number of, 12
categories of, 534
CEILING, 542–543, 1026
CELL, 1026
CHISQ (chi-squared distribution) functions, 1027
CHOOSE, 559, 1027
CLEAN, 544, 546, 1027
CODE, 545–546, 1028
COLUMN, 562, 1028
COMBIN, 540, 1028
compatibility functions, 8–9
COMPLEX (number) function, 1028
CONCATENATE, 550–551, 1028
CONFIDENCE.NORM, 1028
CONFIDENCE.T, 1029
CONVERT, 1029
CORREL (correlation coefficient), 1029
COS (cosine), 1029
COSH (hyperbolic cosine), 1029
COUNT, COUNTIF functions, 603, 736–737, 800–801, 

845–848, 1029
COUP (coupon) functions, 595, 1030
COVARIANCE functions, 9, 1030
CUBE functions for OLAP, 1031–1032
CUMIPMT (cumulative interest paid), 1032
custom. See functions, custom
DATE, 1033
date and time, 574–580
DATEVALUE, 1033
DAVERAGE function, 1033
DB (declining balance), 1033
DCOUNT, 1033
DCOUNTA, 1034
DDB (double-declining balance), 1034
DEC2BIN (decimal to binary), 1034
DEC2HEX (decimal to hexadecimal), 1034
DEC2OCT (decimal to octal), 1034
DEGREES, 1034
DELTA, 1034
depreciation, functions for calculating, 588–590
DEVSQ, 1034
DGET, 1034
DISC (discount rate) function, 594, 1035
DMAX, 1035
DMIN, 1035
DOLLAR, 545, 1035
DOLLARDE, DOLLARFR, 592, 1035
DSTDEV, DSTDEVP, 1036
DSUM, 1036
DURATION, 596, 1036
DVAR, DVARP, 1036
EDATE, 578, 1036
EOMONTH, 1037
error (ERF) functions, 1037
ERROR.TYPE, 553, 1037
EUROCONVERT, 1037
EVEN, 542, 1038
EXACT function, 546, 1038
EXP, 1038

EXPON.DIST, 1038
F probability functions, 1038, 1039, 1040
FACT (factorial), 1038
FALSE function, 1038
financial. See financial functions
FIND, 547, 1039
FISHER, FISHERINV, 1039
FIXED, 1039
FLOOR, 542–543, 1040
FORECAST, 615, 1040
Formula AutoComplete feature, 482
FREQUENCY, 622–623, 1040
frequently used functions formula bar drop-down list, 150
AND function, 551–552, 1023
Function Library group, 534–535
FV (future value), 584, 1040
FVSCHEDULE, 1040
GAMMA, 1041
GCD (greatest common divisor), 1041
GEOMEAN, 1041
GESTEP, 1041
GETPIVOTDATA, 1041
GROWTH, 616, 1041
HARMEAN (harmonic mean), 1041
help for, 527–528
HEX2 functions, 1042
HLOOKUP, 555–557, 1042
HYPERLINK, 950–951, 1042
HYPGEOM.DIST, 1043
IF function, 551, 552, 1043
IFERROR, 1043
IM (imaginary number) functions, 1043–1044
IMABS, 1043
IMAGINARY, 1043
IMARGUMENT, 1043
IMCONJUGATE, 1043
IMCOS, 1043
IMDIV, 1043
INDEX, 525–526, 560–562, 1045
INDIRECT, 562, 1045
INFO, 1045
information functions, 553–554
inserting, 533–535
INT, 543, 1045
INTERCEPT, 1045
INTRATE, 593, 1045
investment. See investment functions
IPMT (interest payments), 585, 1046
IRR (internal rate of return), 587–588, 1046
IS functions, 554–555, 1046–1047
ISBLANK, 553–554, 1046
ISERR, 553–554, 1046
ISEVEN, 554, 1046
ISPMT (interest paid), 1047
JIS, 1047
KURT (kurtosis), 619, 1047
LARGE, 606, 1047
LCM (least common multiple), 1047
LEFT, 548–549, 1047
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functions, continued
LEN, LENB, 545, 1048
LINEST, 610–612, 1048
LN (natural log), 1048
LOG (logarithm), 1048
LOGEST, 616, 1048
logical. See logical functions
LOGNORM functions, 1048
LOOKUP, 555–556, 558, 1049
lookup functions. See lookup and reference functions
LOWER, 544, 547, 1049
MATCH, 525–526, 530, 559–560, 1049
math. See mathematical functions
MAX, 603, 606, 800–801, 845–848, 1049
MDETERM, 1049
MDURATION, 596, 1050
MEDIAN, 603–606, 619, 760–761, 1050
MIN, 603, 606, 800–801, 845–848, 1050
MINUTE, 577, 1050
MINVERSE, 1051
MIRR (modified internal rate of return), 588, 1051
MOD, 540–541, 1051
MODE functions, 603, 619, 1051
MROUND, 543, 1051
MULTINOMIAL, 1052
NA, 1052
#NAME? errors, 535
name part of, 531
NEGBINOM.DIST, 1052
NETWORKDAY functions, 579–580, 1052
new in Excel 2010, 8–9
NOMINAL, 1052
NORM (normal distribution) functions, 1052–1053
NOT function, 551–552, 1053
NOW, 576, 901, 1053
NPER (number of periods to amortize), 586, 1053
NPV (net present value), 583–584, 1053
OCT2 functions, 1054
ODD, 542, 1054
odd period security functions, 1054–1055
OFFSET, 1055
PERCENTILE functions, 604–606, 1054–1055
PERMUT (permutations), 1056
PHONETIC, 1056
PI, 1056
PivotTable value field summary functions, 801
PMT (payments), 584–585, 636, 1056
POISSON.DIST, 1057
POWER, 1057
PPMT (principal component of payments), 586, 1057
PRICE functions, 593, 1057–1058
PROB, 1058
PROPER, 544, 547, 1058
PV (present value), 582–583, 1058
QUARTILE functions, 605–606, 1058
QUOTIENT, 1059
RADIANS, 1059
RAND, RANDBETWEEN, 540, 626, 1059
rank. See ranking functions

RANK functions, 606, 1059
RATE, 586–587, 1059
RECEIVED, 593, 1060
Recommended category, 534
reference functions. See lookup and reference functions
regression functions. See regression
REPLACE, REPLACEB, 593, 1060
REPT (repeat characters), 1060
RIGHT, RIGHTB, 548–549, 1060
ROMAN, 1060
ROUND functions, 531, 542, 921, 1061
ROUNDDOWN function, 542, 1061
ROUNDUP function, 542, 1061
ROW, ROWS, 562, 1061
RSQ, 1061
RTD (real-time data, COM automation), 1061
ScreenTips for, 530
SEARCH, 547–548, 1061
SEARCHB, 1062
SECOND (time), 577, 1062
securities. See securities analysis functions
SERIESSUM, 1062
SIGN, 1062
SIN (sine), 1062
SINH (hyperbolic sine), 1062
SKEW, 1062
SLN (straight-line depreciation), 589, 1062
SMALL, 606, 1062
SQRT (square root), 1062
SQRTPI (pi, square root of), 1063
STANDARDIZE, 1063
STEYX, 615, 1063
SUBSTITUTE, 549, 1063
SUBTOTAL, 736–737, 748–749, 1063
subtotal, choosing for PivotTables, 790
SUMSQ, 1064
SUMX functions, 1064
SYD (sum of years’ digits depreciation), 590, 1065
syntax of, 479, 531–533
T (return text), 1065
TAN (tangent), 1065
TANH (hyperbolic tangent), 1065
TBILL functions, 594–595, 1065
T.DIST (Student’s t-distribution), 1065
text functions, 544–550
TIME, TIMEVALUE, 578, 1066
T.INV (inverse Student’s t-distribution) functions, 1066
TODAY, 576, 1066
TRANSPOSE, 563, 1066
TREND, 613–614, 1066
TRIM, 544, 546, 1066
TRIMMEAN, 1067
TRUE, 1067
TRUNC (truncate decimals), 543, 1067
T.TEST (Student’s t-test), 1067
TYPE, 553, 1067
User Defined. See functions, custom
VALUE, 1067
variance. See variance
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VDB (variable declining balance), 590, 1068
Visual Basic for Applications. See functions, VBA
VLOOKUP, 555–557, 1068
WEEKDAY, 576–577, 1068
WEIBULL, 1069
WORKDAY, 579–580, 1069
XIRR (internal rate of return, nonperiodic), 1069
XNPV (net present value, nonperiodic), 1069
YEAR, 577, 1069
YEARFRAC, 578–579, 1069
YIELD functions, 594, 1070
Z.TEST, 1070

functions, custom
adding to add-in function modules, 925–927
advantages of, 917
arguments of, 919, 923–925
assignment statements, 920–921
creation steps, 917–919
documentation of, 922–923
Else statements, 920
End Function statements for, 917–918
End If statements, 920
entering in worksheet formulas, 919
error trapping, 924–925
Excel functions, using in, 921
Exit Function statements, 924
Function statements for, 917–918
If statements, 920, 932
indentation for code, 918
InputBox statements, 922
inserting in workbooks, 925–927
keywords allowed in, 922–923
limitations of VBA for, 922–923
MsgBox statements, 922
naming, 923
referencing in other workbooks, 925–927
returned values of, 921
rules for coding, 921
saving in workbooks as add-ins, 925–926
UserForms, 922
#VALUE! errors, 922–923
variables, 920–921

functions, VBA
custom. See functions, custom
IsMissing, 923–924
Str, 907

furigana characters, 1056
FV (future value) function, 584, 1040
FVSCHEDULE function, 1040

G
galleries, 30–31
GAMMA functions, 1041
General format, 323–324
GESTEP function, 1041
GETPIVOTDATA function, 1041
glows for graphic objects, 407–408, 686
Go To dialog box

All Levels option, 148

array selection, 146
Column Differences option, 149
conditionally formatted cells, selecting all, 146
constants option, 146
current region selection, 146
data validation cells, selecting all, 146
dependent cell selection, 148
Direct Only option, 148
keyboard shortcuts for, 148
last cell selection, 146
moving among cells without selection loss, 147
moving to different worksheets, 144–145
names, selecting with, 496
objects, selecting all, 146
opening, 144
precedent cell selection, 148
previous locations feature, 145
Reference box displays, 145
Row Differences option, 149
selecting ranges by references, 144
Special dialog box, 145–149
visible cells only selection, 146

Go To Special command, Conditional Formats option, 319
Goal Seek tool, 652–655
Good, Bad And Neutral Cell Styles, 303
gradients, color

cell fills with, 359–360
chart item fills, 702–704
data bars as, 310
embedded objects, for, 420–421
Format Shape options for, 412–413

graphics
3-D formatting options, 415–417
additional formatting for objects, 375
align commands for, 428–429
alternative text for, 404, 427
background images, worksheet, 360–361
brightness, adjusting, 401–402
callout shapes, 383–385
Camera command, 435–436
Change Picture command, 406
charts. See charts
clip art, inserting, 394–396
Color command options, 404–405
compressing images, 411–412
connector shapes, 383–385
constrained graphics, drawing, 376–377
contrast, adjusting, 401–402
copying ranges as pictures, 433–436
Corrections gallery, 401–402
Cut, Copy, And Sort option for, 229
drawing. See shapes
Drawing Tools Format tab, 375, 387–388, 407–408
editing in Excel, 6
as fills in chart items, 704–705
formatting. See formatting graphics
grids for drawing, 386
grouping objects, 421–423
headers and footers, adding to, 449–450
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graphics, continued
hiding, 430
hyperlinks, assigning to, 949
hyperlinks to images, 943
image fills in chart items, 704–705
images, inserting, 396–397
Insert tab drawing tools, 373
links from, creating, 383
macros, assigning to, 430–431
moving objects, 375
new tools in Excel 2010, 373
pasting selected cells as, 202
Picture Tools Format tab. See Picture Tools
pictures, inserting, 396–397
positioning objects, 423–429
properties options, 404
protecting, 429
references of drawn objects, 374
Remove Background command, 405–406
screenshots, 431–433
selecting hyperlinks without triggering, 950
selecting objects, 421–423
Set As Default Shape command, 414
Shadows options, 414–415
Shape formatting controls, 407
Shapes gallery, 382–385
Shapes gallery of tools. See shapes
SmartArt objects. See SmartArt graphics
Snap To Grid command, 428
Stretch options, 414
text, adding to shapes, 381–382
text box objects, 381, 384, 404
text, formatting in, 409–411
texture fills, 704–705
Tile Picture As Texture option, 414
WordArt, 387–388

greater than operator (>), 522
greatest common divisors, 1041
gridlines, chart, 682–683
grids

displayed vs. printed, 105
for drawing, 386
Gridline Color options, 109
printing, 453

Group menu of Data tab
Auto Outline command, 274–276
Group button, 280
Ungroup button, 280

grouping
columns or rows, 280
commands for, 422
objects, 421–423
PivotTable custom data groupings, 808–810
worksheets. See grouping worksheets

grouping worksheets
Across Worksheets command, 260–261
creating groups, 255–259
editing allowed in group mode, 260
ungrouping, 258–259

groups, creating custom ribbon, 88–89

groups, user permissions for, 174–175
GROWTH function, 616, 1041
Growth Trend command, 233–234

H
hackers, 115
HARMEAN (harmonic mean) function, 1041
header rows

automatic creation of filters on, 747
eliminating when importing text files, 821
filter arrows in, 747–748
#Headers tag, 768–769
Modify Table Quick Style formatting of, 772–774

headers
Field Headers toggle of PivotTables, 788
Page Layout view, editing in, 442
Page Setup options for, 444–450
sorting, excepting from, 739
structured reference specifiers, 502
table, overwriting defaults, 732

#Headers tag, 768–769
headings

displayed vs. printed, 105
Heading font, 772
printing, 453
Titles And Headings Cell Styles, 304

heights of rows, setting, 362, 364
Help system

F1 command for, 28
function descriptions in, 527–528
i icons, 72–73
Keep On Top option, 76
navigation pane, 75–76
offline version, 73
online connection for, 73–74
online help advantages, 75
opening the Help dialog box, 73
question mark icons, 77
SceenTips, 72–73
Search menu, 77–78
Table Of Contents pane, 76
toolbar buttons, dialog box, 75–76
VBA, 903

hexadecimals
BIN2HEX function, 1025
DEC2HEX (decimal to hexadecimal) function, 1034
HEX2 functions, 1042
OCT2HEX function, 1054

hidden cells, plotting in charts, 721
hidden files and folders, showing, 369
hiding

cells and worksheets, 176
columns or rows, 365
graphic objects, 430
number format for, 342
outlines, 278
saving as hidden, 192
workbooks, 189–190
worksheets, 192
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hierarchical designs, 135
Highlight Cells Rules feature, 309–311
highlighting changes, 865–868
high-low lines, 726
Histogram tool, 619–622
history worksheets, 867
HLOOKUP function, 555–557, 1042
Home key, 140
Home tab

Clear menu, 220–221
Conditional Formatting command, 309. See also conditional 

formatting
Find & Select. See Find & Select menu
Font group, 351. See also fonts
Format button, 176
formatting commands in, 290–291
Insert menu, 212, 214
Lock Cell command, 171–172
Number group in. See Number group, Home tab
Sum button, 480–481, 538
Wrap Text button, 154

homographs, 116
horizontal text alignment, 344–346
HOUR function, 577, 1042
HTML documents

opening in browsers, 63
saving Excel files as, 69

HTML format, pasting Excel data as, 968
hyperbolic functions

ACOSH (inverse hyperbolic cosine), 1022
ASINH (inverse hyperbolic sine), 1023
ATANH (inverse hyperbolic tangent) function, 1024
COSH (hyperbolic cosine) function, 1029
SINH (hyperbolic sine) function, 1062
TANH (hyperbolic tangent) function, 1065

hyperlinks
autocorrect to hyperlink option, 944
Bookmark button for inserting, 947
Browsed Pages list of, 946
browsing for URLs, 946–947
capabilities of in Excel, 943–944
Clear Hyperlinks command, 221
creating in cells, 944
current document, links to, 947–948
deleting, 950
document creation with, 944
editing, 950
e-mail, launching with, 944, 949
embedding and OLE links compared to, 953–954. See also 

embedding; links
formulas for creating, 950–951
graphic objects, selecting without triggering, 950
Hyperlink command, 944–945
HYPERLINK function, 950–951, 1042
to images, 943
Insert Hyperlink dialog box, 945–949
Internet addresses, AutoCorrection to, 248
links compared to, 961

local documents, locators for, 946–947
most recently used list of, 946
network paths, to, 944
new files, linking to, 948
pasting, 209–210
Place In This Document command, 947–948
Remove Hyperlink command, 947, 950
Remove Hyperlinks command, 221
right mouse button drag option for creating, 223
ScreenTips for, 945
selecting without triggering, 950
text, converting to, 945
Web sites, to, 943
from Word documents to Excel data, 970–971

I
i (information) icons, 72–73
icon sets feature, 310
icons, embedding objects as, 398
IF function, 551, 552, 1043. See also conditional functions
If statements, VBA, 920, 932
IFERROR function, 1043
IIS (Internet Information Services), 874
illustrations. See graphics
IMABS function, 1043
images. See graphics
imaginary numbers

COMPLEX function, 1028
IMABS function, 1043
IMAGINARY function, 1043
IMARGUMENT function, 1043
IMCONJUGATE, 1043
IMCOS function, 1043
IMDIV function, 1043
IMEXP function, 1044
IMLN function, 1044
IMLOG functions, 1044
IMPOWER functions, 1044
IMPRODUCT function, 1044
IMREAL function, 1044
IMSIN function, 1044
IMSQRT function, 1044
IMSUB function, 1044
IMSUM function, 1044

Immediate Window, VBA, 936–937
implicit intersection of references, 765–767
implicit intersections, 496, 501
Import Data dialog box data connection options, 816–819
imported data design considerations, 134
importing

Access tables, entire, 819–820
data connections for, Import Data dialog box, 816
Quick Access Toolbar, 99, 101
ribbon, custom, 91–92
Text Import Wizard, 821–824
themes, 302
Web data. See Web queries
XML data, 825–829
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importing files
help documentation for, 66
Macintosh computer files, 67–68
Open command for, 67
text files, 70

Increase Decimal command, 327
indenting cell content, 344
INDEX function, 525–526, 560–562, 1045
indexes of collections, 906–907
INDIRECT function, 562, 1045
Info category

Mark As Final command, 192–194
unresolved messages, 113

INFO function, 1045
information functions, 553–554, 1029, 1046–1047, 1067
Information Rights Management. See IRM (Information 

Rights Management)
input. See data entry
input ranges, 636
InputBox statements, 922
Insert Function dialog box

browsing functions with, 528–529
launching, 37–38, 481
searching for functions with, 533
User Defined functions, 925

Insert tab
Charts group, 670
graphics buttons of, 373
Hyperlink command, 944–945
Object button, 397
Object command, embedding with, 958–960
Picture button, 396
PivotTable command, 780
SmartArt button, 389
Sparklines group, 690
Symbol tab of, 156–157
Table command, 731
WordArt button, 387–388

inserting
cells, 214–216
copied or cut cells, 215–216
fill handles, dragging, 221–222
fixing formulas after, 219
formula adjustments with, 213, 476
functions in formulas, 481, 533–535
graphics. See graphics
hyperlinks, 945–949
Insert Options button, floating, 213
Insert Worksheet tab, 257
keyboard shortcuts for, 214
names in formulas, 492–493
objects, 397–399
ranges, 214–216
rows and columns, methods for, 212–214
Show Insert Options Button option, 229
slicers in PivotTables, 795
worksheets, 159–160

Inspect Document command, 121–122

integers
INT function, 543, 1045
QUOTIENT function, 1059
TRUNC (truncate decimals) function, 543, 1067

INTERCEPT function, 1045
interest

accrual functions, 592–593, 1021
CUMIPMT function, 1032
INTRATE function, 593, 1045
IPMT (payments) function, 585, 1046
ISPMT (interest paid) function, 1047
NOMINAL function, 1052
rates, Data Table calculations of effects of, 636–640
YIELD functions, 594, 1070

internal rate of return (IRR) function, 587–588, 1046
internal rate of return, nonperiodic (XIRR) function, 1069
Internet

cloud computing, 888
data, querying. See Web queries
Excel Web App, 887–892
SkyDrive folders for collaboration, 884–886

Internet Explorer, 855
intersections, 496, 501–502
INTRATE function, 593, 1045
inverse hyperbolic cosine (ACOSH) function, 1022
inverse hyperbolic sine (ASINH) function, 1023
inverse hyperbolic tangent (ATANH) function, 1024
investment functions. See also securities analysis functions

accrual functions, 592–593, 1021
arguments for, 581–582
CUMIPMT function, 1032
CUMPRINC (cumulative principal paid) function, 1032
FV (future value) function, 584, 1040
FVSCHEDULE function, 1040
IPMT (interest payments) function, 585, 1046
IRR (internal rate of return) function, 587–588, 1046
MIRR (modified internal rate of return) function, 588, 1051
NPER (number of periods) function, 586, 1053
NPV (net present value) function, 583–584, 1053
PMT (payments) function, 584–585, 636, 1056
PPMT (principal payments) function, 586, 1057
PV (present value) function, 582–583, 1058
RATE function, 586–587, 1059
YIELD functions, 594, 1070

IPMT (interest payments) function, 585, 1046
IQY files, 850, 853
IRM (Information Rights Management)

adding new users, 878
capabilities of, 874
Change permissions, 876
Change User command, 879
client-side component installation, 874
Copy command control, 877
defaults, setting, 878
delays, authentication, 878
expiration dates for permissions, 877
installing, 875
modifying permissions, 878
as new feature, 15
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people, granting permissions to, 876–877
Permissions dialog box, 876
print permissions, 877
programmatic access, 878
protecting documents, steps for, 875–877
Read permissions, 876
requesting permissions, 876–877, 879
requirements for, 874
Windows Live sign-up, 875–876
working with protected documents, 878–879

IRR (internal rate of return) function, 587–588, 1046
ISBLANK function, 553–554, 1046
ISERR function, 553–554, 1046
ISEVEN function, 554, 1046
ISLOGICAL function, 554, 1046
IsMissing function, VBA, 923–924
ISNA function, 554, 1046
ISNONTEXT function, 554, 1046
ISNUMBER function, 554, 1046
ISODD function, 554, 1047
ISPMT (interest paid) function, 1047
ISREF function, 554, 1047
ISTEXT function, 554, 1047
Italic command, 351
iterative calculations

enabling, 510–511
function use of, 587
goal seeking, 654

J
Japanese characters, 1056
JIS function, 1047
join operations, 831, 837
Justify command, Fill menu, 236–237
justifying text, 346. See also alignment

K
Keep Change History For specification, 870
Keep Source Formatting option, 964
Keep Text Only option, 964
keyboard commands

displaying, 34–36
essential, table of, 198

keyboard mode indicators, table of, 138–139
keyboard shortcuts

accessibility feature, as a, 109
Alt+F11, 903
current date and time entry, 567
data entry, 150
F4, 242
Go To Special equivalents, 148
insertion commands, 214
navigation shortcuts, 139–140
table selection, 734
tables of, by key, 1003–1009
tables of, by task, 1010–1020
worksheets, display next or previous, 167

keywords, VBA, 903

Korean characters, 1056
KPI (key performance indicator), CUBEKPIMEMBER function, 

1031
KURT (kurtosis) function, 619, 1047

L
labels

axis labels, positioning, 706–707
chart, 675–678
chart titles, 681
names of cells and ranges, using for, 484–485, 489
natural-language formulas feature discontinued, 499

labels, mailing, 976–979
landscape orientation, 438
LARGE function, 606, 1047
last cell selection, 146
layouts, gallery of chart, 674
LCM (least common multiple) function, 1047
leading zeros dropped rule, 323
left aligning text, 344–346
LEFT function, 548–549, 1047
LEFTB function, 1047
legacy versions of Excel

2003, new features of, 15
2007, new features of, 10–13, 729–731

legends, chart
adding or editing, 677–678
WordArt styles for, 684–685

LEN, LENB functions, 545, 1048
less than operator (<), 522
line breaks in formulas, 497
linear optimization models, 663
linear regression

Competitive Market Analysis (CMA), 612
defined, 607
equations for, 609
FORECAST function, 615, 1040
LINEST function, 610–612, 1048
SLOPE function, 615, 1062
STEYX function, 615, 1063
TREND function, 613–614, 1066

Linear Trend command, 233–234
lines

color and style options, 414
drawing, 378
formatting of, 403

LINEST function, 610–612, 1048
Link To Content check box, advanced properties, 60
linked workbooks

advantages of, 518
Edit Links command, 520–521
external content security options, 117–118
opening dependent workbooks, 519
range manipulations in, 521–522
references to cells in other workbooks, 471
saving, 518–519
supporting and dependent workbooks, 518
updating supporting values, 519

linking custom properties to cells, 60–61
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links
Automatic updating, 960–961
broken, fixing, 961
Camera command, 435–436
Change Links dialog box, 961
chart titles to cells, 676
charts pasted into Word, 975
consolidating worksheets with, 286–287
defined, 953
display options for, 953–954
document types available for, 959
Edit Links command, 520–521, 960–961
embedding compared to, 953–954
error messages for, 961
external reference formulas for, 957
file size issues, 954
files, creating objects from, 959–960
green rotation handles of, 957
hyperlinks, compared to, 209, 961
icons for, 953–954, 958
Link & Keep Source Formatting option, 964
Link & Use Destination Styles option, 964
Linked Picture command, 434–435
Manual updating, 960–961
new object creation with Object command, 958–959
Object command, linking with, 958–960
objects to files, 398
OLE (object linking and embedding), 953
Paste Link command, 957–958
paste-linking Excel Tables into Word, 969–970
pasting, 207
remote files not retrievable, anticipating, 954
right mouse button drag option for creating, 223
between text and shapes, 383
Windows Packager, 959–960
Word documents, viewing full, 954
from Word to Excel tables, 963–964
workbook to workbook. See linked workbooks

lists
Custom List feature, 237–238
legacy, 731
management features, legacy, 14, 15. See also tables
PivotTables, as data sources for, 779
sorting, 737–738
sorting parts of, 741

live preview functionality, 30–32
LN (natural log) function, 1048
loans, functions for calculating. See investment functions
locale (location)

formats, selecting, 333
PHONETIC function, 1056

locations, trusted, 114
locks, 170–172
logarithmic functions

IMLN function, 1044
IMLOG functions, 1044
LN (natural log) function, 1048
LOG (logarithm) function, 1048
LOGEST function, 611, 616, 1048

logarithmic scales for chart axes, 679–680, 709
logical functions

defined, 550
FALSE function, 1038
AND function, 551–552, 1023
IF function, 551, 552, 1043
NOT function, 551–552, 1053
OR function, 551–552, 1055
SUMIF, SUMIFS functions, 551
TRUE function, 1067

logical operators. See also logical functions
AND operator, filtering with, 756, 758
OR operator, filtering with, 751–758
table of, 522

logical values
arguments of functions, as, 532
sort order of, 745

LOGNORM functions, 1048
lookup and reference functions

ADDRESS function, 559, 1022
AREAS function, 563, 1023
CHOOSE function, 559
COLUMN function, 562, 1028
COLUMNS, 1028
DGET function, 1034
finding specific values in tables, 525–526
HLOOKUP function, 555–557, 1042
INDEX function, 525–526, 560–562, 1045
INDIRECT function, 562, 1045
ISBLANK function, 553–554, 1046
ISREF function, 554, 1047
listing all, 555
LOOKUP function, 555–556, 558, 1049
MATCH function, 525–526, 559–560, 1049
OFFSET function, 1055
ROW, ROWS functions, 562, 1061
TRANSPOSE function, 563, 1066
TYPE function, 553, 1067
vector vs. array forms, 555
VLOOKUP function, 555–557, 1068

Lotus 1-2-3 support, 14–15
LOWER function, 544, 547, 1049

M
Macintosh computers

date format issues, 68
importing and exporting Excel files to, 67–68
text file formats for, 70

macros
For . . . Next statements, 907
ActiveCell objects, 905
adding recorded code to existing macros, 909–911
collections, 906–907
comments, VBA, 903
creation methods, 895
defined, 895
descriptions for, 899
Dim statements, 932
displaying module code, 902
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documentation of, 922–923
Enable All Macros option, 897
End Sub statements, 903, 912–913
file formats for, 898
keywords, VBA, 903
launching Visual Basic Editor, 901–902
Macro dialog box, 899–900
making available for other workbooks, 914
methods, 904
modules holding, 901–902
naming, 923
objects, 903–908
objects, assigning to, 430–431
Personal Macro Workbooks, 914
play button in status bar, 40
properties, 904–905
Quick Access Toolbar, adding to, 98–99
Range().Select statements, 904
record macro button in status bar, 40
recording, basic steps for, 898–899
relative references when recording, 900
running, 899
security configuration for, 895–898
security warnings, 896–897
Select method, 904
shortcut key assignment, 899
stepping through code, 932–933
Stop Recording button, 899
Sub statements, 903, 912–913
syntax errors, prompts at, 930–931
troubleshooting recorded, 901
Trust Center settings, 116, 895–898
trusted locations for, 897–898
Web Apps not compatible with, 891
XLSM (Excel Macro-Enabled Workbook) file format, 54
XLTXM format for templates, 54

mail-merging Excel data into Word, 976–979
Map Network Drive command, 62
mapping XML elements to columns, 826–828
margins, 441, 443–444, 457, 461
marking as final, 192–194
marquees, 197
master workbooks for combining changes, 869–871
MATCH function, 525–526, 530, 559–560, 1049
mathematical functions. See also financial functions; 

regression; statistics
ABS (absolute value) function, 1022
ACOS (arccosine) function, 1022
ACOSH (inverse hyperbolic cosine) function, 1022
ASIN (arcsine) function, 1023
ASINH (inverse hyperbolic sine), 1023
ATAN (arctangent) function, 1023
ATAN2 (arctangent) function, 1023
ATANH (inverse hyperbolic tangent) function, 1024
AVERAGE, AVERAGEA functions, 544, 602, 800–801, 1024
AVERAGEIF(S) functions, 602, 1024
BESSEL functions, 1024–1025
BETA.DIST function, 1025
BINOM (binomial distribution) functions, 628, 1026

CEILING function, 542–543, 1026
chi-squared distribution functions, 1027
COMBIN function, 540, 1028
COMPLEX (number) function, 1028
CONFIDENCE.NORM function, 1028
CONFIDENCE.T function, 1029
CORREL (correlation coefficient) function, 1029
COS (cosine) function, 1029
COSH (hyperbolic cosine) function, 1029
COUNT function, 603, 736–737, 800–801, 845–848, 1028
COUNTIF functions, 539, 1029
DAVERAGE function, 1033
DEC2BIN (decimal to binary) function, 1034
DEC2HEX (decimal to hexadecimal) function, 1034
DEC2OCT (decimal to octal) function, 1034
DEGREES function, 1034
DELTA function, 1034
DSUM, 1036
DVAR, DVARP functions, 1036
ERF (error) functions, 1037
EVEN function, 542, 1038
EXP function, 1038
EXPON.DIST function, 1038
FACT (factorial) function, 1038
F.DIST functions, 1038
F.INV functions, 1039
FISHER functions, 1039
FIXED function, 1039
FLOOR function, 542–543, 1040
GAMMA functions, 1041
GCD (greatest common divisor) function, 1041
GEOMEAN function, 1041
HARMEAN (harmonic mean) function, 1041
HEX2 functions, 1042
HYPGEOM.DIST function, 1043
IMAGINARY function, 1043
IMARGUMENT, 1043
IMCONJUGATE, 1043
IMCOS function, 1043
IMDIV function, 1043
IMEXP function, 1044
IMLN function, 1044
IMLOG functions, 1044
IMPOWER functions, 1044
IMPRODUCT function, 1044
IMREAL function, 1044
IMSIN function, 1044
IMSQRT function, 1044
IMSUB function, 1044
IMSUM function, 1044
INT function, 543, 1045
INTERCEPT function, 1045
ISEVEN function, 554, 1046
ISODD function, 554, 1047
LCM (least common multiple) function, 1047
LN (natural log) function, 1048
LOG (logarithm) function, 1048
LOGNORM functions, 1048
MDETERM function, 1049
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mathematical functions, continued
MEDIAN function, 603–606, 619, 760–761, 1050
MINVERSE function, 1051
MOD function, 540–541, 1051
MROUND function, 543, 1051
MULTINOMIAL function, 1052
NEGBINOM.DIST, 1052
NORM (normal distribution) functions, 1052–1053
OCT2 functions, 1054
ODD function, 542, 1054
PERMUT (permutations) function, 1056
PI function, 1056
POISSON.DIST function, 1057
POWER function, 1057
power series, SERIESSUM function, 1062
PROB function, 1058
PRODUCT function, 539, 1058
QUOTIENT function, 1059
RADIANS function, 1059
RAND, RANDBETWEEN functions, 540, 626, 1059
ROUND (rounding) functions, 531, 542, 921, 1061
RSQ (Pearson product moment squared) function, 1061
SERIESSUM function, 1062
SIGN function, 1062
SIN (sine) function, 1062
SINH (hyperbolic sine) function, 1062
SKEW function, 1062
SQRT (square root) function, 1062
SQRTPI (pi, square root of) function, 1063
STANDARDIZE function, 1063
SUM. See SUM function
SUMIF, SUMIFS functions, 523–524, 538–539, 551, 1064
SUMPRODUCT function, 539
SUMSQ function, 1064
SUMX functions, 1064
TAN (tangent) function, 1065
TANH (hyperbolic tangent) function, 1065
TRUNC function, 543, 1067
Z.TEST function, 1070

matrices
MDETERM function, 1049
MINVERSE function, 1051
TRANSPOSE function, 563, 1066

MAX function
distribution function, as a, 603
MAXA function, 1049
Microsoft Query totals with, 845–848
PivotTable value fields with, 800–801
QUARTILE function, instead of, 606
syntax of, 1049

Maximize button, 25–26
Maximum value, autocalculation of, 41
MDETERM function, 1049
MDI (multiple document interface), 26, 180
MDURATION function, 596, 1050
means, statistical

Descriptive Statistics formula for, 619
GEOMEAN function, 1041
HARMEAN (harmonic mean) function, 1041

MEDIAN function, 603–606, 619, 760–761, 1050
NORM.DIST function, 1052
NORM.INV function, 1053
NORM.S.DIST function, 1053
NORM.S.INV function, 1053
TRIMMEAN function, 1067

MEDIAN function, 603–606, 619, 760–761, 1050
memory limitations, 11, 21
Merge & Center command, 345
merging cells, 365–368
Message Bar

Change Permissions button, 878–879
security alerts in, 112–113
Trust Center options for, 117
unresolved messages, 113

methods, VBA
Activate method, 907
arguments to, 908–909
defined, 904
Select method, 904

MHT/MHTML format, 69
Microsoft Access. See Access databases
Microsoft Excel Worksheet Object format, 966–967
Microsoft Graph Chart, 974–975
Microsoft Office Button, File tab replacement of, 4
Microsoft Office common chart engine, 973
Microsoft Office Online Web site

Help connection, 73
templates at, 44–45

Microsoft Office Open XML format. See XLSX file format
Microsoft Organization Chart 2.0, 389
Microsoft Outlook, sharing workbooks by, 872–874
Microsoft Query

adding fields to the data pane, 837
adding tables to the data pane, 837
aggregation calculations with, 845–848
Auto Query button, 840, 842
automatic vs. manual queries, 842
capabilities beyond Query Wizard, 834
capabilities of, 829
choosing data sources, 829
Criteria Equals button, 840–842
criteria, menu commands for creating, 843–844
criteria pane, removing, 841
Cycle Through Totals button, 840, 845
DQY files, 833–834
Edit Column command, 846
entering from Query Wizard, 834
exact-match criteria, creating, 840
filtering on calculated fields, 847–848
filtering records to import, 831–832
filtering result sets, 840–844
hiding fields without deleting them, 838
join operations with, 831, 837
launching, 829
moving fields, 838
multiple exact-match criteria with, 841–842
multiple field comparison filters, 844
opening saved queries, 834–835
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parameter-based queries, 848–849
Query Now button, 840, 842
Query toolbar Sort icon, 839
Query Wizard, Choose Columns page, 830–831
relationships, filtering on, 831–832
removing fields from the data pane, 838
renaming fields, 838
result sets, 836
Return Data button, 840
returning results to Excel, 849
saving queries, 833–834, 849
selecting databases for importing, 830
sorting data in, 832–833, 838–840
tables pane, removing, 841
toolbar buttons for, 840
totals, 845–848
unique entries, limiting result set to, 844
View SQL button, 840, 842
window layout of, 836

Microsoft SharePoint
capabilities of, 892
multiple users editing not allowed, 862
Save To SharePoint command, 883
saving files to, 859

Microsoft Word. See Word documents
MID function, 549, 1050
MIDB function, 1050
middle alignment, 347
MIN function

distribution function, as a, 603
Microsoft Query totals with, 845–848
MINA, 1050
PivotTable value fields with, 800–801
QUARTILE function, substituting for, 606
syntax of, 1050

Mini toolbar, 37, 102–103
Minimize button, 25–26
Minimum value, autocalculation of, 41
MINUTE function, 577, 1050
MINVERSE function, 1051
MIRR (modified internal rate of return) function, 588, 1051
mixed references, 470, 475
MMULT. See MODE functions
mobile tools, 10
MOD function, 540–541, 1051
MODE functions, 603, 619, 1051
modular designs, 135
modules

created by recording macros, 901–902
creating in Visual Basic Editor, 918
custom function add-ins, 926
Personal Macro Workbooks, placing in, 914

modulus, 540–541, 1051
MONTH function, 577, 1051
months

creating worksheets for each, 256–259
grouping by in PivotTables, 809–810
sort order for, 746

More Functions command, 481

mouse devices
dragging fill handles, 221–222
dragging with right mouse button, 223
moving and copying with, 211–212
regions, navigating with, 138–139
scrolling with wheels, 23
selection methods with, 140–142
zooming with, 23, 169

moving
arrays, 514
charts to chart sheets, 675
dragging with a mouse, 211–212
right mouse button drag options for, 223
Shift key with, 211–212

Moving Average tool, 631–633
moving averages. See trendlines
MS-DOS, saving to text files for, 70
MsgBox statements, 922
MSN MoneyCentral Investor, Web queries to, 850–851
multicore processor support, 12
multilevel categories for charts, 721–723
MULTINOMIAL function, 1052
multiple document interface (MDI), 26, 180
multiple files, selecting to open, 62
multiple regression, 607, 609
multiple workbooks, combining changes from, 869–871
multiplication, 467–468, 1044

PRODUCT function, 539, 800–801, 1058
multithreaded/multiprocessor acceleration of calculation, 

507
multithreading support, 12
My Templates, 44, 46–48

N
N function, 1052
NA function, 1052
Name box

constant and formula names not in, 490
name assignment, 483–484
scope, setting, 487–488

Name Manager dialog box, 485–486, 490
named cells and ranges

absolute reference nature of names, 484
advantages of, 483
Apply Names command, 494–495
arguments of functions, as, 532
Create From Selection button, 489
editing names, 486
Go To dialog box, selecting with, 496
inserting arguments of functions with mouse devices, 535
inserting in formulas, 492–493
intersections, 496
labels, using for names, 484–485, 489
legacy versions, troubleshooting, 487
links from Word to Excel data using, 970
listing names, 493–494
manager for, 485–486, 490
Name box rules, 484
Paste Names dialog box, 492–493
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named cells and ranges, continued
references, editing, 486
rules for naming, 487
scope of names, setting, 487–488
selecting named cells from Name box, 484
syntax of, 483
tables, names in, 486
three-dimensional, 491
workbook-wide vs. worksheet-only, 487–488

named references. See named cells and ranges
naming

automatic cell name creation, 489
cells, 483–486
constants, 490– 491
Criteria ranges, 757
Extract ranges, 762
formulas, 490– 491
macros, 898
New Name dialog box, 484–486, 490
ranges, 483–486
rules for naming cells and ranges, 487
table formula references, auto converting to named, 763
tables, 498–499, 733–734
worksheets, 162

natural log, LN function, 1048
natural-language formulas feature discontinued, 499. See 

also structured references
navigation

Ctrl+Arrow keystrokes, 138
End mode, 139
keyboard shortcuts for, 139–140
Scroll Lock mode, 139, 140
scrolling and panning, 23, 24–25
workbook navigation methods, 23–25

negative numbers formatting options, 324
NEGBINOM.DIST, 1052
net present value (NPV) function, 583–584, 1053
net present value, nonperiodic (XNPV) function, 1069
NETWORKDAY functions, 579–580, 1052
networks

advanced sharing options, 863–864
allowing changes by multiple simultaneous users, 861–863
change tracking, 861–863
closing shared sessions, 869
conflict management, 861–863
e-mail, sharing workbooks by, 872–874
Excel Web App, 887–892
formatting of changed cells, 861
opening files in, 62
remote computers, saving files to, 859
sharing workbooks on, 860–863
tracking changes in shared workbooks, 863–868
user names, editing, 861

new features in Excel 2003, 15
new features in Excel 2007, 10–13, 729–731
new features in Excel 2010

64-bit edition, 10
charting capacity expansion, 9
compatibility functions, 8–9

conditional formatting improvements, 8
functions, additional, 8–9
graphics tools, 373
math equation editing support improvements, 9
mobile tools, 10
Office Button (Excel 2007) replaced, 4
Office Web Apps, 6–7
picture editing, 6
ribbon customization, 5
slicers, 7–8
SmartArt graphics improvements, 10
sparklines, 5
table features, 729–731

New Name dialog box, 484–486, 490
New Query button, 840
New Web Query form, 852–853, 855
New Window command, 106
NLFs (Natural Language formulas) discontinued, 14
NOMINAL function, 1052
nonadjacent ranges of cells, 141–142
normal distributions

CONFIDENCE.NORM function, 1028
NORM.DIST function, 1052
NORM.INV function, 1053
NORM.S.DIST function, 1053
NORM.S.INV function, 1053
random number generation with, 627–628
Z.TEST function, 1070

Normal style, 307, 772
Normal view button, 40
normalized values, STANDARDIZE function, 1063
not equal to operator (<> ), 522
NOT function, 551–552, 1053
notification bar macro security warnings, 896
NOW function, 576, 901, 1053
NPER function, 586, 1053
NPV (net present value) function, 583–584, 1053
Num Lock mode, 139
Number Format Cell Styles, 304
Number Format drop-down list, 570–571
Number group, Home tab

Accounting Number Format button, 327–329
Currency button, 325–326
layout of, 28–29

number of loan periods, NPER function for, 586, 1053
numbers, formatting

accounting formats, 327–329
billing and part number custom formats, 339
codes for built-in formats, 337–338
colors for, 339–341
conditional operators in custom formats, 341–342
Currency format, 325–326. See also currency
custom number formats, 333–342
Decrease Decimal command, 327
digit placeholders in formats, 336
formatting percentages, 330
four part formats, 338–339
fractions, 331–332
General format, 323–324
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guidelines for, 324–325
hidden number format, 342
Increase Decimal command, 327
locale formats, 333
negative numbers options, 324
Number format, 324–325
phone number format, 333
scientific notation, 332
Social Security number formatting, 333
Text format with, 332
TEXT function, 545, 1066
underlines, 329
ZIP code formats, 332

numeric text
BAHTTEXT function, 1024
formulas, using in, 477
ROMAN (Roman numeral) function, 1060
text strings, functions converting to, 544
VALUE function, 1067

numeric values
### . . . (number signs filling cells), 153
arguments of functions, as, 532
entering in cells, 151
formatting. See numbers, formatting
formatting, Cell Style attribute for, 305
General format with, 323–324
HEX2 functions, 1042
ISNUMBER function, 554–555, 1046
maximum allowed, 512
minimum allowed, 512
N function, 1052
parentheses () around, 151
precision of, 511–512
SIGN function, 1062
text, entering numbers as, 155–156

Numerical Count, autocalculation of, 41

O
Object command, embedding with, 958–960
Object dialog box, 958–960
object layer, 954
object model, VBA

Application objects, 921
collections of objects, 906–907
Excel application object, 903
methods of objects, 904
properties of objects, 904
Selection objects, 911
viewing objects with Watch Window, 935–936
viewing with Object Browser, 905–906

objects
aligning, 428–429
chart, 671
Distribute (objects) Horizontally/Vertically command, 429
embedded, 397, 420–421
files, creating from, 959–960
Format Object command, 420
graphic. See graphics
grouping, 421–423

hyperlinks of, 949–950
inserting, 397–399
Link To File option, 398
macros, assigning to, 430–431
Object Browser view, Visual Basic Editor, 905–906
Object options of Paste Special, 957
positioning, 423–429
Print Object option, 426
protecting, 429
selecting all, 146
VBA. See object model, VBA
Windows Packager wrapped, 959–960
Word Object command for links to Excel, 971–972
Worksheet Object format, 966–967

octal numbers
BIN2OCT function, 1025
DEC2OCT (decimal to octal) function, 1034
HEX2OCT function, 1042
OCT2 functions, 1054

ODC (Office Data Connection) files, 815, 833
ODD function, 542, 1054
odd numbers, ISODD function, 554, 1047
ODDFPRICE function, 1054
ODDFYIELD function, 1054
ODDLPRICE function, 1054
ODDLYIELD function, 1055
Office Assistant discontinued, 14
Office Button, File tab replacement of, 4
Office Data Connection (ODC) files, 815, 833
Office Live Workspace, 887
Office Mobile 2010, 10
Office Online Web site

Help connection to, 73
templates at, 44–45

Office Web Apps
benefits of, 68
collaboration with, 887–892
as new features in Excel 2010, 6–7

Office.com connection settings, 119–120
OFFSET function, 1055
OLAP (online analytical processing)

CUBE functions for, 1031–1032
Enable Background Refresh option not available for, 818
Microsoft Query, as source for, 829

OLE links. See links
On Error GoTo statements, 938–940
open-high-low-close charts, 713–715
opening files

File In Use dialog box, 859–860
importing with Open command, 67
Open Dialog box for, 61–64
remote files, 859
startup, opening on, 64
text data files, 820–821

operating environment INFO function, 1045
operators

& (ampersand) concatenation, 477–478
conditional, 341–342, 522
intersection operator, 496
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operators, continued
logical, 522, 751–758
precedence of, 467–468
reference, with column specifiers, 502

optimization, financial. See Solver; what-if analysis tools
Options dialog box, Excel

Advanced menu of. See Advanced options
After Pressing Enter, Move Selection option, 38, 227
AutoRecover options, 78–79
Color Scheme option, 102
Customize Ribbon category, 83–92
default file locations, setting, 49
Display area of Advanced options, 104–107
editing options, 227–229
Enable Iterative Calculations option, 510–511
Enable Live Preview option, 102
layout of, 31
opening, 31
Quick Access Toolbar category, 95–99
Save Files In This Format list, 898
ScreenTip Style options, 102
Show Formulas In Cells option, 105–106
Show Mini Toolbar On Selection option, 102
Trust Center options. See Trust Center
Use Table Names In Formulas option, 499
zeros, hiding, 106–107

OR function, 551–552, 1055
OR operator, filtering with

Advanced Filter command for, 752–758
Custom Filter command for, 751
two columns joined by OR, 753–757

orientation of pages, 438
orientation of text characters, 347–350
outlines of shapes, 413
outlining

advantages of, 274
Auto Outline command, 274–276
Automatic styles option, 277
collapsing and expanding, 275–276, 278–279
extending outlines, 277
grouping and ungrouping, 280
hiding, 278
level bars and symbols, 278
nonstandard layouts, outlining, 277
printing, designing for, 131–132
Settings dialog box for, 277
undoing outlines, 276
Visible Cells Only option, 279

ovals, drawing, 376–377
Overtype mode, 139

P
Page Break Preview button, 40
page breaks, 457–459
Page Layout tab

Fit To options, 440
grid options, 105
Group button, 422
heading options, 105

Height controls, 440
Margins button, 443–444
orientation of pages, 438
overview of, 437–438
Print Titles feature, 131
Scale To Fit commands, 440–441
Size (of paper) command, 438
Themes group. See themes
Width controls, 440

Page Layout view, 10, 40, 441–442
page numbering, 440, 446
Page Setup dialog box

launching, 437–438
margins, setting, 443–444
print area settings, 451–452
print quality options, 439
Sheet tab settings, 450–451

painting formatting, 299
panes

freezing, 166–167
saving settings as custom views, 169–170
worksheet, split pane views, 164–165

panning, 23, 109
paper size specification, 438–439, 456
parentheses ()

around values, 151
functions, closing automatically, 479
precedence effects in formulas, 467–468

passwords
files, protecting with, 57–58, 65
Protect Shared Workbook passwords, 867
protected items, assigning to, 177, 191
ranges, requiring for editing, 174–175
shared workbook protection with, 865
workbook encryption, for, 191–192

Paste Names dialog box, 492–493
Paste Options floating button, 159
Paste Special command in Word

Bitmap format, pasting Excel data as, 968
formats available with, 966
HTML format, pasting Excel data as, 968
hyperlinking to Excel data, 970–971
Microsoft Excel Worksheet Object format, 966–967
Paste Link option, 969–970
Picture formats, pasting Excel data as, 968
rendering issues solvable by, 965
RTF format, 968
unformatted text, pasting Excel data as, 968

pasting
after Copy command, 198–202
array values, 208
charts into Word documents, 975
Ctrl+V shortcut, 198
cutting for, 203
embedded defaults for Paste, 957
Excel ranges into Word, 963–964
formulas only, 204, 205
hyperlinks, 209–210
images, 396–397
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Linked Picture command, 434–435
linked workbook cells, 521–522
links, 207, 957
math operators, using, 206–207
multiple cells, into, 200–201
names into formulas, 492–493
Object options of Paste Special, 957
Paste All command, 200
Paste Link command, 957
Paste Options menu items, 202
Paste Special command, 203–209, 396–397, 956–957
permissions, 173–174
pictures of the worksheet, 434–435
PowerPoint slides, 956–957
previews of, 5–6, 199
Refreshable Web Query command, 855
Shift key with, 211–212
Show Paste Options Button option, 229
skipping blank cells, 207
themes, 205
transposing rows and columns during, 202, 208–209
values only, 202, 204
Web data to Excel, 855
Word document objects for embedding, 954–956

patterned distributions, 629–630
payments (PMT) function, 584–585, 636, 1056
PDF file format, 71, 462–464
PEARSON (product moment correlation coefficient) 

function, 1055
Pearson product moment squared (RSQ) function, 1061
percentages

% (percent sign), data entry with, 152, 323
Enable Automatic Percent Entry option, 228
formatting percentages, 330
Percentage format, 228
PivotTable, calculating in, 801–804

percentile statistics
PERCENTILE functions, 605–606, 1055
PERCENTRANK functions, 604–605, 1056
Rank And Percentile tool, 623–625

permissions
adding users and groups, 174–175
IRM for setting. See IRM (Information Rights Management)
pasting for editing ranges, 173–174
Permissions dialog box, 174–175
Windows Live SkyDrive, 883–886

PERMUT (permutations) function, 1056
personal information security, 121–122
Personal Macro Workbooks, 914
perspective 3-D graphics effects, 417
phishing, 116
phone number format, 333
PHONETIC function, 1056
PI function, 1056
pi, square root of (SQRTPI function), 1063
Pick From Drop Down List command, 250
Picture formats, pasting Excel data into Word as, 968
Picture option for Excel in Word, 964

Picture Tools
3-D formatting options, 403
Adjust group, 401–402
Artistic Effects menu, 403, 406
capabilities of, 400
Change Picture command, 406
color correction, 403–405
cropping images, 403, 412
Format Picture dialog box, 401–404
Recolor options, 405
Remove Background command, 405–406
shadows in graphic objects, 403
sizing images, 404
transparency, 405–406

pictures. See graphics
PivotCharts

advantages of, 811
creating, 811–812
filtering data before creation, 812
linkage to PivotTables, 811, 813
multilevel categories with, 722–723
pivoting, 812
Tools tab for, 812

PivotTables
Access tables, importing entire, 819–820
ad hoc item grouping, 808
advantages of, 775–779
calculated items, 804–807
centering field labels, 787–788
charts from. See PivotCharts
Choose Fields To Add To Report area, 781–782
Column Labels box, 781–782, 788
Compact default layout, 786
Connection dialog box, 795
creation methods and options, 780–783
creation requirements, 779
custom calculations for Values areas, 801–804
data sources for, 775
date and time, grouping by, 809–810
default field positioning, 781
defined, 775
Design tab of PivotTable Tools, 786–787
direct dragging fields option, 785
empty cells, formatting, 787
error cells, formatting, 787
Excel 2007 improvements, 11–12
external data, creating with, 816
External Data Properties dialog box, 817–819
external data sources, filtering before table creation, 

796–800
Field List window, 780, 783–785
Field List window for filtering, 796–800
Field Settings dialog box, 790
fields, filtering before adding, 780
fields, pivoting, 783–784
fields, subtotal customization for, 790
filtering. See filtering PivotTables
formatting overview, 787
functions, value field summary options, 801
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GETPIVOTDATA function, 1041
grouping, default, 808
hiding elements of, 788
hyperlinks not assignable to cells, 945
Index calculation, 802
Insert Calculated Field dialog box, 805
Insert Calculated Item dialog box, 806
layout selection, 786
lists vs. tables as data sources, 779
maximums for, 11–12
multiple summary functions, applying, 801
naming value fields, 800
Number Format options, 786
outline controls, 788
Outline layout, 786
PivotCharts from. See PivotCharts
pivoting basics, 783–785
rearranging fields, 783–785
refreshing data, 785
Report Filter, 781, 793–794
Row Labels box, 781, 788
Show Values As list of calculations, 801–804
single-axis examples, 776–777
slicers, 7–8
slicers for filtering, 794–796
Solve Order information, 807
sorting on fields, 792
Styles gallery, 787
subtotals display, 789–791
summary function options, 800–804
summary value details, obtaining, 811
Tabular layout, 786
totals display, 789
two-axis examples, 777–779
updates, sorting automatically during, 792
Value Field Settings command, 800–801
Values area defaults, 800
Values box, 781–782

planning worksheets
audiences, considerations for, 132–133
expansion, allowing for, 135–136
imported data, reliance on, 134
printing, designing for, 131–132
row or column choice for data, 129–130
summary sheets, 131–133
survivability of worksheet designs, 133

PMT (payments) function, 584–585, 636, 1056
point sizes of fonts, 352
points, graphic, 378–381
Poisson distributions

POISSON.DIST function, 1057
random number generation with, 628–629

Polynomial trendlines, 724
pop-up labels. See ScreenTips
portable document creation, 462–464
portrait orientation, 438
positioning graphic objects, 423–429
POWER function, 1057

power series, SERIESSUM function, 1062
PowerPoint, pasting from, 956–957
PPMT (principal payments) function, 586, 1057
precedence of operators, 467–468
precedent cells

definition of, 268
selection of, 148

precision, numeric
rounding issues, 511
rules for, 511–512
settings, 153

present value (PV) function, 582–583, 1058
previews

Enable Live Preview option, 102
pastes, of, 5–6, 199
print, 459–461

PRICE functions, 593, 1057–1058
principal payments

CUMPRINC (cumulative principal paid) function, 1032
PPMT function, 586, 1057

print settings options, 864
printing

A4 paper auto resizing, 439
Backstage view print screens, 455–457
collation option, 456
color to grayscale, 454
comments, 274, 454
designing worksheets for, 131–132
draft quality, 454
driver options, 456
error code options, 454
grids, 453
height control, 440
landscape vs. portrait formats, 132
margins for, 441, 443–444, 457, 461
number of copies, specifying, 456
order options for large ranges, 455
Page Layout view, 441–442
paper size, setting, 438, 456
previewing, 459–461
Print Object option, 426
Print Titles feature, 131, 452–453
properties, printer, 456
quality options, 439
Quick Print button, 457
restricting permissions for shared workbooks, 877
scaling to fit, 440–441, 457
shared workbooks settings for, 864
specified print areas, 451–452
width control, 440

privacy options, 119–122
PRN format, 70
PROB (probability) function, 1058
probability

BETA.DIST and .INV functions, 1025
binomial distributions, 628, 1026
chi-squared distribution functions, 1027
COMBIN function, 540, 1028
CONFIDENCE.NORM function, 1028
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CONFIDENCE.T function, 1029
ERF (error) functions, 1037
EXPON.DIST function, 1038
F probability functions, 1038, 1039, 1040
F.DIST functions, 1038
F.INV functions, 1039
FISHER functions, 1039
GAMMA functions, 1041
HYPGEOM.DIST function, 1043
LOGNORM functions, 1048
NEGBINOM.DIST, 1052
NORM (normal distribution) functions, 1052–1053
PERMUT (permutations) function, 1056
POISSON.DIST function, 1057
PROB function, 1058
random number generation. See random numbers
Student’s t-distribution, 1029, 1065
WEIBULL.DIST function, 1069

PRODUCT function
arguments of, 539
PivotTable value fields with, 800–801
syntax for, 1058

programming Excel. See macros
PROPER function, 544, 547, 1058
properties

custom, linking to cells, 60–61
file summary information, adding, 58–59

properties, VBA
With . . . End With statements, 910–911
defined, 904–905
FormulaR1C1 property, 904, 907–908

protection
allowed users and actions, 170–171
allowing access to specific ranges, 173–175
Cell Style attribute for, 305
enabling, 170–171
hiding with, 176
Mark As Final command, 192–194
object protection, 429
password assignment to, 177
pasting permissions, 173–174
Protect Shared Workbook command, 867
Protected View option, 63
protecting files with passwords, 57–58, 65
unlocking individual cells, 171–172
workbooks, of, 172, 190–191

publishers, trusted, 113
PV (present value) function, 582–583, 1058
P-values, Z.TEST function, 1070

Q
quarter, grouping by in PivotTables, 809–810
QUARTILE functions, 605–606, 1058
queries to external data

adding fields, 837
adding tables to the Query data pane, 837
aggregation calculations with, 845–848
criteria, menu commands for creating, 843–844
database selection, 830

editing queries, 835–839
field selection, 830–831
filtering result sets, 840–844
hiding fields without deleting them, 838
join operations, 837
Microsoft Query for. See Microsoft Query
moving fields, 838
multiple field comparison filters, 844
ODC files as holders for, 815
opening saved, 834–835
parameter-based queries, 848–849
Query toolbar Sort icon, 839
removing fields from the data pane, 838
renaming fields, 838
result sets, 836
returning results to Excel, 849
saving queries, 833–834, 849
sorting data while importing, 832–833, 838–839
source types for, 829
toolbar buttons, Microsoft Query, 840
unique entries, limiting result set to, 844
Web data. See Web queries

Query, Microsoft. See Microsoft Query
Query Wizard

Choose Columns page, 830–831
filtering records to import, 831–832
join operations with, 831
relationships, filtering on, 831–832
saving queries, 833–834
Sort Order page, 832–833
View Data Or Edit Query In Microsoft Query option, 834

question mark (?)
Help icons, 77
wildcard filter character, 752

Quick Access Toolbar
active workbook only customization option, 99–100
adding tools to, 93–96, 737
Add-Ins tab of ribbon, 101
advantages over ribbon, 92
For All Documents customization option, 99
Choose Commands From drop-down list items, 96
command modifiers, 86
Compare And Merge Workbooks command, adding to, 

869–870
Customize Quick Access Toolbar buttons, 92, 95, 98
default tools in, 93
display of, 34
exporting, 99
importing, 99, 101
legacy customized, importing, 101
macros, adding buttons for, 98–99
mini-ribbon creation with, 97
More Controls buttons, 97–98
Options dialog box for customizing, 95–99
positioning, 92–93
removing individual buttons, 101
removing tools, 94
resetting, 99–100
restoring, 100–101
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Quick Access Toolbar, continued
Save command, 49
saving, 99–100
Separators, 95–96

Quick Print button, 457
Quick Watch, VBA, 936
QUOTIENT function, 1059

R
radians

DEGREES function, 1034
RADIANS function, 1059

Random Number Generation tool
Bernoulli distributions, 628
binomial distributions, 628
discrete distributions, 629
Distribution list parameter dependence, 627
distributions available with, 626
normal distributions, 627–628
patterned distributions, 629–630
Poisson distributions, 628–629
seed values, 626–627
uniform distributions, 627

random numbers
freezing sets of, 626
RAND, RANDBETWEEN functions, 540, 626, 1059
Random Number Generation tool, 626–630

range finders, 226
range, statistical, 619
ranges

active cells in, 140
allowing access to specific, 173–175
arrays, selection for, 513–514
automatic range expansion, 538
clearing formatting from, 299
data entry in, 157
defined, 140
deleting, 217–220
e-mail, sending by, 873
functions, in arguments of, 531
hyperlinks to, creating, 947–948
inserting, 214–216
naming, 483–486
nonadjacent, selecting, 141–142
PivotTables, as data sources for, 779
Range objects, VBA, 904
Select All command, 140
selecting by mouse dragging, 140
sorting, 741
status bar display of data for, 481
table, determining if a range is a, 733
tables, undoing, 732

Range().Select statements, 904
ranking functions

CUBERANKEDMEMBER, 1031
LARGE function, 606, 1047
PERCENTILE functions, 605–606, 1055
PERCENTRANK functions, 604–605, 1056
QUARTILE functions, 605–606, 1058

Rank And Percentile tool, 623–625
RANK functions, 606, 1059
SMALL function, 606, 1062

RATE function, 586–587, 1059
read-only, opening files as, 63
real-time data, COM automation, RTD function, 1061
recalculation. See calculation
RECEIVED function, 593, 1060
recording macros

adding code to existing macros, 909–911
argument assignments, 909
basic steps for, 898–899
descriptions for, 899
displaying code generated by, 902
Edit button, 899
excess code generated by, 914
guidelines for automation, 929
incomplete actions not recorded, 901
Macro dialog box, 899–900
making available for other workbooks, 914
modules created by, 901–902
name assignment, 898
Personal Macro Workbooks, 914
Record Macros command, 898–899
relative references with, 900
running macros, 899
shortcut key assignment, 899
Stop Recording button, 899
subroutines, 912–913
troubleshooting, 901

records, database, 135. See also databases
recovery

AutoRecover information, 78–79
of corrupted files, 64–66
version management, 79–81

rectangles, drawing, 376–377
Redo command, 158
redoing

Ctrl+Y shortcut, 198
drop-down list of actions, 224–225

reference functions. See lookup and reference functions
reference operators, 502
references

@ tag for current row, 767–768
3-D, 496–497
absolute. See absolute references
#All tag, 768–769
bracketed names in table formulas, 763–764
to cells in other workbooks, 471
to cells in other worksheets, 470–471
circular references, 508–511
computed filter criteria, guidelines for, 759–761
copying, effects on, 472–476
cutting and pasting formulas issues, 522
#Data tag, 768–769
dependents, 268
F4 key, 470
Formula Auditing group buttons for, 267
formulas, using in, 468–469
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#Headers tag, 768–769
implicit intersection of, 765–767
inserting arguments of functions with mouse devices, 535
mixed, 470, 475, 505
name changes, worksheet and workbook, 476
named cells, editing for, 486
named formula references, 490–491
names, replacing all with, 494–495
natural-language formulas feature discontinued, 499
precedents, 268–270
range finders, 226
relative. See relative references
Remove Arrows command, 267, 269
row-column style, 472
rows, explicitly to current in table formulas, 767–768
sorting issues with, 743–744
syntax, 476
table formulas, auto naming of, 763–765
three-dimensional, 491
total rows, to, 766–767
#Totals tag, 768–769
Trace Dependents command, 268–269
Trace Error command, 270–271
Trace Precedents command, 269–270
tracing, 267–272

Refreshable Web Query command, 855
regional (geographic) settings, 566, 570
regions

Ctrl+Arrow keystrokes, 138
definition of, 137
End mode, 139
Go To dialog box, selecting with, 146
keyboard mode indicators, table of, 138–139
keyboard navigation of, 138
keyboard shortcuts for navigation, 139–140
mouse navigation of, 138–139
ranges, compared to, 140
selection techniques, 143
tables, formatting as, 293

registration (activation), 17–18
regression

Competitive Market Analysis (CMA), 612
exponential, 608, 615–616
FORECAST function, 615, 1040
GROWTH function, 616, 1041
linear, 607, 609–615
LINEST function, 610–612, 1048
LOGEST function, 611, 616, 1048
multiple, 607, 609
SLOPE function, 615, 1062
STEYX function, 615, 1063
TREND function, 613–614, 1066
types of regression, 607–608

relational operators
= (equality), 522
Advanced Filter command with, 756–758
filtering with, 751–752

relative references
copying, effect on, 472–473

cutting and pasting formulas issues, 522
defined, 469
macro use of, 900
sorting, guidelines for, 744

remote computers, saving files to, 859
Remove Arrows command, 267, 269
Remove Duplicates command, 762–763
Remove Hyperlink command, 947
repairing files. See recovery
repeating actions, 225
REPLACE function, 549, 1060
REPLACEB function, 1060
replacing

Find And Replace dialog box, 240, 245
Replace command, 244
shorthand, AutoCorrect with, 250
wildcards in Replace With box, 246

Report Filter Axis for PivotTables, 793–794
reports. See Page Layout tab; printing
REPT function, 1060
reputable developers, definition of, 111–112
Research Task Pane, 120
Reset Window Position button, 184
resetting ribbon, 91–92
resizing workbook windows, 25–26
Resolve Conflicts dialog box, 862–863
Restore buttons, 25
Resume statements, 939–940
Return Data button, 840
Review tab

Accept/Reject Changes command, 868
Comments group, 272–274. See also comments
Edit Comment button, 272, 273
Highlight Changes command, 865
Protect Shared Workbook command, 867
Protect Sheet command, 170–171
Protect Workbook command, 172, 190–191
Research command, 252–253
Research Options, 253–254
Select Changes To Accept Or Reject box, 868
Send For Review command, 873–874
Share Workbook command, 860, 870
Spelling command, 251–252
Thesaurus, 252
Track Changes command, 862, 865
Translate command, 252

ribbon
Add-Ins tab of, 101. See also add-ins
command groups, adding to custom tabs, 89–91
command groups of, 83
command modifiers, 86–87
command ScreenTips, 86
commands not in, viewing, 85
context sensitive tool display, 33
customization as new feature, 5
customization overview, 83–86
Data tab. See Data tab
Dialog Box Launchers, 29–30
drop-down lists for, 28–29, 87
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ribbon, continued
dynamic tabs in, 85
Edit controls, 87
ellipsis (...) commands, 30
Excel 2003 menu to ribbon command reference, 983–999
File tab. See File tab
Formulas tab. See Formulas tab
galleries, 30–31
group icon, 87
groups, custom, 88–89
hiding, 28
Home tab. See Home tab
Insert tab. See Insert tab
item identification for customization, 86–87
live preview functionality, 30–32
Office Button replaced by File tab, 4
Options dialog box for customizing, 83–92
organization of, 27
Page Layout tab. See Page Layout tab
Quick Access Toolbar mini-ribbon, 97
resetting, 91–92
Review tab. See Review tab
saving custom, 91–92
ScreenTips for, 27–28
split buttons, 87
structure of, viewing, 83
tabs, creating custom, 87–88
toggles, 29

Ribbon Group Toolbar file, 97
Rich Text Format (RTF), 968
right aligning text, 344–346
RIGHT function, 548–549, 1060
RMS (Microsoft Windows Rights Management Services), 

874
ROMAN (Roman numeral) function, 1060
rotation 3-D graphics effects, 417
rounding

CEILING function, 542–543, 1026
EVEN function, 542, 1038
FIXED function, 1039
FLOOR function, 542–543, 1040
INT function, 543, 1045
MROUND function, 543, 1051
ODD function, 542, 1054
precision issues with formulas, 153
ROUND function, 531, 542, 921, 1061
ROUNDDOWN function, 542, 1061
ROUNDUP function, 542, 1061
Set Precision As Displayed option, 511
TRUNC (truncate decimals) function, 543, 1067

rows
@ tag for referencing current, 767–768
AutoFit Row Height command, 362
banding, 295
deleting, 217–220
designing, 129–130
duplicate elimination, 762–763
elements of style for tables, 773
explicitly referencing current in table formulas, 767–768

grouping, 280
height adjustment with text wrapping, 154
height option of Format menu, 362
heights, dragging, 364
hiding, 176, 365
inserting, 212–214
maximum number allowed, 11
multiple, auto setting heights, 364
nonadjacent, selecting, 142
Page Layout view, height adjustment in, 441
range of, 20
Row Differences option, 149
ROW function, 562, 1061
ROWS function, 562, 1061
selecting entire, 142–143
selecting, keyboard shortcut for, 214
selecting within tables, 734
shortcut menu for, 212–213
special item specifiers for, 500–502
titles, printing on every page, 452–453
total, adding to tables, 736–737
total, referencing, 766–767
ungrouping, 280

RSQ (Pearson product moment squared) function, 1061
RTD (real-time data, COM automation) function, 1061
RTF (Rich Text Format), 968
running totals, PivotTable, 801–804
run-time errors, VBA, 937–940

S
Sampling tool, 630–631
Save As command

exporting files with, 67
file type selection, 54
Web formats with, 69

Save command, 49–50
Save Workspace command, 60
saving

Compatibility Checker with, 52–53
custom number formats, 335
default location for, setting, 49
exporting files with Save As command, 67
macros, file formats for, 898
network computers, to, 859
PDF file format, as, 462–464
Save As Type option, 54
Save Files In This Format options, 898
Save To SharePoint command, 883
Save To Web command, 881
Save Workspace command, 60, 181
shared files, 861–862
SharePoint, to, 883
SkyDrive, files to, 881–883
templates, 369
view settings, 189
workbooks, 49–50, 182
XPS file format, as, 462–464

scaling to fit printouts, 440–441, 457
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Scenario Manager
adding new scenarios, 646
browsing scenarios, 645–646
capabilities of, 641–642
changing cells, defining, 644–645
comment modifications, 647
defining scenarios, 643–645
editing scenarios, 646
merging scenarios, 647–649
naming cells recommended, 642
PivotTable reports, 651–652
Prevent Changes option, 644
reports, 649–652
saving scenarios, 646
Scenario Values dialog box, 644–645
Show command, 645–646
Solver optimization with, 665
tracking changes in scenarios, 646
version control feature, 642

schema files, XML, 825
schemes, color, 102
scientific notation, 151–153, 332
screenshots, 431–433
ScreenTips

accessibility feature, as a, 108
accessing, 72–73
function ScreenTips, 109, 530
hyperlinks, creating for, 945
style options, 102

Scribble tool, 378–381
scrolling

as an accessibility feature, 109
right-click scroll bar menu, 24
scroll box navigation, 24–25
Scroll Lock, 25, 139, 140
scroll thumbs, 24
Synchronous Scrolling button, 184
wheel mice for, 23

SDI (single document interface), 26, 180
SEARCH function, 547–548, 1061
SEARCHB function, 1062
searching Help system contents, 77–78
searching in worksheets. See finding
SECOND function, 577, 1062
securities analysis functions

ACCRINT, ACCRINTM functions, 592–593
arguments for, 591
COUP (coupon) functions, 595, 1030
DISC (discount rate) function, 594, 1035
discounted securities price (PRICEDISC) function, 593, 1057
DOLLARDE, DOLLARFR functions, 592, 1035
DURATION function, 596, 1036
INTRATE function, 593, 1045
MDURATION function, 596, 1050
NOMINAL function, 1052
ODDFPRICE function, 1054
PRICE functions, 593, 1057–1058
RECEIVED function, 593, 1060
TBILL functions, 594–595, 1065

YIELD functions, 594, 1070
security

ActiveX control settings, 115–116
add-ins, 115
alert triggers, 111–113
data connection security warnings, 817
digital signatures, 121–125
draft versions, deleting all, 79
external content options, 117–118
file format attacks, 121
locations, trusted, 114
macros, configuration for, 895–898
Message Bar messages, 112–113
password protection. See passwords
permissions, 173–175, 883–886
personal information, removing from workbooks, 121–122
spoofed Web site detection option, 120
Trust Center options for. See Trust Center
trusted locations for, 897–898
trusted publishers, managing list of, 113

Select All command, 140
Select Case structures, VBA, 932
Select Changes To Accept Or Reject dialog box, 868
selecting

arrays, 514
cells. See selecting cells
graphic objects, 377
hyperlinks without triggering, 950
multiple files to open, 62
objects, 421–423
ranges, 140
regions, 143
Select method, VBA, 904
text within shapes, 420

selecting cells
active cells in selected ranges, 140
Add To Selection mode, 138
conditionally formatted cell selection, 146
conditionally formatted cells, 319
data validation cell selection, 146
Extended Selection mode, 138
formula cells, selecting all, 144
Go To for. See Go To dialog box
last cell selection, 146
mouse selection methods, 140–142
moving among cells without selection loss, 147
nonadjacent ranges, 141–142
objects, selecting all, 146
ranges of, 140
Select All command, 140
Shift+click method, 140
Visible Cells Only option, 279
visible cells only selection, 146
zooming with, 141

Selection objects, VBA, 911
Selection Pane button, 424–425
selection rectangles, 138, 221–222
Send Backward button, 423–424
Send For Review command, 873–874
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Send Using E-Mail command, 872–873
separators, 228–229
serial values of dates and times, 565
series. See data series
Series command, 568–569
SERIESSUM function, 1062
service packs, 18–20
Set Precision As Displayed option, 153
settings, general. See Options dialog box, Excel
shadows in graphic objects, 403, 407–408, 414–415
Shape Outline menu, 413
Shape Styles for charts, 684–685
shapes

additional formatting for objects, 375
constrained graphics, drawing, 376–377
Curve tool, 378–381
drawing basics, 374–375
drawing layer independence, 377
Drawing Tools Format tab, 375, 387–388, 407–408
Edit Points command, 379
Freeform tool, 378–381
gallery, 381–385
grids for drawing, 377
hyperlinks, assigning to, 949
lines, drawing, 378
moving objects, 375
opening the Shapes gallery, 374
point types, 380–381
references of drawn shapes, 374
resizing objects, 375
Scribble tool, 378–381
selecting objects, 377
Set As Default Shape command, 414
Shape Effects menu, 407–408
Shape Fill color palette, 407
Shape Outline palette, 407
Shapes gallery, 381–385
vertex handles of curves, 380

Shared Workbook command, 49
SharePoint. See Microsoft SharePoint
sharing

access control with. See IRM (Information Rights 
Management)

advanced sharing options, 863–864
allowing changes by multiple simultaneous users, 861–863, 

870
The Changes Being Saved Win option, 864
closing shared sessions, 869
conflict management, 861–863
e-mail, sharing workbooks by, 872–874
filtering options, 864
formatting of changed cells, 861
guidelines, establishing, 863
history worksheets, 867
Keep Change History For specification, 870
legacy Excel versions, issues with, 862
limitations of, 862
merging workbooks, 870–871
multiple workbooks, combining changes from, 869–871

password protection of workbooks, 865
print settings options, 864
Protect Shared Workbook command, 867
Resolve Conflicts dialog box, 862–863
reviewing changes, 868
seeing just other users’ changes option, 864
Send For Review command, 873–874
SkyDrive folders for, 884–886
tracking changes in shared workbooks, 863–868
update options, 864
user names, editing, 861
Web Apps for, 887–892
workbooks on networks, 860–863

sharpening graphics, 401–402
Shift+Spacebar, 214
shortcut menus, 36–37
Show All Windows In The Taskbar check box, 26, 180
Show group, View tab, 103–104
Show Mini Toolbar On Selection option, 102–103
Shrink To Fit option, 350–351
SIGN function, 1062
Signatures task pane, 124
simulations, financial. See Solver; what-if analysis tools
SIN (sine) function, 1062
single document interface (SDI), 26, 180
SINH (hyperbolic sine) function, 1062
sizing

cells, 361–365
images, 404
shape objects, 426

skewness, 619, 1062
SkyDrive, Windows Live

browser interface of, 883–884
Excel Web App, opening workbooks in, 887–892
folder management, 883–886
logons, 881–882
permissions, 883–886, 890–891
saving files to, 881–883
sharing files with, 884–886
signing up for Windows Live IDs, 881–882
storage capability of, 881
user share notifications, 886

slash (/)
data entries with, 152
formatting resulting from, 323
precedence as division sign, 467–468

slicers, 7–8, 794–796
SLN (straight-line depreciation) function, 589, 1062
SLOPE function (regression), 615, 1062
SMALL function, 606, 1062
SmartArt graphics

as 2007 new feature, 10
buttons for creating graphics, 393
categories of approaches, 389–390
components of, 390
Excel Web App issues with, 892
formatting tools for, 408–409
improved in Excel 2010, 10
launching, 389
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Picture category, 390, 391
Styles gallery, 392
text pane, 390–391

Snap To Grid command, 428
Snap To Shape command, 429
Social Security number formatting, 333
Solver

Answer reports, 665
binary option, 661
capabilities of, 655–656
Constraint Precision setting, 662
constraints, 657, 658–661
Evolutionary method, 661–662
GRG Nonlinear method, 661–662
installing, 655
integer constraint specification, 660–661, 662
iteration results, viewing, 663–664
launching, 657
Limits reports, 666
linear models, 663
Max Time and Iterations, 662
methods drop-down list, 661
nonlinear problem guidelines, 663
objectives, 657–658
reports, 665–666
saving models, 664
Scenario Manager with, 665
Sensitivity reports, 665
Simplex LP method, 661, 663
Solver Parameters dialog box, 657, 658–659
starting value issues, 663
troubleshooting, 666
variable cells, 657, 658

Sort & Filter group
Filter button, 749
Sort A To Z button, 738
Sort button, 739, 741

sorting
case-sensitivity of, 746–747
characters, sort order of, 745
by columns, 741–743
date evaluation for, 745, 746
external data being imported, 832–833, 838–839
files for opening, 62
formulas, issues with, 743–744
header rows, excepting, 739
levels of, 11, 739–740
lists, 737–738
multiple columns, on, 739–740
order dependence on value types, 745
overview of, 737–738
parts of lists, 741
PivotTables, on fields of, 792
query data, 838–839
ranges, 741
single columns, on, 738–739
Sort & Filter group commands, navigating to, 738–739
Sort Dialog box, 739

Sort Left To Right option, 741–742
table data, 729
underlying values used for, 745

sound feedback for accessibility, 108
space character

as intersection operator, 496, 502
structured reference rules for, 501

sparklines
axes options, 694–695
color selection, 692
compared to chart objects, 689
creating single, 690
deleting, 695
Design tab for, 692
emphasis options, 692–693
expanding sets of, 691
group creation, 691
line thickness options, 692
marker options, 692–693
as new feature in Excel 2010, 5
scaling options, 694–695
text, adding to, 695
time-scaling option, 695
types of charts available, 690
Win/Loss, 690

special character entry guidelines, 151–152
Special formats, 332–333
special item specifiers, 499–502
specifiers. See structured references
spelling, checking, 251–252
split buttons, 87
Split command, 164–165
spoofed Web site detection, 120
Spreadsheet ML, 55
spyware, 116
SQL Server, 874
square roots

IMSQRT function, 1044
SQRT (square root) function, 1062
SQRTPI (pi, square root of) function, 1063

squares
SUMSQ function, 1064
SUMX functions, 1064

standard deviation
defined, 607
Descriptive Statistics tool for, 619
DSTDEV, DSTDEVP functions, 1036
LOGNORM functions, 1048
NORM.DIST function, 1052
NORM.INV function, 1053
NORM.S.DIST function, 1053
NORM.S.INV function, 1053
PivotTable value fields using STDDEV functions, 800–801
STANDARDIZE function, 1063
STDEVA function, 1063
STDEV.P function, 608, 1063
STDEVPA function, 1063
STDEV.S function, 607–608, 1063
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standard error, 619
starting Excel

activation, 17–18
opening files on startup, 64

startup workbook default configuration, 179
statistics

A functions, 604
Analysis Toolpak tools. See Analysis Toolpak
AVEDEV (average of absolute deviations), 1024
AVERAGE functions, 544, 602
AVERAGEIF(S) functions, 602
BETA.DIST, 1025
BETA.INV, 1025
BINOM (binomial distribution) functions, 628, 1026
chi-squared distribution functions, 1027
compatibility functions, 603
confidence, 619
CONFIDENCE.NORM function, 1028
CONFIDENCE.T function, 1029
CORREL (correlation coefficient) function, 1029
COUNT function, 603, 736–737, 800–801, 845–848, 1028
COVARIANCE functions, 9, 1030
Descriptive Statistics tool, 618–619
DEVSQ function, 1034
DMAX function, 1035
DMIN function, 1035
DSTDEV, DSTDEVP functions, 1036
DVAR, DVARP functions, 1036
ERF (error) functions, 1037
error bars for charts, 725
EXPON.DIST function, 1038
F probability functions, 1038, 1039, 1040
FACT (factorial) function, 1038
F.DIST functions, 1038
F.INV functions, 1039
FREQUENCY function, 622–623, 1040
GAMMA functions, 1041
GEOMEAN function, 1041
Histogram tool, 619–622
HYPGEOM.DIST function, 1043
KURT (kurtosis) function, 619, 1044
LARGE function, 606, 1047
LOGNORM functions, 1048
MAX function, 603, 606, 1049
MEDIAN function, 603–606, 619, 760–761, 1050
MIN function, 603, 606, 800–801, 845–848, 1050
MODE functions, 603, 619, 1051
MULTINOMIAL function, 1052
NEGBINOM.DIST, 1052
new distribution functions for 2010, 9
NORM (normal distribution) functions, 1052–1053
PERCENTILE functions, 605–606, 1055
PERCENTRANK functions, 604–605, 1056
PERMUT (permutations) function, 1056
POISSON.DIST function, 1057
PROB function, 1058
QUARTILE functions, 605–606, 1058
range, 619

Rank And Percentile tool, 623–625
RANK functions, 606, 1059
regression, calculating. See regression
RSQ (Pearson product moment squared) function, 1061
sample vs. whole population statistics, 607
Sampling tool, 630–631
SKEW function, 1062
skewness, 619
SMALL function, 606, 1062
standard deviation functions. See standard deviation
standard error, 619
STANDARDIZE function, 1063
Student’s t-distribution, 1029, 1065
SUMX functions, 1064
T.DIST (Student’s t-distribution) functions, 1065
T.INV (inverse Student’s t-distribution) functions, 1066
TRIMMEAN function, 1067
T.TEST (Student’s t-test), 1067
VARA function, 1067
variance functions, 607–608
WEIBULL.DIST function, 1069
Z.TEST function, 1070

status bar
AutoCalculate feature, 41
calculating indicator, 506
Caps Lock mode, 139
Circular References indicator, 508–511
keyboard mode indicators, table of, 138–139
Num Lock mode, 139
options for, 39–41
Permission button, 879
sums, displayed in, 481

STDDEV function in PivotTable value fields, 800–801
STDDEVP function in PivotTable value fields, 800–801
STDEVA function, 1063
STDEV.P function, 608, 1063
STDEVPA function, 1063
STDEV.S function, 607–608, 1063
step function, 1041
STEYX function, 615, 1063
stock market charts, 715, 726. See also securities analysis 

functions
storing files on the Internet. See SkyDrive, Windows Live
straight-line depreciation (SLN) function, 589, 1062
strings

CONCATENATE function, 550–551, 1028
defined, 240. See also text values
EXACT function, 546, 1038
FIND functions, 547, 1039
LEFT function, 548–549, 1047
MID function, 549, 1050
MIDB function, 1050
parsing Clipboard text strings, 824
REPLACE function, 549, 1060
REPT function, 1060
RIGHT function, 548–549, 1060
SUBSTITUTE function, 549, 1063
substring functions, 547–549
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text functions for, 544–550, 1066
UPPER function, 544, 547, 1067
VALUE function, 1067

structure, protecting, 191, 193
structured references

: (colons), 502
, (commas), 502
@ tag for current row, 767–768
advantages of, 498, 500
#All tag, 768–769
AutoComplete with, 503
automatic creation with Table button, 498
calculated columns, 499
column headers as text strings, 501
column specifiers, 499
components of, 498, 500–501
copying ranges of, 504–505
data area specifiers, 502
#Data tag, 768–769
disabling automatic creation of, 499
example formula, 500
fill handles with, 504–505
filling ranges with, 504–505
header specifiers, 502
#Headers tag, 768–769
Help information for, 769
intersection operators, 502
mixed with cell references, 504–505
qualified vs. unqualified, 503
range operators (colons), 502
reference operators in, 502
space characters in, 501
special characters in, 501
special item specifiers, 499–501, 502
specifiers, 498, 501–502
syntax for, 501
table names for, 498–499
table specifiers, 500
tables as traps for fills, 504–505
total row specifiers, 502
#Totals tag, 768–769
union operators (commas), 502

structured references in tables, 729
Student’s t-distribution, 1029, 1065, 1066, 1067
styles

cell. See Cell Styles
chart, selecting, 674–675
customizing for tables, 772–774
elements of style for tables, 773
Normal, 772
PivotTable gallery of, 787
slicers, for, 796
tables formatted with, 771–772
theme effects on, 771–772

Styles group of Home tab, Cell Styles button, 303
Sub (subroutine) statements, VBA, 903, 912–913
SUBSTITUTE function, 549, 1063
substring functions, 547–549

subtotals
PivotTable, 789–791
SUBTOTAL function, 736–737, 748–749, 1063

subtraction
– sign precedence, 467–468
IMSUB function, 1044

SUM function. See also aggregation functions
@ tag limits to current row, 767–768
Alt+= shortcut, 480–481
arguments for, 537
automatic range expansion, 538
DSUM variation, 1036
IMSUM function, 1044
Microsoft Query totals with, 845–848
PivotTable value fields with, 800–801
products, summing, 539, 1064
structured reference example, 500
Sum button for, 538
syntax of, 1064

SUMIF, SUMIFS functions, 523–524, 538–539, 551, 1064
summary information, adding to workbooks, 58–59
summary sheets, 131–133
Summary tab for file properties, 58–59
SUMPRODUCT function, 539, 1064
SUMSQ function, 1064
SUMX functions, 1064
surface 3-D graphics effects, 417
survivability of worksheet designs, 133
Switch Row/Column command (charts), 672–673
SYD function, 590, 1065
SYLK file format, 71
symbol entry, 156–157
Sync, Windows Live, 887
Synchronous Scrolling button, 184
system tray, workbook icons open in, 180

T
T (return text) function, 1065
tab split boxes, 23–24
TABLE function, 637, 641
Table Tools Design tab

Convert To Range command, 733
styles, 772–774
Summarize With PivotTable command, 780
Total Row option, 736–737

tables
@ tag for current row references, 767–768
Access tables, importing entire, 819–820
ad hoc mappings of XML elements to columns, 826–828
adding rows or columns, 734–735
#All tag, 768–769
Apply Names command with, 494–495
autoexpansion of, 729
Body fonts in, 771
boundaries for, 294
calculated columns, 499
chart data tables, 670, 679
color schemes, changing for, 771
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tables, continued
column specifiers, 499, 501
columns, guidelines for data in, 731
columns, selecting, 734
Compatibility mode, feature issues in, 732
converting to ranges, 298–299
creating with Format As Table command, 292–293
creation methods, 731–732
customized styles for, 772–774
data connections, creating with, 816–817
Data Tables. See Data Table what-if analysis
#Data tag, 768–769
default headers, 732
defined, 731
Design tab for. See Table Tools Design tab
determining if a cell is in a table, 733
duplicate row data, removing, 730
elements of style for, 773
enlarging, 296
expanding, 734–735
explicitly referencing current rows, 767–768
extending formatting in, 239
external data, creating with, 816–817
External Data Properties dialog box, 817–819
filtering, 729, 756
finding specific values in, 525–526
fonts, changing for themes, 771, 774
formatting. See formatting tables
formula replication, 730
formula sorting issues, 743–744
formulas, auto copying to columns, 763–764
formulas in, ease of use features, 763
headers, overwriting defaults, 732
#Headers tag, 768–769
Heading font, using for, 772
keyboard shortcuts for, 734
lookup functions with, 555–558
Modify Table Quick Style dialog box, 772–774
naming, 498–499, 733–734
new features of, 729–731
ranges, converting back to ordinary, 732
referencing total rows, 766–767
requirements for, 731
rows of labels, guidelines for, 731
selecting within, 734
sorting by columns, 741–743
sorting data in, 729
sorting on columns, 738–740
sorting parts of lists, 741
special items areas, 499
specifiers, 500–503
structured references in, 729. See also structured references
styles with, 730, 771–772, 774
SUBTOTAL function in, 736–737, 748–749, 1063
themes with, 771–772
total function options, 736–737
total rows, adding, 736–737
#Totals tag, 768–769
XML tables, 825–828

tabs, ribbon
creating custom, 87–88
custom, adding command groups to, 89–91
resetting, 91–92

TAN (tangent) function, 1065
TANH (hyperbolic tangent) function, 1065
task panes, repositioning, 255
TBILL functions, 594–595, 1065
TDIST compatibility function, 1065
T.DIST (Student’s t-distribution) functions, 1065
templates, chart, 686–687
templates, workbook

AppData folders, 46–47
Blank Workbook, 42–43
common categories for, 43–44
creating, 46–47, 368–369
file name extensions for, 50–51
My Templates, 44, 46–48
New dialog box, 46–48
New From Existing option, 44, 46
Online templates, 44–45
recent templates, 43
sample templates, 43, 45–46
tabs, creating for, 47–48
Web-based, display option, 119
XLT legacy file format, 55
XLTX formats for, 54

text
alignment of. See alignment
Alt Text data, 427
boxes. See text box objects
case, functions for manipulating, 544, 547, 1049, 1058, 1067
chart formatting options, 705
chart, rotating, 681–682
CLEAN function, 544, 546, 1027
CONCATENATE function, 550–551, 1028
DOLLAR function, 545, 1035
FIND function, 547, 1039
fonts for. See fonts
formatting in graphics, 409–411
functions, 544–550
hyperlinks, converting to, 945
IF function tests, 551, 1043
ISTEXT function, 554, 1047
justifying, 346–347
Keep Text Flat in 3-D graphics option, 417
LEFT function, 548–549, 1047
LEN function, 545, 1048
LOWER function, 544, 547, 1049
MID function, 549, 1050
MIDB function, 1050
numeric text, 477
orientation of characters, controlling, 347–350
PROPER function, 544, 547, 1058
REPLACE function, 549, 1060
REPT function, 1060
RIGHT function, 548–549, 1060
SEARCH function, 547–548, 1061
SEARCHB function, 1062
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shapes, adding to, 381–382
Shrink To Fit option, 350–351
sparklines, adding to, 695
SUBSTITUTE function, 549, 1063
substring functions, 547–549
T (return text) function, 1065
Text Effects menu, 388
TEXT function, 545, 1066
TRIM function, 544, 546, 1066
UPPER function, 544, 547, 1067
values of. See text values
WordArt, 387–388
wrapping, 346

text box objects
callouts, 384–385
charts, adding to, 683
creating, 381
Format Picture dialog box for, 404
formatting text in shapes, 418–420

text files
column data type specification on import, 824
CSV files, opening, 821
delimited vs. fixed-width data in, 820–821
delimiters, selecting, 823
header row elimination, 821
importing and exporting, 70
numeric text entries, 155–156
parsing errors, fixing, 823
previewing data before importing, 821–823
regional and language option issues, 824
Text Import Wizard, 821–824

text format for numeric values, 332
Text Import Wizard

column data type specification on import, 824
delimiters, selecting, 823
header row elimination, 821
parsing errors, fixing, 823
previewing data before importing, 821–824
regional and language option issues, 824

text values
A function statistics for, 604
arguments of functions, as, 532
backslash (\) text-alignment prefix, 155–156
blank characters, removing, 546
caret (^) text-alignment prefix, 155–156
case, functions for manipulating, 547
entering in cells, 151
EXACT function, 546, 1038
formatting individual characters, 321–322
formulas, as used in, 477–478
functions, 544–550
Justify command, Fill menu, 236–237
long values, handling of, 154
quotation mark (") text-alignment character, 155–156
spelling, checking, 251–252
text-alignment prefix characters, 155–156
wrapping, 154

texture fills, 414, 704–705

Thai language, BAHTTEXT, 1024
Themed Cell Styles, 304
themes

advantages of, 300
chart styles related to, 674–675, 684–685
color schemes, changing in, 771
Colors gallery schemes, 301
converting legacy worksheets, 302–303
custom, creating, 301–302
Effects gallery, 301
fonts, changing for, 771
Fonts gallery, 301
importing, 302
other formatting, effect of, 301
pasting, 205
results of applying, 300–301
styles, relation to, 771
tables using, 771–772
Themes group buttons, 300

tick marks specification, 706–707
tilde (~) wildcard character, 244
time-consuming operations alert option, 228
times

24-hour convention, 567
1904 Apple alternative system, 566
Auto Fill series, 233
calculations with, 574–575
codes, formatting, 572–573
current, shortcut for entering, 567
custom formats for, 571–573
elapsed time, measuring, 573–574
entering, 566–569
formats for entry, 567
formatting, 570–571
functions, 574–580
HOUR function, 577, 1042
hours, maximum, 574
inserting in headers/footers, 446
macro for inserting current, 901
MINUTE function, 577, 1050
negative results of calculations, 574
NOW function, 576, 901, 1053
PivotTable grouping by, 809–810
SECOND function, 577, 1062
serial values of, 565
series creation, 568–570
TIME function, 1066
TIMEVALUE function, 578, 1066

T.INV (inverse Student’s t-distribution) functions, 1066
title bars

Compatibility mode indications, 52
placement of, 22

Titles And Headings Cell Styles, 304
titles of charts, editing, 675–677, 684–685
titles, printing on every page, 452–453
TODAY function, 576, 1066
Toggle Breakpoint command, 933–934
toolbar, Quick Access. See Quick Access Toolbar
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Top 10 Filter dialog box
PivotTables, 799–800
tables, 749–750

top alignment, 347
Top/Bottom rules feature, 310, 312–313
total rows

adding to tables, 736–737
referencing, 766–767
style element for, 773
#Totals tag, 768–769

totals
function for. See SUM function
PivotTable, 789–791
running, 801–804

#Totals tag, 768–769
tracing references, 267–272
tracking changes in shared workbooks, 863–868, 870
trademark symbol, inserting, 156
Transitional Navigation Keys setting, 155–156
transparency

chart areas with, 702
embedded graphic objects with, 956
graphic objects with, 405–406

TRANSPOSE function, 563, 1066
transposing columns and rows while pasting, 202, 208–209
trapping errors, VBA, 938–940
trend analysis, moving averages, 631–633
TREND function, 613–614, 1066
trendlines

adding, 724–725
formatting, 699–700

trigonometric functions
ACOSH (inverse hyperbolic cosine) function, 1022
ASIN (arcsine) function, 1023
ASINH (inverse hyperbolic sine), 1023
ATAN (arctangent) function, 1023
ATAN2 (arctangent) function, 1023
ATANH (inverse hyperbolic tangent) function, 1024
COS (cosine) function, 1029
COSH (hyperbolic cosine) function, 1029
DEGREES function, 1034
IMARGUMENT function, 1043
IMCOS function, 1043
IMSIN function, 1044
PI function, 1056
RADIANS function, 1059
SIN (sine) function, 1062
SINH (hyperbolic sine) function, 1062
TAN (tangent) function, 1065
TANH (hyperbolic tangent) function, 1065

TRIM function, 544, 546, 1066
TRIMMEAN function, 1067
TRUE logical value

conditional test results, as, 523
as logical function outcome, 550
TRUE function, 1067

TRUNC (truncate decimals) function, 543, 1067
Trust Center

ActiveX control settings, 115–116

add-ins, options for enabling, 115
administrator settings issues, 111
Customer Experience Improvement Program, 120
diagnostic file options, 120
Document Inspector, 121–122
external content options, 117–118
file format validation options, 120
Help button, 116
locations, managing trusted, 114
macro settings, 116, 895–898
measures of trustworthiness, 111–112
Message Bars, 112–113, 117
Office.com connection settings, 119–120
opening, 111
privacy options, 119–120
publishers trusted, managing list of, 113
Research Task Pane connection options, 120
security alert triggers, 111–113
spoofed Web site detection, 120
Trusted Documents list, 114
trusted locations, 897–898

T.TEST (Student’s t-test), 1067
TXT format, 70. See also text files
TYPE function, 553, 1067
typefaces. See fonts

U
underlines, accounting formatting, 329
underscore (_) formatting symbol, 337
Undo command, 158–159
undoing

Ctrl+Z shortcut, 198
deletions, limited functionality for, 218
drop-down list of actions, 224
limits to, 224
outlines, 276

unformatted text, pasting Excel data as, 968
Ungroup command, 422
Unhide command, 176, 189–190, 192
Unicode, 156, 968
uniform distributions, 627
up and down bars, 726
updates, 18–20
upgrading to Excel 2010

cost and frequency of upgrades, 20
features included in Excel 2007, 10–13
new features available in, 4–10

UPPER function, 544, 547, 1067
URLs

adding to text with Insert Hyperlink, 945
browsing for, 946–947
Remove Hyperlink command, 947
typing directly in cells, 944

Use Destination Styles option, 964
Use Table Names In Formulas option, 499
User Defined function category, 925. See also functions, 

custom
user permissions, adding for, 174–175
UserForms, 922
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V
validation

pasting only, 205
selecting all cells with, 146

#VALUE! errors from custom functions, 922–923
VALUE function, 1067
values

displayed vs. underlying, 152–153
error, 479
numeric. See numeric values
pasting without formatting, 202, 204
text. See text values
TYPE function, 553, 1067

VAR (variance) functions
PivotTable value fields with, 801
VARA function, 1067
VAR.P function, 1068
VAR.S function, 1068

variable declining balance (VDB) function, 590, 1068
variables, VBA

declaring with Dim statements, 932
Immediate Window, viewing values in, 936–937
Option Explicit statements, 931–932
Quick Watch, viewing with, 936
Require Variable Declaration option, 932
return values for functions with, 920–921
spelling errors, debugging, 931–932
value of, deploying in break mode, 931
Watch Window, viewing values in, 935–936

variance
Descriptive Statistics tool for, 619
DVAR, DVARP functions, 1036
functions for calculating, 607–608
PivotTable value fields with VAR, VARP, 801
VARA function, 1067
VAR.S, VAR.P, VARPA functions, 1068

VARP function, 801
VARPA function, 1068
VBA (Visual Basic for Applications)

:= (argument assignment), 908–909
_ (underscore character), 908
Activate method, 907
ActiveCell objects, 905
Application objects, 921
arguments to methods, 908–909
Assert method of Debug, 934–935
assignment statements, 920–921
Auto Syntax Check option, setting, 930–931
break mode, 930–931, 937
breakpoints, setting, 933–935
classes, 905–906
collections, 906–907
comments, 903
conditional breakpoints, 934–935, 936
continuation character (_), 908
custom functions. See functions, custom
Debug.Print statements, 936–937
Dim statements, 932
displaying module code, 902

documenting code, 922–923
Editor. See Visual Basic Editor
Else statements, 920
End If statements, 920
End Sub statements, 903, 912–913
Err object Number property, 939–940
error handling code, 938–940
error trapping for custom functions, 924–925
Exit Function statements, 924
FormulaR1C1 property, 907–908
For . . . Next statements, 907
functions, Excel, accessing, 921
Help screen, 903
If statements, 920, 932
Immediate Window, 936–937
implied selection and activation of objects, 907–908
indexes of collections, 906–907
InputBox statements, 922
IsMissing function, 923–924
keywords, 903, 922–923
launching Visual Basic Editor, 901–902
macro use of, 895
methods, 904, 906
modules created by, 901–902, 918
MsgBox statements, 922
object model, 903
objects, 903–908
On Error GoTo statements, 938–940
Option Explicit statements, 931–932
Optional keyword, 923–925
Personal Macro Workbooks, 914
properties, 904–906
Quick Watch, 936
Range().Select statements, 904
Require Variable Declaration option, 932
Resume statements, 939–940
run-time error fixes, 937–940
Select Case structures, 932
Select method, 904
Selection objects, 911
stepping through code, 932–933
Str function, 907
Sub statements, 903, 912–913
subroutines, 912–913
syntax errors, prompts at, 930–931
trapping errors, 938–940
UserForms, 922
variables, 920–921
Watch Window feature, 935–936
With . . . End With statements, 910–911

VBA-enabled workbooks, file format for, 55
VDB (variable declining balance) function, 590, 1068
vectors, lookup functions with, 555–558
vertex handles of curves, 380
vertically aligning text, 347
View SQL button, 840, 842
View tab

Arrange All command, 180
Custom Views command, 169–170, 188
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View tab, continued
Freeze Panes command, 166–167
Full Screen command, 182
grid options, 105
heading options, 105
Hide command, 189–190
New Window button, 185–189
New Window command, 106
Record Macros command, 898–899
Save Workspace command, 60
Show group, 103–104
Split command, 164–165
Switch Windows menu, 180
Unhide command, 189–190
View Macros, 899
View Side By Side command, 183–185
Zoom button, 167–168. See also zooming

views
custom, 169–170. See also windows, workbook
freezing panes, 166–167
Full Screen view, 182
multiple windows, independence of, 187
naming custom, 169–170
Page Layout view, 441–442
saved settings rule, 189
split pane views of worksheets, 164–165
status bar buttons for selecting, 40
zooms. See zooming

Visible Cells Only option, 279
visible cells selection, 146
VisiCalc, 71
Visual Basic Editor

With . . . End With statements, 910–911
adding recorded code to existing macros, 909–911
Alt+F11 keyboard shortcut for launching, 903
Assert method of Debug, 934–935
Auto Data Tips option, 931
Auto List Members option, 931
Auto Quick Info option, 931
Auto Syntax Check option, setting, 930–931
break mode, 930–931, 937
breakpoints, setting, 933–935
classes, 905–906
Code window, 902
collections, 906–907
color for syntax errors, settings, 931
comments, 903
conditional breakpoints, 934–935, 936
continuation character (_), 908
copying code, 910
custom functions. See functions, custom
Debug menu, 933
Debug.Print statements, 936–937
deleting a macro, 910
Dim statements, 932
displaying module code, 902
documenting code, 922–923
error messages, run-time, 930–931
F8 command, 933

Immediate Window, 936–937
Insert, Module command, 918
keywords, VBA, 903
launching, 901–902
methods, 904
modules, 901–902, 918
Object Browser view, 905–906
objects, 903–908
Option Explicit statements, 931–932
Project Editor window, 902
properties, 904–905
Quick Watch, 936
Require Variable Declaration option, 932
Run To Cursor command, 933
run-time error fixes, 937–940
stepping through code, 932–933
subroutines, 912–913
syntax errors, prompts at, 930–931
Toggle Breakpoint command, 933–934
trapping errors, 938–940
Watch Window feature, 935–936
workbooks, returning to, 903

Visual Basic for Applications. See VBA (Visual Basic for 
Applications)

VLOOKUP function, 555–557, 1068
volatile functions, recalculation, 626

W
Watch Window feature, 265–267, 935–936
Web Apps. See Office Web Apps
web beacons, 116
Web documents

opening in browsers, 63
saving Excel files as, 69

Web queries
browsers, copying and pasting from, 855
capabilities of, 849–850
creation methods for, list of, 852
data connection icons for, 816
Enter Parameter Value dialog box, 851
existing, launching, 850
full HTML formatting option, 854–855
Import command, 853
importable data in Web pages, highlighting of, 853
Internet Explorer, exporting data to Excel, 855
IQY files, 850, 853
New Web Query form, 852–853, 855
Options dialog box, 853–854
plain vs. rich text imports, 854
refreshing automatically, option for, 851
saving, 853
From Web command for creating, 852–854

Web sites, hyperlinks to, 943
WEEKDAY function, 576–577, 1068
WEIBULL.DIST function, 1069
what-if analysis tools

advantages of, 635
data tables for. See Data Table what-if analysis
Goal Seek tool, 652–655
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input ranges, 636
scenario analysis. See Scenario Manager
Solver, 655–666
What-If Analysis command, 635

widths of columns, setting, 362–364
wildcard characters

filtering with, 752
finding with, 244

Window group of View tab
Arrange All button, 180–181
New Window button, 185–189
Reset Window Position button, 184
Synchronous Scrolling button, 184
View Side By Side button, 183–185

Windows Explorer, starting Excel from, 17
Windows Live

feature availability of, 887
for IRM, 874–875
permissions, setting, 883–886
Sign-In Assistant, 882
signing up for IDs, 881–882
SkyDrive. See SkyDrive, Windows Live
Sync, 887

Windows Metafile (Bitmap) format, 968
Windows Packager, 959–960
Windows taskbar, hiding, 25
windows, workbook

arranging multiple, 180–182
freezing panes, 166–167
multiple allowed per worksheet, 21
new, creating, 185–189
New Window command, 106
Reset Window Position button, 184
Show All Windows In The Taskbar check box, 26
switching between, 179–180
Windows Of Active Workbook option, 186
worksheet, split pane views, 164–165

Win/Loss sparklines, 690
With . . . End With statements, VBA, 910–911
Word documents

Bitmap format, pasting Excel data as, 968
embedding copied text, 954–956
embedding, object layer for, 954
Excel charts in, 973–975
Excel data, methods for using in Word, 963
Excel rendering in Word issues, 965
HTML format, pasting Excel data as, 968
hyperlinking to Excel data, 970–971
Keep Source Formatting option, 964
Keep Text Only option, 964
linking Excel tables into Word, 969–970
links to Excel tables, pasting, 963–964
mail-merging with Excel data, 976–979
manual linking option for Excel tables in, 969
Microsoft Graph Chart, 974–975
multipage, viewing from links, 954
named ranges preferred for links to Excel, 969
Object command for links to Excel, 971–972
Object format, pasting Excel data as, 966–967

Paste Special command for including Excel data, 965–971
pasting charts into, 975
pasting Excel ranges into Word, 963–964
pasting links to, 957
Picture formats, pasting Excel data into Word as, 968
Picture option for Excel in Word, 964
RTF (Rich Text Format), pasting Excel data as, 968
unformatted text, pasting Excel data as, 968
Use Destination Styles option, 964

WordArt, 387–388, 684–685
workbooks

active, viewing only windows of, 186
add-ins, saving as, 925–926
advantages of organizing with, 2
arranging multiple windows, 180–182
Blank Workbook template, 42–43
creating new, 42–46
digital signatures for, 121–125
encryption of, 191–192
file name extensions for, 50–51
hiding, 189–190, 192
Inspect Document command, 121–122
linking. See linked workbooks
marking as final, 192–194
master, for combining changes, 869–871
navigating between open, 179–180
navigation methods, 23–25
new windows for, creating, 185–189
newly created, layout of, 21–22
opened but invisible, 190
opening, 61–64
Protected View option, opening in, 63
protecting, 172, 190–191
resizing windows of, 25–26
saving, 49–50, 182
Shared Workbook command, 49
sharing over networks, 860–869
sheet tab navigation buttons, 24
Show Previous Versions option, 64–65
structure, protecting, 191, 193
summary information, adding to, 58–59
tab split boxes, 24
templates for. See templates, workbook
title bars of, 22

WORKDAY functions, 579–580, 1069
Worksheet Object format, 966–967
worksheets

Across Worksheets command, 260–261
active areas of, 25
chart sheets, 675
color, selecting for individual tabs, 109
consolidating, 280–287
copying, 162–163
deleting, 161
designing. See designing worksheets
dragging between workbooks, 163
e-mail, sending by, 873
Fill, Across Worksheets command, 236
freezing panes, 166–167
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worksheets, continued
grouping for editing, 255–260
hiding, 176, 192
hyperlinks to, creating, 947–948
Insert Worksheet tabs, 257
inserting new, 159–160
keyboard navigation between, 167
layout of, 20–21
memory limitations of, 21
moving, 161–163
multiple in a workbook, limit to, 159
naming, 162
naming custom views, 169–170
navigation methods, 23–25
new, creating, 257
new windows for, creating, 185–189
planning. See planning worksheets
protected, not editable in Excel Web App, 891
protecting, 170–175
regions of. See regions
resizing windows of, 25–26
Select All command, 140
Select All Sheets command, 160
selecting entire, 143
shortcut menu for, 159–160
side by side comparisons of, 183–185
split pane views of, 164–165
Tab Color command, 160
windows for, multiple allowed, 21
zooming, 167–169

workspaces
customizing. See customizing the workspace
file name extensions for, 50–51
Save Workspace command, 60, 181

Wrap Text button, 154
wrapping text, 346

X
XIRR (internal rate of return, nonperiodic) function, 1069
XLAM file format, 55, 926
XLK backup file format, 56–57
XLM file format, 55
XLS file format, 55, 898
XLSB (Binary Workbook) file format, 54, 898
XLSM (Excel Macro-Enabled Workbook) file format, 54, 898

XLStart folder, 64
XLSX file format

advantages and disadvantages of, 54
default workbook format, as, 51
introduction in Excel 2007, 13
macros not supported in, 898

XLT file format, 55
XLTX (template) file format, 54
XML (Extensible Markup Language)

ad hoc mappings of elements to columns, 826–828
as an XML table, opening option, 825
existing XML structures, importing XML data to, 828–829
importing into existing worksheets, 826
Open XML dialog box, 825
refreshing XML tables, 826
schema files of, 825
Source task pane for, 825
Spreadsheet ML specification for, 55
Use The XML Source Task Pane opening option, 826–828
Web Apps, required for using, 891
XML file format, 55

XML Paper Specification (XPS), 71, 462–464
XNPV (net present value, nonperiodic) function, 1069
XPS file format, 71, 462–464

Y
YEAR function, 577, 1069
YEARFRAC function, 578–579, 1069
YIELD functions, 594, 1070

Z
zeros

hiding, 106–107
leading zeros dropped, 323

ZIP code formats, 332
zooming

as an accessibility feature, 109
mouse devices for, 23, 169
selecting cells, as aid to, 141
status bar buttons for, 40
worksheets, 167–169
Zoom On Roll With IntelliMouse option, 228
Zoom To Selection command, 167–169

Z.TEST function, 1070
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